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Owner’s Record

The model and the serial numbers are
located at the bottom. Record the serial
number in the space provided below. Refer
to these numbers whenever you call upon
your Sony dealer regarding this product.

Model No.
Serial No.

WARNING

To reduce a risk of fire or electric
shock, do not expose this product
to rain or moisture.

To avoid electrical shock, do not
open the cabinet. Refer servicing to
qualified personnel only.

IMPORTANT

The nameplate is located on the bottom.

Notice

The PCS-XG80S and the PCS-XG80 are
systems each of which contains Model No.
PCS-XGS80S as a main unit. Always refer to
Model No. PCS-XGS80S for regulatory
compliance purpose.

The PCS-XG55S and the PCS-XGS55 are
systems each of which contains Model No.
PCS-XG55S as a main unit. Always refer to
Model No. PCS-XGS5SS for regulatory
compliance purpose.

WARNING

Use the AC power adapter provided with
this equipment as a power supply source.
Manufacture Type No.
Sony VGP-ACI9V15
Any other power sources may result in
hazards such as a fire.
Disconnect device of this equipment is the
mains plug of the AC adapter.
The mains plug on this equipment must be
used to disconnect mains power.
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Please ensure that the socket outlet is
installed near the equipment and shall be
easily accessible.

In the event of abnormal operations,
disconnect the mains plug.

NOTICE

Use the power cord set approved by the
appropriate testing organization for the
specific countries where this unit is to be used.

NOTICE

Each of PCS-XG80S/XG55S, PCS-RF1 and
PCSA-CXGS80 contains an RF (Radio
Frequency) transmitting and receiving
module. Operation is subject to applicable
local radio communication regulations in
each country.

This equipment should be installed and
operated with minimum distance 20cm
between the radiator & your body. This
transmitter must not be co-located or
operating in conjunction with any other
antenna or transmitter.

CAUTION for LAN port

For safety reasons, do not connect the LAN
port to any network devices that might have
excessive voltage.

Installing batteries

Two RO6 (size AA) batteries are supplied for
Remote Commander.

To avoid risk of explosion, use R06 (size
AA) manganese or alkaline batteries.

CAUTION

Danger of explosion if battery is incorrectly
replaced. Replace only with the same or
equivalent type recommended by the
manufacturer. Dispose of used batteries
according to the manufacturer’s instructions.

For the customers in the USA

WARNING

This device complies with Part 15 of the
FCC Rules.

Operation is subject to the following two
conditions: (1) This device may not cause
harmful interference, and (2) this device
must accept any interference received,
including interference that may cause
undesired operation.




This equipment has been tested and found to
comply with the limits for a Class A digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference when the equipment is operated
in a commercial environment. This
equipment generates, uses, and can radiate
radio frequency energy and, if not installed
and used in accordance with the instruction
manual, may cause harmful interference to
radio communications. Operation of this
equipment in a residential area is likely to
cause harmful interference in which case the
user will be required to correct the
interference at his own expense.

You are cautioned that any changes or
modifications not expressly approved in this
manual could void your authority to operate
this equipment.

All interface cables used to connect
peripherals must be shielded in order to
comply with the limits for a digital device
pursuant to Subpart B of Part 15 of FCC
Rules.

FCC Radiation Exposure Statement
(PCS-XG80S/PCS-XG55S/PCS-RF1):
This equipment complies with FCC
radiation exposure limits set forth for an
uncontrolled environment. This equipment
should be installed and operated with
minimum distance 20 cm between the
radiator & your body. This transmitter must
not be co-located or operating in conjunction
with any other antenna or transmitter.

This manual focuses on using ISDN lines

to conduct a videoconference, but it also

covers non-ISDN lines. If you use ISDN

lines, consult your Sony dealer for more

information.

* The ISDN service may not be available
in some areas.

If you dispose the unit, consult your nearest
Sony Service Center. The built-in battery
must be treated as a chemical waste.

For the customers in Canada

This Class A digital apparatus complies with
Canadian ICES-003.

Cet appareil numérique de la classe A est
conforme a la norme NMB-003 du Canada.

IC Interference Statement (PCS-

XG80S/PCS-XG55S/PCS-RF1)

This device complies with RSS-210 of the

IC Rules. Operation is subject to the

following two conditions:

1. This device may not cause harmful
interference, and

2. This device must accept any interference
received, including interference that may
cause undesired operation.

(PCS-XG80S/PCS-XGS55S)

The term “IC:” before the radio certification

number only signifies that Industry Canada

technical specifications were met.

IC:7424A-ZM100

IC Radiation Exposure Statement:
This equipment complies with IC RSS-102
radiation exposure limits set forth for an
uncontrolled environment.

This equipment should be installed and
operated with minimum distance 20 cm
between the radiator & your body.

For the customers in Europe

The manufacturer of this product is Sony
Corporation, 1-7-1 Konan, Minato-ku,
Tokyo, Japan.

The Authorized Representative for EMC
and product safety is Sony Deutschland
GmbH, Hedelfinger Strasse 61, 70327
Stuttgart, Germany. For any service or
guarantee matters please refer to the
addresses given in separate service or
guarantee documents.

(PCS-XG80S/PCS-XG55S/PCS-RF1)
This equipment conforms to R&TTE
Directive 1999/5/EC. For details, please
access the following URL:
http://www.compliance.sony.de
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For the customers in Europe, interference in which case the user may be
Australia and New Zealand required to take adequate measures.

In the case that interference should occur,

WARNING consult your nearest authorized Sony service
This is a Class A product. In a domestic facility.
environment, this product may cause radio This apparatus shall not be used in the

residential area.

For the customers in Taiwan only

&3

EEEIHEREIUR

For the customers in Europe (PCS-XG80S/PCS-XG55S)

C€

This product is intended to be used in the following countries:

AT |BE|CY|CZ

DK|EE| FI |FR|DE|GR|HU

IS|IE|IT|LV

LI | LT |[LU|MT|NL|NO|PL

PT |[RO|SK]| SI

ES|SE|CH|GB|BG

Language

Informal DoC

Bulgarian

C nacrosimero Conn Kopniopanust nexnapupa, ye To3u PCS-XG80S/
XGS55S/HD Visual Communication System o TroBapst Ha OCHOBHUTE
U3UCKBAHUS U APYIUTE CbOTBETCTBALIM Kiay3u Ha [Jupekrusa 1999/5/EC.
IToppoOHoCcTH MOXKE 1a HaMmepuTe Ha MIHTEpHET cTpaHuiaTa
http://www.compliance.sony.de

Czech

Sony Corporation timto prohlasuje, Ze tento PCS-XG80S/XG55S/HD
Visual Communication System je ve shodé se zakladnimi pozadavky a
dal$imi pfisluSnymi ustanovenimi smérnice 1999/5/ES. Podrobnosti 1ze
ziskat na nasledujici URL: http://www.compliance.sony.de/

Danish

Undertegnede Sony Corporation erklerer herved, at fglgende udstyr PCS-
XG80S/XGS55S/HD Visual Communication System overholder de vasentlige
krav og gvrige relevante krav i direktiv 1999/5/EF.

For yderligere information gé ind pa fglgende hjemmeside:
http://www.compliance.sony.de/

Dutch

Hierbij verklaart Sony Corporation dat het toestel PCS-XG80S/XG55S/HD
Visual Communication System in overeenstemming is met de essenti€le eisen
en de andere relevante bepalingen van richtlijn 1999/5/EG. Nadere informatie
kunt u vinden op: http://www.compliance.sony.de/

English

Hereby, Sony Corporation, declares that this PCS-XG80S/XG55S/HD Visual
Communication System is in compliance with the essential requirements and
other relevant provisions of Directive 1999/5/EC. For details, please access the
following URL: http://www.compliance.sony.de/
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Language

Informal DoC

Estonian

Sony Corporation kinnitab kidesolevaga seadme PCS-XG80S/XG55S/HD
Visual Communication System vastavust 1999/5/EU direktiivi pohinduetele ja
nimetatud direktiivist tulenevatele teistele asjakohastele sitetele.
Uksikasjalikum info: http://www.compliance.sony.de/.

Finnish

Sony Corporation vakuuttaa titen ettd PCS-XG80S/XG55S/HD Visual
Communication System tyyppinen laite on direktiivin 1999/5/EY oleellisten
vaatimusten ja sitd koskevien direktiivin muiden ehtojen mukainen. Halutessasi
lisdtietoja, kiy osoitteessa: http://www.compliance.sony.de/

French

Par la présente Sony Corporation déclare que 1’appareil PCS-XG80S/XG55S/
HD Visual Communication System est conforme aux exigences essentielles et
aux autres dispositions pertinentes de la directive 1999/5/CE. Pour toute
information complémentaire, veuillez consulter I’'URL suivante: http://
www.compliance.sony.de/

German

Hiermit erklért Sony Corporation, dass sich das Gerdt PCS-XG80S/XG55S/
HD Visual Communication System in Ubereinstimmung mit den grundlegenden
Anforderungen und den iibrigen einschlidgigen Bestimmungen der Richtlinie
1999/5/EG befindet. Weitere Informationen erhéltlich unter: http://
www.compliance.sony.de/

Greek

Me v tagovoa 1 Sony Corporation dnhawver 6Tt PCS-XG80S/XG55S/
HD Visual Communication System OUHUO QPOVETAL TTQOG TNG OVOLMOELS
OTTALTNOELS %auL TIg hoWTég oyeTinég dtatdEelg Tng odnyiag 1999/5/EK. T
LETTTOUEQELES TTALQOUXAAOVE OTTWG ENEVEETE TNV axOLOVON oELLDO TOV
owad wtvou: http://www.compliance.sony.de/

Hungarian

Alulirott, Sony Corporation nyilatkozom, hogy a(z) PCS-XG80S/
XGS55S/HD Visual Communication System megfelel a vonatkozo
alapvet6 kovetelményeknek €s az 1999/5/EC iranyelv egyéb elGira
sainak. Tovabbi informacidkat a kovetkezd weboldalon talalhat:
http://www.compliance.sony.de

ltalian

Con la presente Sony Corporation dichiara che questo PCS-XG80S/XG55S/
HD Visual Communication System ¢ conforme ai requisiti essenziali ed alle
altre disposizioni pertinenti stabilite dalla direttiva 1999/5/CE. Per ulteriori
dettagli, si prega di consultare il seguente URL: http://
www.compliance.sony.de/

Latvian

Ar 80 Sony Corporation deklaré, ka PCS-XG80S/XG55S/HD Visual
Communication System atbilst Direktivas 1999/5/EK bitiskajam prasibam un
citiem ar to saistitajiem noteikumiem. Plagaka inform acija ir pieejama:
http://www.compliance.sony.de/

Lithuanian

Siuo Sony Corporation deklaruoja, kad §is PCS-XG80S/XG55S/HD Visual
Communication System atitinka esminius reikalavimus ir kitas 1999/5/EB
Direktyvos nuostatas. Susipazinti su visu atitikties deklaracijos turiniu Jas galite
interneto tinklalapyje: http://www.compliance.sony.de/

Norwegian

Sony Corporation erklerer herved at utstyret PCS-XG80S/XG55S/HD Visual
Communication System er i samsvar med de grunnleggende krav og gvrige
relevante krav i direktiv 1999/5/EF. For flere detaljer, vennligst se: http://
www.compliance.sony.de/
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Language

Informal DoC

Polish

Niniejszym Sony Corporation oswiadcza, .e PCS-XG80S/XG55S/HD Visual
Communication System jest zgodne z zasadniczymi wymaganiami oraz innymi
stosownymi postanowieniami Dyrektywy 1999/5/WE. Szczeg6lowe informacje
znalezc mo.na pod nastepujacym adresem URL: http://
www.compliance.sony.de/

Portuguese

Sony Corporation declara que este PCS-XG80S/XG55S/HD Visual
Communication System esta conforme os requisitos essenciais e outras
disposi¢des da Directiva 1999/5/CE. Para mais informacoes, por favor consulte
a seguinte URL: http://www.compliance.sony.de/

Romanian

Prin prezenta, Sony Corporation declard cd acest PCS-XG80S/XG55S/
HD Visual Communication System respecta cerintele esentiale si este in
conformitate cu prevederile Directivei 1995/5/EC. Pentru detalii, va
rugdm accesati urmatoarea adresa: http://www.compliance.sony.de/

Slovak

Sony Corporation tymto vyhlasuje, ze PCS-XG80S/XG55S/HD Visual
Communication System splia zakladné po ziadavky a vSetky prislusné
ustanovenia Smernice 1999/5/ES. Podrobnosti ziskate na nasledovnej
webovej adrese: http://www.compliance.sony.de/

Slovenian

Sony Corporation izjavlja, da je ta PCS-XG80S/XG55S/HD Visual
Communication System v skladu z bistvenimi zahtevami in ostalimi
relevantnimi dolo¢ili direktive 1999/5/ES. Za podrobnosti vas napro S§amo,
¢e pogledate na URL: http://www.compliance.sony.de/

Spanish

Por medio de la presente Sony Corporation declara que el PCS-XG80S/XG55S/
HD Visual Communication System cumple con los requisitos esenciales y
cualesquiera otras disposiciones aplicables o exigibles de la Directiva 1999/5/
CE. Para mayor informacion, por favor consulte el siguiente URL: http://
www.compliance.sony.de/

Swedish

Hérmed intygar Sony Corporation att denna PCS-XG80S/XG55S/HD Visual
Communication System stéir I 6 verensstimmelse med de visentliga
egenskapskrav och dvriga relevanta bestimmelser som framgar av direktiv
1999/5/EG. For ytterligare information gé in pa f6ljande hemsida: http:/
www.compliance.sony.de/

For the customers in Europe (PCS-RF1)

C€

This product is intended to be used in the following countries:

AT |BE|CY|CZ|DK|EE| FI |FR|DE|GR|HU
IS|IE|IT|LV]|LI|LT |[LU|MT|NL|NO|PL
PT|RO|SK| SI |[ES|SE|CH|GB|BG
Language Informal DoC
C nacrosimero Conn Kopnopanus gexnapupa, gye To3u PCS-RF1/RF
Bulgarian Remote Commander o TroBapst Ha OCHOBHUTE H3UCKBAHUS U APYTUTE
cpoTBeTcTBaIu Kiay3u Ha upekTusa 1999/5/EC. [TogpoGHOCTH MOXKeE f1a
Hamepute Ha VIHTepHeT cTpaHunata : http://www.compliance.sony.de/
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Language

Informal DoC

Czech

Sony Corporation timto prohlasuje, Ze tento PCS-RF1/RF Remote
Commander je ve shodé se zdkladnimi pozadavky a dal$imi prislusnymi
ustanovenimi smérnice 1999/5/ES. Podrobnosti Ize ziskat na nasledujici
URL: http://www.compliance.sony.de/

Danish

Undertegnede Sony Corporation erklearer herved, at fglgende udstyr PCS-RF1/
RF Remote Commander overholder de vesentlige krav og gvrige relevante krav
i direktiv 1999/5/EF.

For yderligere information gé ind pa fglgende hjemmeside:
http://www.compliance.sony.de/

Dutch

Hierbij verklaart Sony Corporation dat het toestel PCS-RF1/RF Remote
Commander in overeenstemming is met de essenti€le eisen en de andere
relevante bepalingen van richtlijn 1999/5/EG. Nadere informatie kunt u vinden
op: http://www.compliance.sony.de/

English

Hereby, Sony Corporation, declares that this PCS-RF1/RF Remote Commander
is in compliance with the essential requirements and other relevant provisions of
Directive 1999/5/EC. For details, please access the following URL: http://
www.compliance.sony.de/

Estonian

Sony Corporation kinnitab kéesolevaga seadme PCS-RF1/RF Remote
Commander vastavust 1999/5/EU direktiivi pohinduetele ja nimetatud
direktiivist tulenevatele teistele asjakohastele sitetele. Uksikasjalikum info:
http://www.compliance.sony.de/.

Finnish

Sony Corporation vakuuttaa titen ettd PCS-RF1/RF Remote Commander
tyyppinen laite on direktiivin 1999/5/EY oleellisten vaatimusten ja sitd
koskevien direktiivin muiden ehtojen mukainen. Halutessasi lisétietoja, kéy
osoitteessa: http://www.compliance.sony.de/

French

Par la présente Sony Corporation déclare que 1’appareil PCS-RF1/RF Remote
Commander est conforme aux exigences essentielles et aux autres dispositions
pertinentes de la directive 1999/5/CE. Pour toute information complémentaire,
veuillez consulter I’URL suivante: http://www.compliance.sony.de/

German

Hiermit erklidrt Sony Corporation, dass sich das Gerit PCS-RF1/RF Remote

Commander in Ubereinstimmung mit den grundlegenden Anforderungen und
den iibrigen einschldgigen Bestimmungen der Richtlinie 1999/5/EG befindet.
Weitere Informationen erhéltlich unter: http://www.compliance.sony.de/

Greek

Mze tnv magovoa 1 Sony Corporation dnhmver 6t PCS-RF1/RF Remote
Commander oUUIO QPDOVETAL TQOG THG OVOLMOELG OTTULTIOELS KO

TG houTteg oyeTIreg dLoTaEeLs tng odnyiag 1999/5/EK. T Aemtougeteg
TAQUXAAOVUE OTTWG eAEVEETE TNV ArOMOVON oeMd TOV dLad TVOU:
http://www.compliance.sony.de/

Hungarian

Alulirott, Sony Corporation nyilatkozom, hogy a(z) PCS-RF1/RF Remote
Commander megfelel a vonatkozé alapvet§ kovetelményeknek

és az 1999/5/EC iranyelv egyéb elbira sainak. Tovabbi informacidkat a
kovetkezS weboldalon talalhat: http://www.compliance.sony.de/

Italian

Con la presente Sony Corporation dichiara che questo PCS-RF1/RF Remote
Commander ¢ conforme ai requisiti essenziali ed alle altre disposizioni
pertinenti stabilite dalla direttiva 1999/5/CE. Per ulteriori dettagli, si prega di
consultare il seguente URL: http://www.compliance.sony.de/
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Language

Informal DoC

Latvian

Ar S0 Sony Corporation deklaré, ka PCS-RF1/RF Remote Commander
atbilst Direktivas 1999/5/EK biutiskajam prasibam un citiem ar to
saistitajiem noteikumiem. Plasaka inform acija ir pieejama:
http://www.compliance.sony.de/

Lithuanian

Siuo Sony Corporation deklaruoja, kad sis PCS-RF1/RF Remote
Commander atitinka esminius reikalavimus ir kitas 1999/5/EB Direktyvos
nuostatas. Susipazinti su visu atitikties deklaracijos turiniu Jus galite
interneto tinklalapyje: http://www.compliance.sony.de/

Norwegian

Sony Corporation erklerer herved at utstyret PCS-RF1/RF Remote
Commander er i samsvar med de grunnleggende krav og gvrige relevante krav i
direktiv 1999/5/EF. For flere detaljer, vennligst se: http://
www.compliance.sony.de/

Polish

Niniejszym Sony Corporation oswiadcza, .e PCS-RF1/RF Remote Commander
jest zgodne z zasadniczymi wymaganiami oraz innymi stosownymi
postanowieniami Dyrektywy 1999/5/WE. Szczegbélowe informacje znalezc
mo.na pod nastepujacym adresem URL: http://www.compliance.sony.de/

Portuguese

Sony Corporation declara que este PCS-RF1/RF Remote Commander esta
conforme os requisitos essenciais e outras disposi¢des da Directiva 1999/5/CE.
Para mais informacoes, por favor consulte a seguinte URL: http://
www.compliance.sony.de/

Romanian

Prin prezenta, Sony Corporation declara ca acest PCS-RF1/RF Remote
Commander respectd cerintele esentiale si este in conformitate cu
prevederile Directivei 1995/5/EC. Pentru detalii, va rugdm accesati
urmatoarea adresa: http://www.compliance.sony.de/

Slovak

Sony Corporation tymto vyhlasuje, Ze PCS-RF1/RF Remote Commander
splna zakladné po ziadavky a vsetky prislusné ustanovenia Smernice
1999/5/ES. Podrobnosti ziskate na nasledovnej webovej adrese:
http://www.compliance.sony.de/

Slovenian

Sony Corporation izjavlja, da je ta PCS-RF1/RF Remote Commander v
skladu z bistvenimi zahtevami in ostalimi relevantnimi dolo¢ili direktive
1999/5/ES. Za podrobnosti vas napro Samo, ¢e pogledate na URL: http:/
www.compliance.sony.de/

Spanish

Por medio de la presente Sony Corporation declara que el PCS-RF1/RF Remote
Commander cumple con los requisitos esenciales y cualesquiera otras
disposiciones aplicables o exigibles de la Directiva 1999/5/CE. Para mayor
informacién, por favor consulte el siguiente URL: http://
www.compliance.sony.de/

Swedish

Hirmed intygar Sony Corporation att denna PCS-RF1/RF Remote Commander
star I 6 verensstimmelse med de viisentliga egenskapskrav och 6vriga relevanta
bestdmmelser som framgar av direktiv 1999/5/EG. For ytterligare information
gd in pa foljande hemsida: http://www.compliance.sony.de/
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Precautions

Operating or storage location

Avoid operating or storing the system in the

following locations:

* Extremely hot or cold places

* Humid or dusty places

¢ Places exposed to strong vibration

¢ Close to sources of strong magnetism

* Close to sources of powerful
electromagnetic radiation, such as radios
or TV transmitters

* Noisy places

Cleaning

Use a soft, dry cloth to gently wipe the
cabinet and panel when cleaning the unit.
For heavier cleaning, use a cloth lightly
moistened with a mild detergent to remove
the dust, and finish by wiping again with a
dry cloth. Do not use volatile solvents such
as alcohol, benzene, thinners, or insecticides
as they may damage the surface finishes.

Note on laser beams

Laser beams may damage a CMOS image
sensor. You are cautioned that the surface
of a CMOS image sensor should not be
exposed to laser beam radiation in an
environment where a laser beam device is
used.
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Chapter 1:
Installation and
Preparation

Using This Manual

The chapters cover the following contents;
please read the chapters that may be required
for your type of communication.

Chapter 1: Installation and
Preparation

This chapter guides you through the system
configuration and information required to
use your HD Visual Communication System
for the first time. It shows you how to install
and connect your Communication System,
to turn the system on/off and how to access
basic on-screen menus.

Chapter 2: Registration and Setup for
System Administrators

This chapter describes how to register and
set up all the necessary items for system
administrators, using the on-screen menus.

Chapter 3: Basic Connection

This chapter guides you through the basic
operations and settings for connecting to a
remote party. You will learn how to start
connection to finish it. It is recommended
that this chapter be read by participants in a
communication.

Chapter 4: Connection with Optional
Equipment

This chapter shows advanced
communication using the optional
equipment, and functions such as streaming,
recording, presentation and annotation.

Chapter 5: Encrypted Connection

This chapter shows how to connect to a
remote party using an encrypted video and
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audio data, and encrypted data from a
computer.

Chapter 6: Multipoint Connection
This chapter shows you how to connect your
system to multiple sites. Multipoint
connection requires installation of the
optional PCSA-MCGS80 HD MCU software
in your Visual Communication System.

The PCSA-MCG80 software cannot be
installed on the PCS-XG55/XG55S.

Chapter 7: Web Control Function
This chapter shows you how to control the
Visual Communication System or set it up
via a Web browser.

Appendix

The appendix contains descriptions of the
controls and connectors on the components
of the HD Visual Communication System,
troubleshooting list, specifications, and a
glossary.



Features

The PCS-XG80/XG80S/XG55/XG55S HD
Visual Communication System is a
communication system that provides face-
to-face communications with a remote party
by transmitting and receiving images and
sound via LAN (Local Area Network) or
ISDN (Integrated Services Digital Network)
connections.

Supports ITU-T international
standard

The HD Visual Communication System
complies with ITU-T Recommendations
defined by WTSC for easy connection with
remote parties overseas.

ITU: International Telecommunication
Union

WTSC: World Telecommunications
Standardization Committee

Supports data communication
Installing the optional PCSA-DSG80 HD
Data Solution Software into the
Communication System enables
transmission of output data from a computer.

High transmission speeds and
high-quality picture capability

The Communication System accepts a LAN
communication bit rate of up to 10 Mbps (up
to 4 Mbps on the PCS-XG55/XG55S). It
also allows you to connect to as many as
three ISDN lines and use 6B channels with
the optional PCSA-B384S ISDN Unit, and
as many as six ISDN lines and use 12B
channels with the optional PCSA-B768S
ISDN Unit.

When the PCS-XG80/XG80S is connected to
other models, the maximum communication

bit rate is 4 Mbps.

Transmission and reception of
high-definition images enabled

The Communication System supports the
H.264 high-definition video compression
format, enabling transmission and reception
of interlaced video signals with a high
resolution of 1920 x 1080 or 1280 x 720 by
a maximum of 60 frames per second.

The PCS-XG55/XG55S does not support
interlaced video signals with a resolution of

1920 x 1080.

Transmission and reception of
wide range of stereo sound
capability

The audio compression format of the
Communication System supports MPEG4
AAC (Advanced Audio Coding) stereo
sound and 22 kHz monaural sound, allowing
high-quality audio transmission and
reception. The built-in echo canceller
supports up to 16 kHz.

Wide range of video/audio
compression format selectable

The Communication System supports the
H.264, H.263+, H.261 and MPEG4 " video
compression formats. It also supports the
MPEG4 AAC™, G.722, G.728, and G.711
audio compression formats.

*  Supports MPEG4 only for connection using
SIP.

** Supports MPEG4 AAC only for IP and
ISDN connection.

Annotation capability

The annotation function allows you to write
letters or graphics on the screen or point with
a pointer during communication using the
optional pen tablet.

BrightFace feature incorporated in
the HD Camera Unit

The supplied PCSA-CXG80 HD Camera
Unit incorporates the BrightFace feature,
allowing detection of dark and bright
shooting parts of a scene individually to
make a dark scene brighter and a bright
scene clearer.
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Up to 100 preset camera settings

Up to 100 settings for camera angle and
zoom can be registered in the preset memory
of the System. You can easily switch the
shooting area only by recalling the preset
position.

RF (Radio Frequency) Remote
Commander adopted

The supplied Remote Commander controls
the Communication System using the radio
frequency of 2.4 GHz. The Remote
Commander can be programmed for pairing
with the System or the Camera Unit to
prevent interference from other Systems and
Camera Units.

On-screen keyboard

The on-screen keyboard displayed on the
monitor screen allows you to input a
number, address, etc. without moving your
eyes away from the screen.

QoS (Quality of Service) function
for optimization of bandwidth and
traffic packet through network

The Communication System includes the
“Packet Resend Request”, “Adaptive Rate
Control”, and “Forward Error Correction”
functions. Depending on the network status,
these functions are used in Hybrid to
guarantee consistent, high-quality
communications.

Compact size

The compact size of the Communication
System allows versatile installation layout.

Echo cancelling microphone

Up to 40 PCSA-A7 echo cancelling
microphones (optional) can be connected to
one port without losing sound quality, using
a cascade connection.

This function is not available on the PCS-
XG55/XG55S.
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Equipped with an HDMI connector

The HDMI connector allows you to connect
an HDMI display unit to the Communication
System easily.

Equipped with a Memory Stick slot

The Communication System is equipped
with a Memory Stick slot, allowing you to
save still images, create the Private Phone
Book and store the customized settings in a
“Memory Stick”.

Video and audio recording

Video and audio can be recorded in a
“Memory Stick” and can be watched on a
computer after.

Streaming

You can broadcast streaming video and
audio. This allows people who cannot attend
the communication to watch the proceedings
over the Web using a computer. You can
also select whether to broadcast both video
and audio or audio only.

Supports a connection using SIP

The Communication System allows
connection to a remote party with an IP phone,
etc. using SIP (Session Initiation Protocol).

The maximum communication bit rate during
SIP connection is 4 Mbps.

Supports encrypted connection

The system allows you to make a strictly
confidential connection using standard
encryption, which complies with the H.233,
H.234 and H.235 standerdized by the ITU-T.

Supports multipoint connection

Installing the optional PCSA-MCG80 HD
MCU software in your Visual
Communication System allows connection
among multiple points via a LAN or/and
ISDN line.

This software cannot be installed on the PCS-
XG55/XGS55S.



System Components

The PCS-XG80/XG80S/XG55/XG55S HD Visual Communication System is
composed of basic system components for a basic communication, and
optional equipment for an enhanced communication.

Basic System Components

This manual explains how to operate the following systems.

» PCS-XG80

HD Visual Communication System package that includes the main unit, one PCSA-
CXG80 HD Camera Unit, and two PCS-A1 Microphone units.

* PCS-XG55

HD Visual Communication System package that includes the main unit, one PCSA-
CXG80 HD Camera Unit, and one PCS-A1 Microphone unit.

» PCS-XG80S/XG55S

HD Visual Communication System package that includes only the main unit.

Components packaged in the PCS-XG80

Unit

Description

PCS-XGS80S HD Visual
Communication System

Contains the video codec, audio codec, echo
canceller, network interfaces and system controller.

PCS-RF1
Remote Commander

Used to control the HD Visual Communication
System. Before using, pairing with the
Communication System or HD Camera Unit is
required.

Supplies power to the Communication System.
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Unit Description
PCSA-CXG80 Camera to shoot high-definition images.
HD Camera Unit

Omni-directional microphone that picks up sound
relatively from all directions, allowing participants to
speak from any location. It is recommended to use in
a quiet situation (two pieces supplied).

Components packaged in the PCS-XG80S

Unit

Description

PCS-XG80S HD Visual
Communication System

Contains the video codec, audio codec, echo
canceller, network interfaces and system controller.

PCS-RF1
Remote Commander

Used to control the HD Visual Communication
System. Before using, pairing with the
Communication System or HD Camera Unit is
required.

Supplies power to the Communication System.

Components packaged in the PCS-XG55

20

Unit

Description

PCS-XG55S HD Visual
Communication System

Contains the video codec, audio codec, echo
canceller, network interfaces and system controller.
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Unit

Description

PCS-RF1
Remote Commander

Used to control the HD Visual Communication
System. Before using, pairing with the
Communication System or HD Camera Unit is
required.

Supplies power to the Communication System.

PCSA-CXGS80
HD Camera Unit

Camera to shoot high-definition images.

Omni-directional microphone that picks up sound
relatively from all directions, allowing participants to
speak from any location. It is recommended to use in
a quiet situation (one piece supplied).

Components packaged in the PCS-XG55S

Unit

Description

PCS-XGS55S HD Visual
Communication System

Contains the video codec, audio codec, echo
canceller, network interfaces and system controller.

PCS-RF1
Remote Commander

Used to control the HD Visual Communication
System. Before using, pairing with the
Communication System or HD Camera Unit is
required.

21
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Unit

Description

VGP-AC19V15 AC adaptor

Supplies power to the Communication System.

Optional Equipment

TV monitor

A TV or projector, etc. is required to monitor the images for the system.

Unit

Description

TV, Projector, etc.

i

Used as a monitor and speakers.

When the TV monitor is connected to the HDMI
connector on the Communication System, you can
view the high-definition images.

The Communication System only supports 1080i-
compatible equipment.

Optional equipment especially designed for use with the Communication

System

The following optional devices are used to enhance your videoconference.

Unit

Description

PCSA-B384S ISDN Unit

Used to connect to an ISDN line. Up to three ISDN
lines; 6B channels usable.

Used to connect to an ISDN line. Up to six ISDN
lines; 12B channels usable.

Unidirectional microphone. It is recommended when
you want to pick up the voice of a speaker directed
toward the microphone.
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Unit

Description

PCSA-A7 microphone

Directional microphones that feature high sound
quality and a built-in monaural echo canceller.
(Commercially available microphones are 4-piece
set.) Several PCSA-A7 Microphones can be
connected in cascade without reduceing sound
quality. Recommended when many microphones are
required.

This function is not available on the PCS-XG55/
XG558S.

PCSA-DSGS80 HD Data
Solution Software

Software required for transmission of video and
computer pictures at the same time by connecting a
computer.

PCSA-MCGS80 HD MCU
Software

Software required for multipoint connection using
LAN or/and ISDN.

This software cannot be installed on the PCS-XGS55/
XG55S.

Cable

Use the following cable to connect a device in this system.

Cable Part No. Number
HDMI cable (3 m (9.8 ft)) 1-835-440-1x 1
HDMI cable

om (]
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System Configuration

The PCS-XG80/XG80S/XG55/XG55S HD Visual Communication System
has various system configuration capabilities using the basic components and
optional equipment. This section describes the capabilities and necessary
equipment for some typical configuration examples.

Although two PCS-A1 Microphones are depicted in the system configurations, only one
microphone is supplied with the PCS-XG55. Microphones are not supplied with the
PCS-XG80S/XGS55S.

System Configuration via a LAN

This allows you to:
* Have a point-to-point HD visual communication over LAN.
* Pick up sound in stereo by using two microphones connected to the system.

System configuration

® PCS-XG80S/XG55S HD Visual
Communication System

® PCSA-CXG80 HD Camera Unit

® PCS-RF1 Remote Commander

@ TV monitor (not supplied)
® PCS-A1 Microphones
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System Configuration via an ISDN

Connection to ISDN is required to use the PCSA-B384S or PCSA-B768S
ISDN Unit especially designed for use with this system.

This allows you to:

* Have a point-to-point HD visual communication over ISDN.

* Pick up sound in stereo by using two microphones connected to the system.

* Hold an HD visual communication with high speeds and highest quality
image transmission by connecting up to three ISDN lines (when using the
PCSA-B384S) or by connecting up to six ISDN lines (when using the PCSA-
B768S).

System configuration

@ PCS-XG80S/XG55S HD Visual
® Communication System

(@ PCSA-CXG80 HD Camera Unit

(® PCS-RF1 Remote Commander

® @ TV monitor (not supplied)
= (® PCSA-B384S or PCSA-B768S
ISDN Unit (not supplied)

ISDN ® PCS-A1 Microphones

This diagram depicts a system

configuration using the PCSA-B768S

ISDN Unit.

@ —— >

About the number of ISDN lines and B (bearer) channels

Up to three ISDN lines (6B channels) with the PCSA-B384S ISDN Unit or up
to six ISDN lines (12B channels) with the PCSA-B768S ISDN Unit can be
connected to one Communication System. The more channels you use for a
single communication, the faster speeds and higher-quality picture you can
obtain for your network communication.

When connecting to the ISDN Unit, Use the ports in ascending order.
Yes: 1,2, 3...
No: 1,6,5...
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System Configuration via a SIP

This allows you to:
* Have an HD visual communication with an IP telephone, etc. using SIP.
* Pick up sound in stereo by using two microphones connected to the system.

System configuration

® PCS-XG80S/XG55S HD Visual
Communication System
® ® ® PCSA-CXG80 HD Camera Unit
2 G (® PCS-RF1 Remote Commander
J] @ TV monitor (not supplied)

(® PCS-A1 Microphones
== o4 ® SIP server
® @ IP telephone, etc.

-

@QUD LAN
[ Note

Use the #%= 1 (LAN1) connector (z%= (LAN) connector on the PCS-XG55/XG55S) on
the Communication System when connecting your system via a SIP. Connection to a
SIP server through the 72 (LAN2) connector is not available.
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System Configuration Using Two LAN Connections (PCS-XG80/
XG80S only)

This allows you to:

Connect your system to two networks using the &= 1 (LAN1) and == 2 (LAN2)
connectors. You can use the =% 1 connector to connect a private network in
your company and =52 connector to connect to an intranet outside your
company.

* The &2 connector is not available on the PCS-XG55S.

* If your system is connected to a LAN using the a2 connector, some of the intranet/
internet functions of your system, such as SIP server connection, gatekeeper
connection, Telnet access, and Web access, are not available. If your system is
connected to one LAN, use the @& 1 connector.

For details, see “Restrictions on the Use of LAN2 (PCS-XG80/XG80S only)”
on page 97.

System configuration

@ —— >

(® PCS-XG80S HD Visual Communication System
(® PCSA-CXG80 HD Camera Unit

® PCS-RF1 Remote Commander

® TV monitor (not supplied)

(® PCS-A1 Microphones
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System Configuration via a LAN for Multipoint (PCS-XG80/XG80S
only)

You need to install the PCSA-MCG80 HD MCU software.

This software cannot be installed on the PCS-XG55S.

This allows you to:
Have a multipoint HD visual communication among up to 10 sites over LAN.

System configuration

LAN = LAN

@ PCS-XG80S HD Visual Communication System
® PCSA-CXG80 HD Camera Unit

® PCS-RF1 Remote Commander

@ TV monitor (not supplied)

® PCS-A1 Microphones

(® PCSA-MCGB80 HD MCU software (not supplied)
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System Configuration via an ISDN for Multipoint (PCS-XG80/
XG80S only)

You need to connect the optional PCSA-B384S or PCSA-B768S ISDN Unit
especially designed for use with this system and to install the optional PCSA-

MCG80 HD MCU software.

This software cannot be installed on the PCS-XG55S.

This allows you to:

Have a multipoint HD visual communication among up to six sites over ISDN.

System configuration

This diagram depicts a
system configuration using

the PCSA-B768S ISDN Unit.

(® PCS-XG80S HD Visual Communication System

® PCSA-CXG80 HD Camera Unit

® PCS-RF1 Remote Commander

@ TV monitor (not supplied)

® PCS-A1 Microphones

® PCSA-MCG80 HD MCU software (not supplied)

@ PCSA-B384S (not supplied) or PCSA-B768S (not supplied) ISDN Unit

System Configuration
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System Configuration via a LAN and ISDN for Multipoint
(PCS-XG80/XG80S only)

Installing the PCSA-MCGS80 HD MCU software in two HD Visual
Communication Systems enables you to connect to multiple sites up to 10 via
mixed LAN and ISDN lines.

This software cannot be installed on the PCS-XGS55S.

This allows you to:

Have a multipoint HD visual communication among up to 10 sites over LAN
and ISDN.

Be sure to connect two Communication Systems with the HD MCU software installed
over LAN.

System configuration

This diagram depicts a system
configuration using the PCSA-
B768S ISDN Unit.

@ PCS-XG80S HD Visual Communication System

(@ PCSA-CXG80 HD Camera Unit

(® PCS-RF1 Remote Commander

@ TV monitor (not supplied)

® PCS-A1 Microphones

(® PCSA-MCG80 HD MCU software (not supplied)

@ PCSA-B384S (not supplied) or PCSA-B768S (not supplied) ISDN Unit
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System Configuration Using the PCSA-A7 Microphones
(PCS-XG80/XG80S only)

This allows you to:

* Connect up to 40 PCSA-A7 microphones to one microphone connector,
using a cascade connection. As the PCSA-A7 microphones feature high
sound quality and can be connected in cascade without reducing sound
quality, they are available to an HD visual communication with a large
number of participants.

* Connect additional microphones during communication.

This function is not available on the PCS-XGS55S.

System configuration

@ PCS-XG80S HD Visual Communication System

(@ PCSA-CXG80 HD Camera Unit

® PCS-RF1 Remote Commander

@ TV monitor (not supplied)

(® PCSA-A7 microphone (PCSA-A7P4: 4-piece set x 2,
not supplied)

* Position the microphones about 50 cm (1.6 ft) away from the participants.
* When using speakers, do not place them in front of the microphones.
* The PCSA-A7 microphone is monaural and cannot pick up sound in stereo.

For information about PCSA-A7 microphones, see “Using the PCSA-A7
Microphones (PCS-XG80/XG80S only)” on page 169.
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System Connections
This section describes the typical system connections.

* Be sure to turn off all the equipment before making any connections.

* Do not connect/disconnect the camera cable, interface cable, or pen tablet with the power
on. Doing so may damage the Camera Unit, Communication System or ISDN Unit.

* For safety, do not connect the 100BASE-TX/10BASE-T connector to a network that

applies excess voltage via the 100BASE-TX/10BASE-T connector.

Used with the Camera Unit or ISDN Unit for the first time, the Communication

System may automatically upgrade the software of the connected equipment.

Upgrade the software according to the message displayed on the monitor screen. Be

sure not to turn off the Communication System or disconnect the cable during

upgrading. Otherwise, it may cause a malfunction of the system.
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System Connection via a LAN

fm\ PCSA-CXG80 HD Camera Unit

" \ PCS-A1 microphone

to TERMINAL r@

i

® = —=5) ores
R

Camera cable (supplied with the
Camera Unit)

PCS-XG80S/XG55S") HD Visual
Communication System

VGP-AC19V15

AC adaptor®
P Power cord®

émm—m <=L mm—

to a wall outlet

UTP cable (category 5, straight)“)

P
to LAN
1) The S VIDEO IN, EC-MIC (A7)
1/2, AUDIO 1IN, EXT 1/2, and .
@ 2 connectors are not TV monitor¥
available on the PCS-XG55S.
2) &= connector on the @J@E’]
PCS-XG55S [ [ ]
3) Supplied =————="—— to awall outlet

4) Not supplied

* Normally, connect the UTP cable to the =% 1 (LAN1) connector (indicated in green).
If the UTP cable is connected to the =72 (LAN2) connector, some of the functions
of your system may be restricted.

Fordetails, see “Restrictions on the Use of LAN2 (PCS-XG80/XG80S only)”
on page 97.

* The REC OUT jack is used to make an audio recording of a communication. This is
not used during regular communication.
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System Connection via an ISDN

PCSA-CXG80 HD Camera Unit PCS-A1 Microphone
@ —
© © Interface ISDN Unit
cable _t to TERMINAL
(supplied ‘\
r with ISDN - ~
Unit) PCSA-B384S ISDN Unit®
Camera cable
(supplied with
the Came_ra to ISDN 1-3
Unit) é PCSA-B763S
to MIC ISDN Unit
piay g o
to ISDN 1-6
& @ N | T Y,
=L Eﬁto ISDN
PCS-XG80S/XG55S") HD H
Visual Communication >
System HDMI {2 DC19.5V |SDN modular cabled
OUT &
HDMI Power cord®
cable? éﬂlﬂl—m . <[ Bm—y
to g3 VGP-AC19V15 to a wall outlet
HDMI{= AC adaptor?
IN
\C] TV monitor®
1) The S VIDEO IN, EC-MIC (A7) (0o0) J0
1/2, AUDIO 1 IN, EXT 1/2, and -gg
@ 2 connectors are not —7 ——X to a wall outlet
available on the PCS-XG55S. :
2) Supplied

3) Not supplied

The REC OUT jack is used to make an audio recording of a communication. This is not
used during regular conferences.
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System Connection via a SIP

PCSA-CXG80 HD Camera Unit PCS-A1 microphone
i@f — N\
VGP-AC1 9\3/)1 5
© © AC adaptor Power cord®

i <=H[ Bm—
ﬂu \ to a wall outlet

to TERMINAL

-

Camera cable (supplied with
the Camera Unit)

SIP server

o LAN1 f to LAN

— I_Iq ponr Dio L AUDI N o
PCS-XG80S/XG55S") HD connector connector
Visual Communication
System l
OUT\=
to DC19.5V =)

to LAN

connector
cable UTP cable (category 5, telephone,
to straight)?) etc.
HDMI %
IN
1) The S VIDEO IN, EC-MIC (A7) (] TV monitor¥
1/2, AUDIO 1IN, EXT 1/2, and
@ 2 connectors are not
available on the PCS-XG55S. @%@Dm@
2) &%= connector on the —— ——
PCS-XG55S ——— to a wall outlet
3) Supplied

4) Not supplied

* Normally, connect the UTP cable to the =% 1 (LAN1) connector (indicated in green).
If the UTP cable is connected to the =2 (LAN2) connector, some of the functions
of your system may be restricted.

Fordetails, see “Restrictions on the Use of LAN2 (PCS-XG80/XG80S only)”
on page 97.

* The REC OUT jack is used to make an audio recording of a communication. This is not
used during regular communication.
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Attaching the PCSA-CXG80 HD Camera Unit to a Tripod

To attach the Camera Unit to a tripod

Attach a tripod to the screw hole used for attaching a tripod on the bottom of
the Camera Unit.

The tripod must be set up on a flat surface and tightened firmly by hand.
Use a tripod with screws of the following specifications.

/*1/4 -20UNC

e
£=4.5—-6mm

£ =0.18 — 0.24 inches
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Preparing the System

Inserting Batteries into the Remote Commander

Most of the operations with the HD Visual Communication System can be
controlled with the supplied Remote Commander.

1 Remove the battery compartment cover.

2 Insert two size AA (R6) batteries (supplied) with correct polarities into the
battery compartment.

3 Replace the cover.

Be sure to insert the batteries @ side first. Inserting them forcibly @ side first may
damage the insulated film covering the batteries and cause a short circuit.

Battery life

When the batteries are exhausted, the LED indicator does not light if you press
any button and the Remote Commander does not function properly. Replace
both batteries with new ones.

Notes on batteries

To avoid damage from possible battery leakage or corrosion, observe the

following:

* Make sure to insert the batteries with the polarities in the correct direction.

* Do not mix old and new batteries, or different types of batteries.

* Do not attempt to charge the batteries.

* If you do not intend to use the Remote Commander for a long period of time,
remove the batteries.
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* If battery leakage occurs, clean the battery compartment and replace all the
batteries with new ones.

Programming the Remote Commander to Operate the Camera Unit

The supplied Remote Commander controls the HD Visual Communication
System using the radio frequency of 2.4 GHz. The Remote Commander and
the Communication System are paired to prevent interference from other
Remote Commanders and Systems.

Pairing between the Remote Commander and the Communication System is
programmed at the factory. If the Communication System is installed in
shielded locations, such as under a desk or in a rack, it may not be controlled
by the Remote Commander, depending on the conditions of radio-wave
reception. In this case, pair the PCSA-CXG80 HD Camera Unit with the
Remote Commander.

When performing pairing procedure, be sure to turn off other HD Visual
Communication Systems or HD Camera Units located nearby that are not targets for
pairing. If multiple devices are turned on, the Remote Commander might pair device
other than the target one.

To pair the Camera Unit with the Remote Commander

I
‘s@ /(Y (power) indicator

b : il

— LED indicator

1 Press the /) (power) switch on the Communication System to turn it on.

The /) (power) indicator on the Communication System flashes. The
indicator lights in green when the Communication System turns on.

2 Set “RF Remote Control Reception” to “Camera” in the General setup
menu.
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IPELA

2 Setup General Device Setup

Terminal Name 7
Standby Mode
Standby Time
Last Number Registration[Off  [+]
Control by Far End
Language
System LED Brightness
Camera LED Brightness
RF Remote Control Reception

For details, see “RF Remote Control Reception” on the Device Setup page
of the General setup menu on page 84.

For the procedure on how to operate the menus, see “Opening the Setup
Menu” on page 61.

3 Within three minutes after the power of the Communication System is

turned on, locate the Remote Commander closer to the RF receiver at the
rear of the Camera Unit, and press the RETURN and TOOLS buttons at the
same time.

The Remote Commander and the Camera Unit enter pairing mode, and the
LED indicator on the Remote Commander flashes rapidly.

4 Ppress the ENTER button on the Remote Commander.

If the LED indicator on the Remote Commander flashes more slowly,
pairing the units has succeeded.

The pairing between the Communication System and the Remote
Commander is disabled.

When pairing has failed
The LED indicator on the Remote Commander continues flashing rapidly. In
this case, press the ENTER button on the Remote Commander again.

To cancel pairing
Press the 1/() (power) switch on the Communication System.

* When the LED indicator does not flash even if you press any button on the Remote
Commander, the batteries might be exhausted. Replace both batteries with new ones.

* Once pairing is established between the units, it will not be erased even if the batteries
are replaced.

¢ Operable distance is 10 m (32.8 ft.). Depending on the circumstances, a longer
operable distance may be possible.
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To pair the Communication System with the Remote Commander again

Follow the procedure below to release the paring with the Camera Unit, and to
perform pairing with the System again.

1 Turn on the Communication System.

2 Set“RF Remote Control Reception” to “System” on the Device Setup page
of the General setup menu (page 84).

3 Within three minutes after the power is on, locate the Remote Commander
closer to the Communication System, and press the RETURN and TOOLS
buttons at the same time.

The LED indicator flashes rapidly.

4 Press the ENTER button on the Remote Commander.

If the LED indicator flashes more slowly, pairing between the units has
succeeded.

Pairing between the Camera Unit and Remote Commander is released.
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Turning the System On/Off

This section describes how to turn on or off the Communication System.

Turning On
1 Turn on the TV monitor.
2 Turn on the power of any other equipment to be used for this connection.

3 Press the /) (power) switch on the Communication System to turn it on.

=

/(Y (power) switch
/(Y (power) indicator

The I/ (power) indicator on the Communication System flashes. The
indicator lights in green when the Communication System turns on.

The Home menu will appear on the monitor screen and the picture shot by
the local camera will also appear in the Home menu.

Home menu

IPELA AAA IPXXCXOOCXXX XXX (I Ready to connect.  5/11/2008 13:00
4 Home

% Connect

For details on the Home menu, see “Identifying the Home Menu” on page 48.
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 After the power is turned on, the camera moves automatically for trial operation. Be
careful not to catch your finger.

* If you use force to prevent the camera from moving, the camera may stop moving and
the picture may not be displayed. In this case, turn off the System, and turn it on again.

* When you turn on the power of the Communication System for the first time after
installation, the setup wizard will appear after the self-diagnosis is completed. Set up
your system following the wizard.

For setups using the wizard, see “Setting Up the System Immediately after
the Installation — Initial Setup Wizard” on page 45.

» Used with an optional device especially designed for use with this system, such as the
Camera Unit and ISDN Unit, for the first time, the Communication System may
automatically upgrade the software of the connected device. Upgrade the software
according to the message displayed on the monitor screen. Be sure not to turn off the
Communication System or disconnect the cable during upgrading. Otherwise, it may
cause a malfunction of the system. System malfunction may also occur when a system
power-off has been caused by an accidental problem such as a power interruption
during upgrading. If connection of the Camera Unit, ISDN Unit, etc. to the
Communication System is not re-established even after the system power is
recovered, consult a Sony dealer.

* You can check the versions of the Communication System, optional dedicated
equipment connected and the application software installed using the Machine Status
menu.

For details on the Machine Status menu, see page 93.

Standby Mode Function

42

To save power, the Communication System will enter standby mode if you do
not operate it for a specified period of time. When the Communication System
is in standby mode, the I/() indicator lights in orange.

You can turn on the Communication System with any button on the Remote
Commander if the System is in standby mode.

Once the Communication System receives a call, the standby mode is
automatically released.

Turning the System On/Off



Setting the HD Visual Communication System to Standby Mode

1 Display the Home menu on the monitor screen, then press the I/() button
on the Remote Commander.

The message “Power off?” appears on the monitor screen.

2 Pressthe 4, ¥, «or=» button on the Remote Commander to select OK, then
press the ENTER button.

You may press the /() button on the Remote Commander.

The Communication System enters standby mode and the /() indicator on
the Communication System lights in orange.

To cancel setting the system to standby
Select “Cancel” with the 4, ¥, « or ® button on the Remote Commander, then
press the ENTER button in step 2 above.

To release the standby mode
Press any button on the Remote Commander.

To specify the standby time

Specify the time that you want the system to remain on before entering into
standby mode (1 to 99 minutes) by setting “Standby Time” of the Device Setup
page of the General setup menu. If you do not want the system to enter the
standby mode, set “Standby Mode” to “Off”.

For the settings, see “Standby Time” and “Standby Mode” in the General
setup menu on page 83.

Turning Off

1 Press the VO (power) switch on the Communication System.

The message “Power off?” appears on the monitor screen.

2 Press the 4, ¥, « or # button on the Remote Commander to select “Power
off”, and press the ENTER button.

You can power off the system by pressing the /() (power) button on the
Remote Commander.

The system turns off.

3 Turn off the power of other equipment used for the communication.

¢ Turn off the power switch on the Communication System when the system will not
be used for an extended period. While the power switch is off, you cannot receive a
call from a remote party.
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* Be sure to unplug the power cord after the power of the system is turned off
completely.

* If the system is unplugged for about 10 days or longer, the clock setting of the system
may be reset. In this case, re-set the date and time in the Clock Set page of the General
setup menu.

Adjusting the Volume on the TV Monitor

The procedure for volume adjustment during system setup differs from the
procedure during communication.

Adjust the volume on the TV monitor during system setup, and adjust the
volume on the Communication System while in communication.

Volume adjustment during setup

Before adjusting the volume on the TV monitor, set the volume on the
Communication System to the appropriate position.

1 Press the VOLUME +/— buttons on the Remote Commander to set the
volume level on the adjustment bar displayed on the screen to the middle
position.

o ———— 1 1

2 Adjust the volume on the TV monitor so that you can properly hear a
remote party’s speaking.

Do not activate the TV’s surround sound feature as it may cause the echo canceller of
the Communication System not to function properly and make strange sounds.

Volume adjustment during communication

Press the VOLUME +/- buttons on the Remote Commander to adjust the
volume on the Communication System during communication.
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Setting Up the System Immediately
after the Installation — Initial Setup
Wizard

When you turn on the Communication System for the first time after
installation and the self-diagnosis is completed, the setup wizard appears on
the monitor screen. Register your local system data with the setup wizard using
the Remote Commander.

* You can change the settings made with the setup wizard later using the setup menus.
* The setup wizard will also be displayed when you install the PCSA-B384S or PCSA-
B768S ISDN Unit to your system later. Perform the setup again.

1I/ELA
2 Wizard

Set Region and Clock
Select Line I/F

Set up LAN

To select the on-screen language

1 Usethe 4, ¥, « or # button on the Remote Commander to select “Select
Language” in the setup wizard, then press the ENTER button.

1IPELA
2 Wizard Select Language

Select Language

Select the on-screen language.

Cance
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2 Use the 4, ¥, « or #» button on the Remote Commander to select the
language to be used for the on-screen menus and messages.
Select from among English, French, German, Japanese, Spanish, Italian,
Simplified Chinese, Portuguese, Traditional Chinese, Korean, Dutch,
Danish, Swedish, Finnish, Polish, Russian, Arabic, Thai, Turkish,
Norwegian, Welsh, Czech and Hungarian.

3 Use the 4, ¥, « or #» button on the Remote Commander to select “Save”,
then press the ENTER button.

The setup wizard is restored.

To set the region and clock

1 Usethe 4, ¥, « or # button on the Remote Commander to select “Set
Region and Clock” in the setup wizard, then press the ENTER button.

2 Setthe region and clock items.

1I=ELA
2 Wizard Set Region and Clock

Select the region
Set Region and C| [ —
Select the display patter
Enter the year I
Enter the month [
Enter the day |:|
Enter the time ]

Gance

Select the region: Select the country or region where the system is used.

Select the display pattern: Select the display pattern of year, month and
day.

Enter the year, Enter the month, Enter the day, Enter the time: Enter
the date and time using the number buttons on the Remote
Commander.

For the procedure to enter the numbers using the Remote Commander, see
“Entering Characters Using the Remote Commander” on page 58.

3 Use the 4, ¥, <« or » button on the Remote Commander to select “Save”,
then press the ENTER button.

The setup wizard is restored.

To select the line interface

1 Usethe 4, ¥, @« or » button on the Remote Commander to select “Select
Line I/F” in the seup wizard, then press the ENTER button.
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2 Select the line interface to be used.

IPELA
2 Wizard Select Line I/F

Which is your Line I/F? (Multiple selection available)

Select Line

Which is your primary Line VF?

[@r [Cison O sip |

Which is your Line I/F?: Select from among IP, ISDN and SIP.

Which is your primary Line I/F?: If you select two or more interfaces
with “Which is your Line I/F?”, select the interface you most use.
Select from among IP, ISDN and SIP.

3 Use the 4, ¥, « or » button on the Remote Commander to select “Save”,
then press the ENTER button.

The setup wizard appears.

To set up a LAN connection
Select “Set up LAN” in the setup wizard, then set up a LAN connection.

To set up an ISDN line
Select “Set up ISDN” in the setup wizard, then set up an ISDN line connection.

To set up a SIP
Select “Set up SIP” in the setup wizard, then set up a SIP connection.
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Using the Menus

The HD Visual Communication System uses the on-screen menus to make
various adjustments and settings. This section explains how to adjust or set the
items in the menus and gives a brief introduction to the menus.

Identifying the Home Menu

The Home menu is displayed on the monitor screen when the system is
turned on and has not been connected to a remote party. The Home menu
displays the image shot by the local camera, local system name, current date
and time and buttons to open the menus.

You can select the items shown in the Home menu using the Home Menul to
Home Menu3 pages in the Home Menu setup menu.

The descriptions of the items displayed in the Home menu are given below
using the default menu and the menu with all items shown, as the examples.

Home menu (default)

117 7 i

¥ Home

%2 Camera
| & connest

79
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Home menu (with all items shown)

N N

I-_-IE [N IPxxxxxxxxxxx
M@lm e [ =
o
[ — |
@-—0@
_. Room 101 Roem 201 O"csA omceE
(1)-—o® ProneBook__|
@——:oﬂ‘ DetailedDial | [IP_@ [v][ ][ pial
| I

@ IPELA logo

®
@
@

(® Background screen
Image shot by the camera is displayed.

® Local terminal name
The local terminal name set in the menu is displayed.

® IP address of the local system

The IP address of the local system is shown.

By changing the “Number Display” setting (page 86) on the Home Menul
page of the Home Menu setup menu, you can display the gatekeeper’s user
name and user number, NAT address, etc. instead of the IP address.

(® ISDN line number
The ISDN line number of the local system is shown.

(® Local system status
The status on the local terminal is shown.

@ Date and time
The current date and clock are displayed.

Camera button
The Camera menu opens when you select the button and press the ENTER
button on the Remote Commander.
The Camera menu is used to adjust the camera angle or brightness, or to
preset the camera adjustments and to move the camera to the preset
position.
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Camera menu

IPELA 5/11/2008 13:00

2 camera

Brightness

Preset

I

Details

For details on the Camera menu, see page 136.

(® Tools button

The Tools menu opens when you select the button and press the ENTER
button on the Remote Commander.

The menu is used to carry out presentation, streaming, recording,
annotation, etc. The Machine Status menu or Setup menus can be displayed
using the buttons in the Tools menu.

Tools menu

1IPELA

B Tools
! Streaming [Suspended]
E; Recording [Suspended]
(g Execute
|0l Icon display
22 Reject Answer [off  [+]
& screen Capire

For details on the Tools menu, see page 151.
For details on the Machine Status menu, see page 93.
For details on the Setup menu, see page 61.

History button

The History menu opens when you select the button and press the ENTER
button on the Remote Commander.

The menu is used to check the incoming call and outgoing call histories or
to call a remote party from the history list.
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History menu

1I/ELa 511172008 1300
History
1A Home T 200m0s/01 000 (12:34:50
Answer Dial History2
555-555-555 200805126 00:00 (03:25:45)
Missed Call Dial History3
17174747 2008105126 00:00 (01:00:17)
Dial Historya
18.18.18.18 2008105126 00:00 (01:00:18)
Dial Historys
19.19.19.19 2008105126 00:00 (01:00:19)
Dial History6
20202020 2008105126 00:00 (01:00:20)
Dial History?
T Phone Book 66.66.66.66 2008105126 00:08 (00:00:00)
Dial Historys
%+ Detailed Dial 88.88.88.88 008/05/2

For details on the History menu, see page 113.

@ Phone Book button
The Phone Book opens when you select the button and press the ENTER
button on the Remote Commander.
The menu is used to register a remote party to the Phone Book or to call a
remote party registered in the Phone Book.

Phone Book
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Foom 101 Room 102 Offce A

m Groups

%+ Detailed Dial

[ Groups ] | tsonorzuisores | | passassassass | | isonsereseaato
(Group Bt ] La_l |_ﬂ_| pas
M Group7 1P0.0.00 1P 123.456.789.012 ISDN 01-2345-6789

For details on the Phone Book, see page 122.

@ Connect button
The Connect menu opens when you select “Connect” in the Home menu
and press the ENTER button on the Remote Commander.
The Connect menu is used to call a remote party.
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Connect menu

1IPELA 5/11/2008 13:00

For details, see “Calling a Remote Party by Using the Connect Menu” on
page 109.

@9 Detailed Dial button
The Detailed Dial menu opens when you select the Detailed Dial button
and press the ENTER button on the Remote Commander.
The menu is used to call a remote party by setting the details of the dial
setup options.

Detailed Dial menu

IPELA

&+ Detailed Dial

ﬁ Home. Dial to|
e P
‘Communication
BitRate 1024kbps [v]
Number of Lines [ 1B (64K) [ |

& Phone Book

For details on the Detailed Dial menu, see page 116.

Instruction display
The instructions for the operation in the Home menu are displayed.

@ Line interface select button

Selecting the button opens the drop-down list of the line interface. Select
the interface to be used, then press the ENTER button.

Number input box

To call a remote party not registered in the Phone Book, select the box and
enter the party’s IP address, Domain name, ISDN line number, etc.
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@ Dial button
To call a remote party whose number or address has been entered in the
number input box, select this button, then press the ENTER button on the
Remote Commander.

One-touch dial buttons
The submenu is displayed when you select a thumbnail for a remote party
you want to call and press the ENTER button on the Remote Commander.
Using the submenu you can call the remote party.
You can also call the remote parties assigned to the one-touch buttons by
pressing the F1 to F4 buttons on the Remote Commander.

11re o

Display

Arome | D&
-
=
o (8]

© Video input
The selected video input on the local system is displayed.
The displayed video input is shown as the label set in “Custom Input
Label” in the Video setup menu.

@ Audio input
The selected audio input on the local system is displayed.

©® LAN status
The current status of LAN connection is shown. The LAN indicator is
shown in white when LAN is enabled for use and in gray when it is
disabled.

O ISDN status

The current status of the ISDN unit ports is shown. The port indicator is
shown in white when it is enabled for use and in gray when it is disabled.

@ Indicators
The status indicators for when the microphone is off, a “Memory Stick” is
inserted, a pen tablet is connected, streaming broadcast is being executed,
recording is being executed, etc. are displayed.

0O Audio level meter
The current audio input level is displayed.
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© Volume
The volume-level bar is temporarily shown when you adjust the volume of
the Communication System.

© Warning messages
If system malfunction occurs, a warning, instruction, etc. are displayed.
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Operation Using the Menu

The basic operation through the menu is explained taking manual brightness

adjustment in the Camera menu as an example

Buttons used for menu operations

IPELA

PRESENTATION

RETURN TOOLS

RETURN button

BACK
CONNECT  SPACE DISCONNECT

HOE

L #/%/«/% buttons

—— ENTER button

Number buttons

TONE DOT.

DOT button

EIC)EsS

ON/OFF

SONY
PoSRFT
v
1 Display the Home menu.
I1IPELA AAA TPIXXX XXX XXX XXX () Ready to connect.  5/11/2008 13:00
A Home
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2 Usethe 4, ¥, «or * button on the Remote Commander to select “Camera”,
then press the ENTER button.

The Camera menu appears.

[ET-TWN st 1300
Adjustments
Brightness

2 camera Proset

3 Use the 4, ¥, « or # button on the Remote Commander to select
“Brightness”, then press the ENTER button.

The Brightness menu appears.

1IPELA 51172008 13:00

£ Adjustments > Brightness

Auto Adjustment | v |
/ [-——o—+] \
) i

4 Ppress the ENTER button on the Remote Commander.
Now you can select the adjustment mode.

5 Usethe 4, ¥, «or # button to select the desired item from the drop-down
list, then press the ENTER button.

The menu goes to Manual Adjustment mode.

1IPELA 51172008 13:00

£ Adjustments > Brightness

Manual Adjustment | ¥

o-

f=
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6 Use the 4, ¥, « or #» button on the Remote Commander to select the
brightness adjustment bar, then press the ENTER button.

1IPELA 5/11/2008 13:00

e 8
€ Adjustments > Brightness
Manual Adjustment | v
) \
.

7 Usethe 4, ¥, «or» button to adjust the brightness of the image, then press
the ENTER button.

8 Use the 4, ¥, « or % button on the Remote Commander to select
“Previous”, then press the ENTER button after the adjustment is finished.
You can also use the RETURN button on the Remote Commander.

The Brightness menu is restored.

9 Use the 4, ¥, <« or » button on the Remote Commander to select
“Previous”, then press the ENTER button. You can also use the RETURN
button on the Remote Commander.

The Camera menu is restored.

When the “Save” button is displayed in the menu

When the setting or adjustment is finished, press the 4, ¥, <« or # button on the
Remote Commander to select “Save” and press the ENTER button. The setting
or adjusted value becomes effective.

When the “Cancel” button is displayed in the menu

If you press the 4, ¥, « or » button on the Remote Commander to select
“Cancel” and press the ENTER button, the setting or adjustment is canceled
and the previous one is restored.
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Entering Characters Using the Remote Commander

58

This section explains how to enter the letters, numbers or symbols in the text
box in the menu using the Remote Commander.

IPELA
PRESENTATION
[ 2) 179 F1 button
I e/ Fs F | F2 button
O0O®mOo
LAYOUT VIDEO INPUT_CAMERA F3 button
—— & button

—— BACK SPACE button

CONNECT  SP/CE DISCONNECT

@ @ DOT button
= = =

ON/OFF

SONY

PCS-RF1

V

Gno Number buttons

To enter letters or numbers
1 Press the F1 button repeatedly to enable the letters or numbers to be input.

2 Press the number buttons to enter a letter or number you want.
You can enter the letter shown on each button by pressing it repeatedly.
You can enter the number shown on each button by pressing it once.

To enter a symbol

Press the F2 button repeatedly to select the desired symbol. Pressing the 0
button repeatedly also enables you to enter a symbol.

To enter a dot (.) for an IP address
Press the # button or DOT button.

To delete a character
Press the BACK SPACE button. The last entered character is deleted.
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To delete all the characters entered
Press the F3 button.

Entering Characters Using the On-Screen Keyboard

This section explains how to enter the letters or numbers in the text box in the
menu using the on-screen keyboard displayed on the monitor screen.

When “Display On-Screen Keyboard” is set to “On” in the Menu Screens page
of the General setup menu (page 84), the on-screen keyboard automatically
appears on the screen if character input is required in the menu.

You can also use the buttons on the Remote Commander even when the on-screen
keyboard is displayed on the screen.

To enter letters or numbers

[Num | [ 1 | aBc || oeF JIg

| GHI |[ JkL | mNoO ||Space

| PaRrs || TUV || wxyz |[symbol

L * Jl o |l # | pot]
| space || < [ — |
| End || Cancel |

1 Usethe 4, ¥, « or #» button on the Remote Commander to select “Num”
or “Alpha” on the on-screen keyboard, then press the ENTER button.

Select “Num” to enter numbers, and “Alpha” to enter alphabetic letters.

2 Usethe 4, ¥, «or = button on the Remote Commander to select the button
on the on-screen keyboard on which the desired character is indicated, then
press the ENTER button.

When you select a number, the selected number is entered.

When you select an alphabetic letter, a submenu with available letters
appears on the on-screen keyboard. Select the desired letter and press the
ENTER button on the Remote Commander. The selected letter is entered.
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| REG |Back

Alpha Previous Space

(KB ifomm
i

Space ” «— ” — |

| End || Cancel |

3 Repeat step 2 to enter all the letters or numbers.

4 After the input is complete, select “End”, then press the ENTER button on
the Remote Commander.

To enter a symbol

1 Select “Symbol” on the on-screen keyboard, then press the ENTER button
on the Remote Commander.

The submenu with available symbols are displayed.

2 Use the 4, ¥, « or » button on the Remote Commander to select the
desired symbol, then press the ENTER button.

The selected symbol is entered.
3 Repeat steps 1 and 2 to enter all the symbols.

4 After the input is complete, select “End”, then press the ENTER button on
the Remote Commander.

To enter a dot (.) for an IP address
Select “#” or “Dot” on the on-screen keyboard, then press the ENTER button
on the Remote Commander.

To enter a space
Select “Space”, then press the ENTER button on the Remote Commander.

To delete a character
To erase the last entered character, select “Back Space”, then press the ENTER
button on the Remote Commander.

To delete all the characters entered

Select “Cancel”, then press the ENTER button on the Remote Commander.
Pressing the F3 button on the Remote Commander also deletes all the
characters entered.
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Chapter 2:
Registration and
Setup for System
Administrators

This chapter describes the registration and settings to be carried out by the
system administrator.The chapter is intended to be read by the system
administrator.

Registering Local Information

Before connecting, set up the local system using the Setup menus. This section
describes how to display the Setup menus and gives a introduction to the
menus.

Opening the Setup Menu

1 Press the Tools button on the Remote Commander, or use the 4, ¥, «or
button to select “Tools” in the Home menu, then press the ENTER button.

The Tools menu appears on the monitor screen.

IPELA

8 Tools
st Streaming [Suspended]
% Recording [Suspended]
IOl Icon display
>3 Reject Answer
&7 Screen Capture
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2 Usethe 4, ¥, «or» button to select “Setup”, then press the ENTER button

on the Remote Commander.
The Setup menu appears on the monitor screen.

Menus available from a setup menu

The Setup menus are grouped into the following depending on the setting
items. The setup menus that include many setting items are divided into
multiple pages. Select an appropriate menu button to set the respective
item.

The commonly-used menu butttons are displayed on the screen at the
factory. Pressing the F4 button on the Remote Commander allows you to
display the maximum number of setup menu buttons. To restore the
commonly-used setup display, press the F4 button again.

Menu buttons

IPELA
2 Setup Line IF
£ Home \ == Line IF Line Interface

= Dial & 1P O1sbN [ sIP
= Answer Primary Line Interface

% Multipoint

P ISDN sip
q Audiol ® o o}
Use LAN2 ot

-Video2
5 LAN
% LAN
s LAN

@
]
b

For a description of each setup menu, see the page for that menu indicated
below.

Line Interface setup menu (see page 65)
Dial setup menu (see page 65)

Answer setup menu (see page 66)
Multipoint setup menu (see page 66)
Communication setup menu (see page 67)
Audio setup menu (see page 71)

Video setup menu (see page 73)

LAN setup menu (see page 76)

QoS setup menu (see page 78)

TOS setup menu (see page 80)

SIP setup menu (see page 80)

ISDN setup menu (see page 81)
Annotation setup menu (see page 82)
Camera setup menu (see page 83)
General setup menu (see page 83)

Home Menu setup menu (see page 85)
Administrator setup menu (see page 87)
Encryption setup menu (see page 91)
Shared Phone Book setup menu (see page 92)
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The Multipoint setup menu is displayed only when the PCSA-MCG80 HD MCU
software is installed in the Communication System.

3 Usethe 4, ¥, « or # button on the Remote Commander to select the menu

button you want to set, then press the ENTER or # button.

The selected

setup menu appears.

Menu button

Setting items

IPELA

& Setup Dial

Telephone Mode
[EECECI| More Options Enable
User Name Input
Prefix
Prefix-A
Prefix-B
Prefix-C
LAN Prefix
LAN Prefix

[Auto__________[+]

Disable

Save Cancel

4 Usethe 4, ¥, « or» button on the Remote Commander to select the setting
item, then press the ENTER button.

1IPELA

& Setup Dial

EECE  Telephone Mode

Auto v

(Auto |
G711 pelaw
G711 Alaw

5 Select the desired item from the drop-down list, or enter the characters in

the text box.

For individual items, see pages 65 to 91.

6 After the selection or character input is completed, use the 4, ¥, « or »
button to select “Save”, then press the ENTER button.

The setting is saved, and the Setup menu is restored.
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To cancel the setup

Use the 4, ¥, « or # button on the Remote Commander to select “Cancel”,
then press the ENTER button. Or press the RETURN button on the Remote
Commander.

To return to the left column
Press the < button or RETURN button on the Remote Commander.
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Line Interface Setup Menu

The Line Interface setup menu is used to
select the line interface you use for
connection with a remote party.

Line Interface

Allows you to select the line interface from
among “IP”, “ISDN” and “SIP”. You can
select multiple interfaces.

Primary Line Interface

Allows you to select the line interface you
use most from among IP, SIP and ISDN.

Use LAN2 (PCS-XG80/XG80S only)

Allows you to select whether to use the == 2

(LAN?2) connector on the rear of the

Communication System.

Off: Select when you do not use the =2
(LANZ2) connector.

On: Select when you use the =2 (LAN2)
connector.

When “Use LAN2” is set to “On”, some of the
functions using the &= 2 connector are
restricted. For details, see “Restrictions on the
Use of LAN2 (PCS-XG80/XG80S only)” on
page 97.

Dial Setup Menu

The Dial setup menu is used to set the
attributes for dialing.

@ Dial Dial

Telephone Mode

Allows you to select the audio compression

format when conducting a voice meeting.

Auto: Selects an appropriate format
automatically.

G.711p-law: Selects the format based on the
G.711p-law standard.

G.711A-law: Selects the format based on
the G.711A-law standard.

More Options Enable

Allows you to select whether to display the

More Options button in the List Edit menu

of the Phone Book. You can set the detailed

items for dialing in the List Edit menu by

selecting the More Options button.

On: Displays the More Options button.

Off: Does not display the More Options
button.

User Name Input

Allows you to select whether to register user

names in the communications log when

connection is made.

Off: Disables the recording of the user
names.

On: Select when you want to record user
names. Each time dialing takes place,
the user name input menu appears.

Prefix

Select the prefix number (call number

prefixed to a line number).

Prefix-None: Select when you are not using
a prefix number.

Prefix-A: Select when you use the prefix set
in “Prefix-A”.

Prefix-B: Select when you use the prefix set
in “Prefix-B”.

Prefix-C: Select when you use the prefix set
in “Prefix-C”.

Prefix-A

When “Prefix” is set to “Prefix-A”, the line
number prefixed by the prefix (dial number)
registered in this box is dialed.

Prefix-B

When “Prefix” is set to “Prefix-B”, the line
number prefixed by the prefix (dial number)
registered in this box is dialed.

Prefix-C

When “Prefix” is set to “Prefix-C”, the line
number prefixed by the prefix (dial number)
registered in this box is dialed.

Enter “9” when this is required to make an
outgoing call.

Registering Local Information 65

slojelisiuiwpy waisAg 1oy dnjag pue uonelsibay :g Jeydeyd



Select LAN Prefix

Allows you to select whether to use the LAN
prefix when dialing via a LAN.

Disable: Disables the LAN prefix.

Enable: Enables the LAN prefix.

LAN Prefix

When dialing using the IP connection, the
information entered into this box is added to
the beginning of the IP address. Select
whether to use the LAN prefix in “Select
LAN Prefix”.

Answer Setup Menu

The Answer setup menu is used to set up call
reception.

‘@&. Answer Answer

Auto Answer

Allows you to select whether the system

answers calls automatically.

On: Answers calls automatically. When a
call comes in, the line is automatically
connected.

Off: Allows you to answer calls manually.
When a call comes in, the phone rings. If
you select “OK” in the “Answer?”
message, the line is connected.

ISDN MSN

Allows you to select whether you are using

the Multiple Subscriber Number.

Off: Select when you do not use the
Multiple Subscriber Number.

On: Select when you use the Multiple
Subscriber Number.

Mic on Answer

Allows you to select whether to transmit

audio from your site when you receive a call

and connect it.

On: Enables transmission of audio when
answering a call.

Off: Disables transmission of audio when
answering a call.
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Reject Answer (PCS-XG80/XG80S

only)

Allows you to select whether to connect a

remote party’s calling during

communication.

On: Disables the connection of a remote
party.

Off: Enables the connection of a remote

party.

For details, see “Turning Off the Sound
Momentarily — Muting Function” on page
133.

Multipoint Setup Menu
(PCS-XG80/XG80S only)

The Multipoint setup menu is used to set up
multipoint connection when the local
system is used as the main terminal.

The menu is displayed only when the PCSA-
MCG80 HD MCU software is installed in
the Communication System.

For the procedure how to install the PCSA-
MCGS80 software, see page 192.

When the local system is used as the main
terminal and connected with remote terminals
other than the PCS-XG80/XG80S/XG55/
XG558S, the maximum bandwidth to be used is
restricted to 4 Mbps.

| % Muttipoint Multipoint

Multipoint Mode

AUTO: Switches from point-to-point
connection to multipoint connection
automatically.

On: Enables you to make a multipoint
connection at any time.

Broadcast Mode

Allows you to select the broadcast mode.

Split: Displays the picture from the
connected terminals in split windows.

Voice Activate: Detects the terminal where
a speaker has the loudest voice, and
automatically transmits the picture of
this terminal to all other terminals.



Voice Activate (720P): Enables
transmission of pictures with resolution
of 720p (1280 x 720 pixels) in H.264
Video Mode when “Voice Activate”
mode is activated.

¢ The “Voice Activate (720P)” mode cannot
be selected when the communication is made
via an ISDN or SIP connection. Even for an
IP connection, this mode is not available if
the remote party does not support H.264
Video Mode.

¢ When “Broadcast Mode” is set to “Voice
Activate (720P)”, you cannot change
“Broadcast Mode” during communication.
Select the Broadcast Mode before starting
communication.

Split

Allows you to select the type of split display

used to display local and remote pictures on

a single monitor during a multipoint

connection.

Automatic: When there are two or three
terminals connected, the display is
automatically split into four parts. When
there are four or five terminals
connected, it is split into six parts.

Six-screen Mosaic: The display is split into
six parts regardless of the number of
terminals connected.

When there is only one terminal connected, the
display switches to full screen regardless of the
selection of the setting.

Communication Setup Menu

The Communication setup menu is used to
set up communications.

The contents of the Communication menu vary
with “Line Interface” setting in the Line I/F
setup menu, or “Individual Settings for
Transmission/Reception” or “Individual
Settings for Point-to-Point/Multipoint” setting
in the Communication setup menu.

The Communication page number after the
Communication2 page also varies according to
the number of setting items.

> Communication IP

The menu is used to set up the
communication mode for the IP connection.

Individual Settings for Transmission/

Reception

Allows you to select whether to configure

the IP settings for transmission and

reception individually.

Off: Select to configure the IP settings for
transmission and reception commonly.

On: Select to configure the IP settings for
transmission and reception individually.

Individual Settings for Point-to-Point/

Multipoint (PCS-XG80/XG80S only)

Allows you to select whether to configure

the IP settings for a point-to-point

connection and multipoint connection

individually.

Off: Select to configure the IP settings for
both connections commonly.

On: Select to configure the IP settings for a
point-to-point connection and
multipoint connection individually.

The setting items and page numbers in the IP:
Mode page vary according to the setting of
“Individual Settings”.

¢ Communication IP: Mode

Total Bandwidth (PCS-XG80/XG80S
only)

Allows you to select the total bandwidth to
be used with this system.

In multipoint connection, the total
bandwidth of all points is displayed.

You can select from among 128Kbps,
384Kbps, 512Kbps, 1Mbps, 2Mbps, 3Mbps,
4Mbps, SMbps, 6Mbps, 7Mbps, 8Mbps,
9Mbps, 10Mbps and Other.
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In multipoint connection, the actual
Communication Bit Rate for each point is
automatically adjusted so as not to exceed
“Total Bandwidth”.

Communication Bit Rate

Allows you to select the communication bit
rate per point.

When “Individual Settings for
Transmission/Reception” or “Individual
Settings for Point-to-Point/Multipoint™ on
the IP page is set to “On”, you can set this
item for transmission and reception, and
point-to-point and multipoint connections
individually.

You can select from among 128Kbps,
384Kbps, 512Kbps, 1Mbps, 2Mbps, 3Mbps,
4Mbps, SMbps, 6Mbps, 7Mbps, 8Mbps,
9Mbps, 10Mbps and Other.

The 5Mbps, 6Mbps, 7Mbps, 8Mbps, 9Mbps,
and 10Mbps settings are not available on the

PCS-XG55/XG55S.

Audio Mode

Allows you to select the compression format
of audio to be sent to a remote party. When
“Individual Settings for Transmission/
Reception” or “Individual Settings for Point-
to-Point/Multipoint” on the IP page is set to
“On”, you can set this item for transmission
and reception, and point-to-point and
multipoint connections individually.

You can select multiple formats from among
G.711, G.722, G.728 and MPEG4 (MPEG4
AAC).

When the remote system does not support the
audio mode selected by the local site, the mode
automatically becomes “G.711”.

Far End Camera Control

Allows you to select whether to enable the
control of each other’s cameras from each
other’s site.

When “Individual Settings for Point-to-
Point/Multipoint” for IP is set to “On”, you
can set this item individually for point-to-
point and multipoint connections.
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On: Enables the control of each other’s
cameras. Normally, set to “On”.
Off: Disables the control of each other’s

cameras.

H.239

Use of the presentation mode complying

with H.239 allows you to transmit the

presentation data and picture from the

camera simultaneously.

This item allows you to select whether to use

the presentation mode based on the H.239

presentation standard.

On: Enables the presentation mode based on
the H.239 presentation standard.

Off: Disables the presentation mode based
on the H.239 presentation standard.

H.239 Ratio

When H.239 presentation transmissions are

made with the system, the H.239

presentation data shares bandwidth with

camera images that are also being sent. This

setting allows you to select how much of the

total bandwidth to use for H.239

presentation data transmissions.

2/3: Use 2/3 of the total bandwidth for H.239
presentation data transmissions.

1/2: Use 1/2 of the total bandwidth for H.239
presentation data transmissions.

1/3: Use 1/3 of the total bandwidth for H.239
presentation data transmissions.

Screen Size

Allows you to select the screen size of the
picture to be transmitted or received.
When “Individual Settings for
Transmission/Reception” or “Individual
Settings for Point-to-Point/Multipoint” on
the IP page is set to “On”, you can set this
item for transmission and reception, and
point-to-point and multipoint connections
individually.

You can select from among 720, W4CIF,
W432P, WCIF, 4CIF, CIF, QCIF and
AUTO.

Video Mode

Allows you to select the compression format
of pictures to be transmitted or received.
When “Individual Settings for
Transmission/Reception” or “Individual
Settings for Point-to-Point/Multipoint” on



the IP page is set to “On”, you can set this
item for transmission and reception, and
point-to-point and multipoint connections
individually.

You can select from among H.261, H.263+,
and H.264.

Video Frame
Allows you to select the number of video
frames during transmission or reception.
When “Individual Settings for
Transmission/Reception” or “Individual
Settings for Point-to-Point/Multipoint” on
the IP page is set to “On”, you can set this
item for transmission and reception, and
point-to-point and multipoint connections
individually.
15fps: Send CIF format pictures at a
maximum rate of 15 frames per second.
30fps: Send CIF format pictures at a
maximum rate of 30 frames per second.
60fps: Send CIF format pictures at a
maximum rate of 60 frames per second.
AUTO: Switch the number of frames
automatically.

DN

The menu is used to set up the
communication mode for an ISDN
connection.

Individual Settings for Point-to-Point/

Multipoint (PCS-XG80/XG80S only)

Allows you to select whether to configure

the ISDN settings for point-to-point and

multipoint connections individually.

Off: Select to configure the ISDN settings
for both connections commonly.

On: Select to configure the ISDN settings
for point-to-point and multipoint
connections individually.

The setting items and page numbers for
“ISDN: Mode” varies according to the setting
of “Individual Settings”.

> Communication ISDN: Mode

ISDN Bandwidth (Dial)

Allows you to select the number of ISDN
lines used for dialing.

When “Individual Settings for Point-to-
Point/Multipoint” on the ISDN page is set to
“On”, you can set this item for point-to-point
and multipoint connections individually.
You can select from among 1B (64K), 2B
(128K), 3B (192K), 4B (256K), 5B (320K),
6B (384K), 8B (512K) and 12B (768K).

ISDN Bandwidth (Answer)

Allows you to select the number of ISDN
lines used for answering.

You can select from among 1B (64K), 2B
(128K), 3B (192K), 4B (256K), 5B (320K),
6B (384K), 8B (512K) and 12B (768K).

Audio Mode

Allows you to select the compression format
of audio to be sent to a remote party.

You can select from among G.711, G.722,
G.728 and MPEG4 (MPEG4 AAC).

When the remote system does not support the
audio mode selected by the local site, the mode
automatically becomes “G.711”.

Far End Camera Control

Allows you to select whether to enable the

control of each other’s cameras from each

other’s site.

On: Enables the control of each other’s
cameras. Normally, set to “On”.

Off: Disables the control of each other’s
cameras.

H.239

Allows you to select whether to use the

presentation mode based on the H.239

presentation standard.

On: Enables the presentation mode based on
the H.239 presentation standard.

Off: Disables the presentation mode based
on the H.239 presentation standard.

H.239 Ratio
When H.239 presentation transmissions are
made with the system, the H.239
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presentation data shares bandwidth with

camera images that are also being sent. This

setting allows you to select how much of the

total bandwidth to use for H.239

presentation data transmissions.

2/3: Use 2/3 of the total bandwidth for H.239
presentation data transmissions.

1/2: Use 1/2 of the total bandwidth for H.239
presentation data transmissions.

1/3: Use 1/3 of the total bandwidth for H.239
presentation data transmissions.

Restrict

Allows you to select the ISDN transmission

rate.

Auto: Select when connecting a remote
party via a normal ISDN line.

56K: Select when connecting a remote party
located in a region or country where the
ISDN transmission rate is 56 Kbps.

The system is set to connect an ISDN line at the
transmission rate of 64 Kbps by default.
However, some countries, such as the USA,
and some regions may use the ISDN
transmission rate of 64 Kbps and 56 Kbps. You
may not communicate with such countries or
regions at 64 Kbps, so you must therefore set
“Restrict” to “56K” before dialing.

Screen Size
Allows you to select the screen size of the
picture to be transmitted or received.

You can select from among W4CIF,
W432P, WCIF, 4CIF, CIF and AUTO.

Video Mode

Allows you to select the compression format
of pictures to be transmitted or received.
You can select from among H.261, H.263+,
and H.264.

Video Frame

Allows you to select the number of video

frames during transmission or reception.

15fps: Send CIF format pictures at a
maximum rate of 15 frames per second.

30fps: Send CIF format pictures at a
maximum rate of 30 frames per second.

AUTO: Switch the number of frames
automatically.
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> Communication

SIP: Mode

Communication Bit Rate

Allows you to select the communication bit
rate per point

You can select from among 128Kbps,
384Kbps, 512Kbps, 1Mbps, 2Mbps, 3Mbps,
4Mbps, SMbps, 6Mbps, 7Mbps, 8Mbps,
9Mbps, 10Mbps and Other.

The 5Mbps, 6Mbps, 7Mbps, 8Mbps, 9Mbps,
and 10Mbps settings are not available on the

PCS-XG55/XG55S.

Audio Mode

Allows you to select the compression format
of audio to be sent to a remote party.

You can select from among G.728, G.722
and G.711.

‘When the remote system does not support the
audio mode selected by the local site, the mode
automatically becomes “G.711”.

Far End Camera Control

Allows you to select whether to enable the

control of each other’s cameras from each

other’s site.

On: Enables the control of each other’s
cameras. Normally, set to “On”.

Off: Disables the control of each other’s
cameras.

Screen Size

Allows you to select the screen size of the
picture to be transmitted or received.

You can select from among 720, W4CIF,
W432P, WCIF, 4CIF, CIF, QCIF and
AUTO.

Video Mode
Allows you to select the compression format
of pictures to be transmitted or received.

You can select from among H.261, H.263+,
H.264 and MPEG4.

Video Frame

Allows you to select the number of video
frames during transmission or reception.



15fps: Send CIF format pictures at a
maximum rate of 15 frames per second.

30fps: Send CIF format pictures at a
maximum rate of 30 frames per second.

60fps: Send CIF format pictures at a
maximum rate of 60 frames per second.

AUTO: Switch the number of frames
automatically.

Audio Setup Menu

The Audio setup menu is used to set various
audio items.

|« Audiot Basic Setupf

Audio Input

Allows you to select the audio input.

MIC: Inputs audio from the microphone.

AUX: Inputs audio from auxiliary external
equipment.

MIC+AUX: Inputs audio from the
microphone and auxiliary external
equipment.

When “Link to Audio Input” is set to “On” in
the Video setup menu, “Audio Input”, “Input
Select (MIC)” and “Input Select (AUX)”
cannot be selected.

Input Select (MIC)/
Input Select (AUX)

Allows you to select the microphone and/or
external equipment from which an audio
signal is input.

For the PCS-XG80/XG80S

The options that can be selected vary with
the Audio Input setting.

When you select “MIC” from “Audio
Input”, you can select one of the following
four options. When you select “AUX”, you
can select “AUDIO 1” or “AUDIO 2”.
When you select “MIC+AUX"”, you can
select two options: one microphone input
from “MIC (A1/A3)”, “EC MIC (A7)”,
“AUDIO 1” or “AUDIO 2”, and one
auxiliary external input from “AUDIO 1” or
“AUDIO 2”.

MIC (A1/A3): Select use of the PCS-A1
microphone (supplied with the PCS-
XG80/XGS55) or PCSA-A3 microphone
(not supplied) connected to the MIC
(A1/A3) jacks on the Communication
System.

EC-MIC (A7): Select use of the PCSA-A7
echo canceling microphone (not
supplied) connected to the EC-MIC
(A7) jacks on the Communication
System.

AUDIO 1: Select to input the audio of
external equipment connected to the
AUDIO 1 IN jacks on the
Communication System.

AUDIO 2: Select to input the audio of
external equipment connected to the
AUDIO 2 IN jacks on the
Communication System.

The “MIC (A1/A3)” and “EC-MIC (A7)”
settings cannot be used simultaneously.

For the PCS-XG55/XG55S

The options that can be selected vary with

the Audio Input setting.

When you select “MIC” from “Audio

Input”, you can select one of the following

two options. When you select “AUX", you

can only select “AUDIO”. When you select

“MIC+AUX”, you can select “MIC (A1/

A3)”, for microphone input, and “AUDIO”

for auxiliary external input.

MIC (A1/A3): Select use of the PCS-A1
microphone (supplied with the PCS-
XG80/XG55) or PCSA-A3 microphone
(not supplied) connected to the MIC
(A1/A3) jacks on the Communication
System.

AUDIO: Select to input the audio of
external equipment connected to the
AUDIO IN jack on the Communication
System.

The PCSA-A7 echo canceling microphone
cannot be used on the PCS-XG55/XG55S.

Echo Canceller

Allows you to select whether to use the
internal echo canceller.
On: Enables the internal echo canceller.
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Off: Disables the internal echo canceller.

When “Audio Input” is set to “AUX”, the echo
canceller will not function.

Lip Sync

Allows you to select whether to use the Lip
Sync function.

Auto: Enables the Lip Sync function.

Off: Disables the Lip Sync function.

When “Adaptive Rate Control (ARC)”,
“Packet Resend Request (ARQ)” or
“Forward Error Correction (FEC)” is set to
“On” in the QoS setup menu, you cannot set
“Lip Sync” to “Off”.

When “Lip Sync” is set to “Off”, you cannot
change the setting for “Adaptive Rate
Control (ARC)”, “Packet Resend Request
(ARQ)” or “Forward Error Correction
(FEC)” in the QoS setup menu.

Recording Mute

When you connect an audio recording
device to the AUDIO 1 IN or AUDIO 2 IN
and REC OUT jacks to record audio, this
function reduces oscillations in sound that
occur due to loop-back within audio
recording device.

Off: Disables the recording mute function.
On: Enables the recording mute function.

When “Recording Mute” is set to “On”, only
signals from external equipment are affected.
Signals from the microphones or remote sites
are not affected. Therefore, the Recording
Mute functions only when “Audio Input” is
set to “AUX” or “MIC+AUX.”

When connecting an audio recording device
to the AUDIO 1 IN or AUDIO 2 IN and REC
OUT jacks, set “Recording Mute” to “On”
and record the sound only from the audio
recording device. If you want to record the
sound on your site as well, also use the
microphone input.

The AUDIO 1 IN jack is not available on the
PCS-XG55/XG55S, and the AUDIO 2 IN
jack is labeled AUDIO IN.
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Input Mode

Allows you to select the input audio mode.

Stereo: Inputs audio to the R/L jacks of the
audio input as stereo left and right
sounds.

Monaural: Inputs audio to the R/L jacks of
the audio input as monaural sound.

Output Mode

Allows you to select the output audio mode.

Stereo: Outputs audio from the AUDIO
OUT R/L or HDMI OUT jacks as stereo
left and right sounds.

Monaural: Outputs audio from the AUDIO
OUT R/L or HDMI OUT jacks as
monaural sound.

Basic Setup2

AUX Local Monitor Out

Allows you to select whether the audio input
from the AUDIO 1 IN or AUDIO 2 IN jacks
outputs to the audio output jacks on the
Communication System.

On: Enables output from the audio output.
Off: Disables output from the audio output.

The AUDIO 1 IN jack is not available on the
PCS-XG55/XG558S, and the AUDIO 2 IN jack
is labeled AUDIO IN.

Reversed MIC Inputs

Allows you to select whether to transmit the

audio input from the microphone with right

and left reversed. If you select “On”, you can

match the right and left of the camera image

and audio.

Off: Transmits the audio with right and left
not reversed.

On: Transmits the audio with right and left
reversed.

Audio Input Delay Setting

Allows you to set Audio Input Delay to

synchronize the audio with the video input.

Default —100ms: Selects the default delay
minus 100ms.

Default —-50ms: Selects the default delay
minus 50ms.

Default: Selects the default delay.



Default + 50ms: Selects the default delay
plus 50ms.

Default + 100ms: Selects the default delay
plus 100ms.

Custom: Uses the Audio Input Delay you
set.

Audio Input Delay

When you set “Audio Input Delay Setting”
to “Custom”, you can set the delay time of
the input audio to match the image and
audio.

Audio Output Delay Setting
Allows you to set Audio Output Delay to

synchronize the audio with the video output.

Default -100ms: Selects the default delay
minus 100ms.

Default -50ms: Selects the default delay
minus 50ms.

Default: Selects the default delay.

Default + 50ms: Selects the default delay
plus 50ms.

Default + 100ms: Selects the default delay
plus 100ms.

Custom: Uses the Audio Output Delay you
set.

Audio Output Delay

When you set “Audio Output Delay Setting”
to “Custom”, you can set the delay time of
the output audio to match the image and
audio.

REC OUT Mode

Stereo: The mixed sounds of the remote and
local sites are output from the REC OUT
R and L jacks in stereo.

Monaural 2ch: The sounds of the remote
and local sites are output from the REC
OUT R and L jacks separately.

o] Audio3 Sound Effect

Beep Sound

Allows you to select the volume of the beep
that sounds each time you press a button on
the Remote Commander from among
“Loud”, “Medium” and “Quiet”. You can
also select “Off” for the beep not to sound.

Sound Effect

Allows you to select the volume of output
sound when the system starts, or when
connection starts or is disconnected from
among “Loud”, “Medium” and “Quiet”.
You can also select “Off” for the sound not
to be output.

Dial Tone

Allows you to select the volume of a ring-
back and busy tones when you are dialing
from among “Loud”, “Medium” and
“Quiet”. You can also select “Off” for the
ring-back and busy tones not to be output.

Ringer Tone

Allows you to select the volume of a ring
tone when you receive a call from among
“Loud”, “Medium” and “Quiet”. You can
also select “Off” for the ring tone not to be
output.

Video Setup Menu

The Video setup menu is used to set up video
input/output.

l%’ Basic Setup

Video Input

Allows you to select the video input.

Camera: Selects the camera picture from
the camera connected to the CAMERA
connector.

RGB: Selects the video signal from the
external equipment connected to the
RGB IN connector.

YPbPr: Selects the video signal from the
external equipment connected to the
VIDEO IN YPbPr connector.

S-VIDEO: Selects the video signal from the
external equipment connected to the S
VIDEO IN connector.

The “S-VIDEO?” setting is not available on the
PCS-XG55/XGS558S.

Presentation Screen
Allows you to select the display pattern of
the presentation screen.

Registering Local Information 73

slojelisiuiwpy waisAg 1oy dnjag pue uonelsibay :g Jeydeyd



The “Presentation Screen” settings are
enabled when the PCSA-DSG80 HD Data
Solution Software (not supplied) is installed,
and “H.239” is disabled during the
communication.

Full Screen: Sends the computer picture,
etc. from the external equipment
connected to the RGB IN connector in
full screen mode.

PandP: Sends the computer picture, etc.
from the external equipment connected
to the RGB IN connector and the
selected input picture such as a camera
picture in PandP mode.

Side by Side: Sends the computer picture,
etc. from the external equipment
connected to the RGB IN connector and
the selected input picture such as a
camera picture in Side by Side mode.

Monitor Output

Allows you to select the video signal output

from the Communication System.

HDMI: Outputs the video signal to the
external equipment connected to the
HDMI OUT connector.

RGB: Outputs the video signal to the
external equipment connected to the
RGB OUT connector.

HDMI+RGB: Outputs the video signal to
the external equipment connected to the

HDMI OUT and RGB OUT connectors.

If “Monitor Output” is set to “HDMI+RGB”
when no HDMI monitor is connected to the
Communication System, you cannot view
the menus. Before making this setting, be
sure to connect an HDMI monitor.
When you change the setting of “Monitor
Output” to an incorrect setting, no picture is
displayed on the screen. In this case, select
the correct setting for “Monitor Output”
using the Q) (power) switch on the
Communication System and the buttons on
the Remote Commander.
When the I/QI) (power) indicator on the
Communication System stays lit, perform
the steps below.
1 Press the |/(|) (power) switch on the
Communication System.
2 Within five seconds after you pressed the
/Y switch, press the buttons on the
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Remote Commander described below
depending on the desired “Monitor
Output”.
HDMI: VIDEO INPUT button (once)
then Number button 3 (three times)
RGB: VIDEO INPUT button (once) then
Number button 4 (three times)
HDMI+RGB: VIDEO INPUT button
(once) then Number button 5 (three
times)
The setting of “Monitor Output” is changed,
and the picture will be displayed on the screen.

RGB Monitor Output Format

Allows you to select the format of the signal
output from the RGB OUT connector.
SXGA: Outputs the SXGA signal.

XGA: Outputs the XGA signal.

WXGA: Outputs the WXGA signal.

Blanking Period

Allows you to select the blackout period that
occurs temporarily when the input picture is
switched when the monitor is connected to

the HDMI OUT connector.

You can select among from Long, Medium
and Short.

Frequency
Allows you to select the frequency of 50 Hz
or 60 Hz for video input/output.

* “Frequency” is set to “60 Hz” at the factory.
Note that video may not be output or the
menu not displayed on the screen when
“Frequency” is set to “50 Hz” if the
connected equipment does not support the
frequency of 50 Hz.

* When you change the setting of
“Frequency”, the system will reboot. If you
change it to an incorrect setting, no picture is
displayed on the screen after rebooting. In
this case, select the correct setting for
“Frequency” using the /() (power) switch
on the Communication System and the
buttons on the Remote Commander.

‘When the I/Ql) (power) indicator on the

Communication System blinks then stays lit

after rebooting, perform the steps below.

1 Press the /() (power) switch on the
Communication System.



2 Within five seconds after you pressed the
I/QI) switch, press the buttons on the
Remote Commander described below
depending on the desired Frequency.

60 Hz: VIDEO INPUT button (once)
then Number button 1 (three times)
50 Hz: VIDEO INPUT button (once)
then Number button 2 (three times)
The setting of “Frequency” is changed, and the
system will reboot.

Custom Input

Label

Allows you to set the names of the selected
video inputs using up to 12 characters.

Custom Input Label (Camera)
Selects when “Camera” is selected in
“Video Input”.

Custom Input Label (RGB)

Selects when “RGB” is selected in “Video
Input”.

Custom Input Label (YPbPr)
Selects when “YPbPr” is selected in “Video
Input”.

Custom Input Label (S VIDEO)
(PCS-XG80/XG80S only)

Selects when “S VIDEQO” is selected in
“Video Input”.

[=videos | Link to Mic

Allows you to select whether to link an
audio input to the selected video input.

Link to Audio Input

Allows you to switch the audio input in

conjunction with switching the video input

by linking each video input and a specific
microphone or other audio input.

Off: Switches the video input and the
microphone or other audio input
separately.

On: Links switching of the video input and
the microphone or other audio input.

When “Link to Audio Input” is set to “On”,
“Audio Input”, “Input Select (MIC)” and

“Input Select (AUX)” on the Basic Setupl
page of Audio setup menu cannot be selected.

Video Input

Allows you to select the video input.

Camera: Selects the camera picture from
the camera connected to the CAMERA
connector.

S-VIDEO: Selects the picture from the
external equipment connected to the S
VIDEO IN connector.

RGB: Selects the picture from the external
equipment connected to the RGB IN
connector.

YPDbPr: Selects the picture from the external
equipment connected to the YPbPr
jacks.

The “S-VIDEO” setting is not available on the
PCS-XG55/XG55S.

Audio Input

Allows you to select the audio input which is

linked to the video input selected in “Video

Input” when “Link to Audio Input” is set to

“On”.

MIC: Inputs audio from the microphone.

AUX: Inputs audio from the external
equipment.

MIC+AUX: Inputs audio both from the
microphone and external equipment.

Input Select (MIC)
Input Select (AUX)

Allows you to select the audio input from the
microphone and/or external equipment
when “Link to Audio Input” is set to “On”.

For the PCS-XG80/XG80S

The options that can be selected vary with
the Audio Input setting.

When you select “MIC” from “Audio
Input”, you can select one of the following
four options. When you select “AUX”, you
can select “AUDIO 1” or “AUDIO 2”.
When you select “MIC+AUX”, you can
select two options: one microphone input
from “MIC (A1/A3)”, “EC MIC (A7)”,
“AUDIO 1” or “AUDIO 2”, and one
auxiliary external input from “AUDIO 1” or
“AUDIO 2”.
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MIC (A1/A3): Select use of the PCS-A1
microphone (supplied with the PCS-
XG80/XG55) or PCSA-A3 microphone
(not supplied) connected to the MIC
(A1/A3) jacks on the Communication
System.

EC-MIC (A7): Select use of the PCSA-A7
echo canceling microphone (not
supplied) connected to the EC-MIC
(A7) jacks on the Communication
System.

AUDIO 1: Select to input the audio of
external equipment connected to the
AUDIO 1 IN jacks on the
Communication System.

AUDIO 2: Select to input the audio of
external equipment connected to the
AUDIO 2 IN jacks on the
Communication System.

The “MIC (A1/A3)” and “EC-MIC (A7)”
settings cannot be used simultaneously.

For the PCS-XG55/XG55S

The options that can be selected vary with

the Audio Input setting.

When you select “MIC” from “Audio

Input”, you can select one of the following

two options. When you select “AUX", you

can only select “AUDIO”. When you select

“MIC+AUX?”, you can select “MIC (A1/

A3)”, for microphone input, and “AUDIO”

for auxiliary external input.

MIC (A1/A3): Select use of the PCS-A1
microphone (supplied with the PCS-
XG80/XG55) or PCSA-A3 microphone
(not supplied) connected to the MIC
(A1/A3) jacks on the Communication
System.

AUDIO: Select to input the audio of
external equipment connected to the
AUDIO IN jack on the Communication
System.

The PCSA-AT7 echo canceling microphone
cannot be used on the PCS-XG55/XG55S.
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LAN Setup Menu

The LAN setup menu is used to set up LAN
connection.

For details about the settings, consult your
network administrator.

* The contents of the LAN setup menu vary
with the “Use LAN2” setting in the Line
Interface setup menu, or “Internet Protocol”
setting in the Administrator setup menu.
The LAN page number after the LAN2 page
also varies according to the number of setting
items.

* The menu displays and references to
“LAN1” will be simply “LAN” on the
PCS-XG55/XGS55S.

Basic Setup

Host Name
Enter your host name (up to 30 characters).

DHCP Mode

Allows you to select whether the Dynamic
Host Configuration Protocol (DHCP) server
is enabled.

Auto: The IP address, network mask,
gateway address and DNS address are
automatically assigned.

Off: Disables the DHCP server. In this case,
enter an IP address, network mask,
gateway address and DNS address.

Prefix Length

Configure the prefix length of the IPv6
address within the range of O to 128.

IP Address
Enter the IP address.

Network Mask
Enter the network mask.

Gateway Address
Enter the default gateway address.

Primary DNS
Enter a primary DNS address.



Secondary DNS
Enter a secondary DNS address.

LAN Mode

Allows you to select the interface type and
the communication mode of the LAN
connection.

Auto: The interface type and the
communication mode are detected
automatically.

100Mbps Full Duplex: Connects via
100BASE-TX in full duplex mode.

100Mbps Half Duplex: Connects via
100BASE-TX in half duplex mode.

10Mbps Full Duplex: Connects via
10BASE-T in full duplex mode.
10Mbps Half Duplex: Connects via
10BASE-T in half duplex mode.

7% LAN PPPOE

PPPoE

Allows you to select whether to use PPPoE

for LAN connection.

When using PPPoE, you can use the B

FLET’S* or FLET’S ADSL service without

connecting a router.

Off: Does not use PPPoE.

LANI1: Uses PPPoE for LAN connection
using the =% 1 (LAN1) connector (==
(LAN) connector on the PCS-XG55/
XG55S).

LAN?2: Uses PPPoE for LAN connection
using the =2 (LAN2) connector.

The “LAN1” setting is called the “On”
setting on the PCS-XG55/XG55S.

The “LAN2” setting is not available on the
PCS-XG55/XG55S.

Operations of PPPoE for LAN connection
are presently verified only for the Japanese

NTT B FLET’S and FLET’S ADSL services.

The PPPoE registration status appears at the
bottom of the screen for each page.

* “FLET’S” is a trademark of NTT East and
NTT West Corporations in Japan.

User Alias
Enter a user name when you use PPPoE for
LAN connection.

Password

Enter a password when you use PPPoE for
LAN connection.

Fixed IP for PPPoE

Select whether to make a PPPoE connection

using a fixed IP address.

Off: Does not use a fixed IP address for a
PPPoE connection.

On: Uses a fixed IP address for a PPPoE
connection.

Fixed IP Address for PPPoE

Enter an IP address when “Fixed IP for
PPPoE” is set to “On”.

DNS

Allows you to select whether to obtain DNS

server addresses automatically or to specify

them manually when connecting to a LAN

using PPPoE.

Obtain automatically: Assigns DNS server
addresses automatically.

Specify: Allows you to specify DNS server
addresses.

Primary DNS
Enter a primary DNS address.

Secondary DNS
Enter a secondary DNS address.

NAT Setup

NAT Mode

Allows you to select whether you connect
the system to a local network using Network
Address Translation (NAT), which allows
one IP address to be shared by several
computers on the same LAN.

Auto: Enables or disables the NAT mode by
automatically detecting the use of NAT.
This option is effective only when you
use the UPnP router.

On: Enables NAT mode.

Off: Disables NAT mode.

WAN IP Address

Enter the IP address for the Wide Area
Network (WAN).
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s LAN Gatekeeper

Gatekeeper Mode

Allows you to select whether to use the

gatekeeper to control access to a LAN.

Using the gatekeeper allows you to dial

using the user name or user number as well

as dialing using the IP address.

Auto: Automatically detects the gatekeeper
and uses it.

On: Enables the gatekeeper.

Off: Disables the gatekeeper.

Gatekeeper Address

Enter the address of the gatekeeper used
when “Gatekeeper Mode” is set to “On”.

User Alias

Enter the user name (H.323 alias) registered
in the gatekeeper.

User Number

Enter the user number (E.164 number)
registered in the gatekeeper.

H.460

Allows you to select whether to use H.460 to

traverse firewalls and connect to the

terminals on other networks.

On: Enables connection that traverses
H.460 standard firewalls.

Off: Disables connection that traverses
firewalls.

5 LAN | Used Port
Number, RTP/RTCP Setup

Q.931
Enter the Q.931 port number.

H.245
Enter the H.245 port number.

RTP/RTCP
Enter the RTP/RTCP port number.

MTU Size
Enter the MTU size.
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75 LAN SNMP

SNMP Mode

Allows you to select whether the Simple
Network Management Protocol (SNMP)
agent is enabled.

On: Enables the SNMP agent.

Off: Disables the SNMP agent.

Trap Destination

Enter the address of the trap destination
SNMP manager.

Community

Enter the community name managed by the
SNMP manager (up to 24 characters). By
default, “public” is entered.

Description

Enter the description of this terminal. By
default, “Videoconference Device” is
entered and can not be changed.

Location

Enter the location where this terminal is
installed (up to 30 characters).

Contact
Enter information about the terminal
administrator (up to 30 characters).

QoS Setup Menu

Specifies the functions for providing
optimum consistent communication.

* When “Lip Sync” is set to “Off” in the Audio
setup menu, you cannot change the setting
for “Adaptive Rate Control (ARC)”, “Packet
Resend Request (ARQ)” or “Forward Error
Correction (FEC)”.

* When “Adaptive Rate Control (ARC)”,
“Packet Resend Request (ARQ)” or
“Forward Error Correction (FEC)” is set to
“On”, you cannot set “Lip Sync” to “Off” in
the Audio setup menu.
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Adaptive Rate Control (ARC)

Allows you to select whether to always
optimize the LAN bandwidth.

On: Always optimizes the LAN bandwidth.

Off: Does not optimize the LAN bandwidth.

Auto Bandwidth Detection

Allows you to select whether you use the

Auto Bandwidth Detection feature.

On: Enables the Auto Bandwidth Detection
feature.

Off: Disables the Auto Bandwidth Detection
feature.

TCP Port Number
Enter the fixed TCP port number.

UDP Port Number
Enter the fixed UDP port number.

For details on the port numbers used on the
system, see “List of Port Numbers Used on
the PCS-XG80/XG80S/XG55/XG55S” on
page 248.

Packet Resend Request (ARQ)

Allows you to select whether to request
packet to be resent when packet losses occur
during communication.

On: Requests packets to be resent.

Off: Does not request packets to be resent.

When a multipoint connection is made among
six points with “Packet Resend Request
(ARQ)” set to “On”, the maximum bandwidth
to be used is restricted to 7 Mbps.

ARQ Buffering Time

Set the buffering time used for “Packet
Resend Request”.

You can select from among “300ms”,
“150ms”, “80ms”, “Auto” and “Custom”.
When “Custom” is selected, you can specify
any buffering time.

ARQ Buffering Time

Enter the buffering time (50 ms to 999 ms)
when you select “Custom” in “ARQ
Buffering Time”.

Forward Error Correction (FEC)

Allows you to select whether received

packets are identified with an error

correction mark.

On: Identifies with an error correction mark.

Off: Not identify with an error correction
mark.

When “Forward Error Correction (FEC)” is set
to “On”, the maximum bandwidth to be used is
restricted to 8 Mbps.

FEC Redundancy

Allows you to set redundancy of the packet
used for the Forward Error Correction
(FEC).

You can select from among “8”, “4”, “2” and
“Auto”. When you select “8”, “4” and “2”,
the communication bit rate may be different
from the specified value.

Audio Duplex Transmission

Allows you to select whether to

automatically transmit audio in double when

audio communication is interrupted

depending on a network status.

On: Enables the Audio Duplex
Transmission feature.

Off: Disables the Audio Duplex
Transmission feature.

[TH QoS2 Re-Order/Shaping

Re-Order

Allows you to select whether to correct re-
order that may cause packet loss (invalid
order of arrival in the packet). Correcting re-
order enables smoother picture and sound.
On: Corrects re-order.

Off: Does not correct re-order.

Re-Order Buffer

Allows you to select re-order buffer.
You can select from among “Auto”, “17,
“2” and “Custom”.

Re-Order Buffer Rate
Enter the re-order buffer rate. You can enter
the value between 1 and 5.

Registering Local Information 79

slojelisiuiwpy waisAg 1oy dnjag pue uonelsibay :g Jeydeyd



Shaping

Allows you to select whether to use shaping,
which adjusts the IP packet transfer rate.
On: Uses shaping.

Off: Does not use shaping.

TOS Setup Menu

TOS Data Type

Allows you to select the type of data for

which you configure the TOS (Type of

Service) field.

Video: Configure the TOS field for video
data.

Audio: Configure the TOS field for audio
data.

Data: Configure the TOS field for camera
control signals, etc.

Presentation: Configure the TOS field for
the RGB presentation data.

TOS

Allows you to select how to define the TOS
(Type of Service) field of the data selected in
“TOS Data Type”.

Off: Does not define the TOS field.

IP Precedence: Defines the TOS field as IP
Precedence.

DSCP: Defines the TOS field as the
Differentiated Services Code Point
(DSCP). Enter the value between 0 and
63.

Precedence

Enter the IP Precedence value between 0 and
7.

Low Delay

Allows you to select whether to specity the

Low Delay bit of the TOS field.

On: Specifies the Low Delay bit of the TOS
field.

Off: Does not specity the Low Delay bit of
the TOS field.

High Throughput

Allows you to select whether to specify the
High Throughput bit of the TOS field.
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On: Specifies the High Throughput bit of
the TOS field.

Off: Does not specify the High Throughput
bit of the TOS field.

High Reliability

Allows you to select whether to specify the

High Reliability bit of the TOS field.

On: Specifies the High Reliability bit of the
TOS field.

Off: Does not specify the High Reliability
bit of the TOS field.

Minimum Cost

Allows you to select whether to specify the

Minimum Cost bit of the TOS field.

On: Specifies the Minimum Cost bit of the
TOS field.

Off: Does not specify the Minimum Cost bit
of the TOS field.

DSCP

Enter the DSCP value. This item only
appears when “TOS” is set to “DSCP”.

SIP Setup Menu

The SIP setup menu is used to connect with
an IP phone, etc. using the SIP (Session
Initiation Protocol).

‘g sIp Basic Setup

SIP Server Mode

Allows you to select whether you use a SIP
server or not.

On: Enables use of the SIP server.

Off: Disables use of the SIP server.

Transport Protocol

Allows you to select the protocol to be used

for SIP.

TCP: Uses TCP (Transmission Control
Protocol).

UDP: Uses UDP (User Datagram Protocol).
This is the factory default setting.

Port Number
Enter the port number to be used for SIP.



SIP Domain
Enter the SIP domain name.

Registered User Name

Enter the user name for the terminal to be
registered to the SIP server (up to 39
characters).

Password

Set the password for the terminal to be
registered to the SIP server (up to 39
characters).

SIP Server Address
Enter the address of the SIP server.

SIP Server Port

Enter the port number used for
communication with the SIP server.

ISDN Setup Menu

The ISDN setup menu is used to set up ISDN
lines.

Basic Setup

Country/Region

Allows you to select the country or region
where you are using the Communication
System.

Protocol

Allows you to select the protocol of the
ISDN lines to be used. You can select
National ISDN, Japan (NTT), Euro ISDN,
Euro ISDN (France), SESS (P-P), or DMS-
100, depending on the interface that you are
using.

For customers in the USA and Canada, see
“SPID Settings for Customers in the USA
and Canada” on page 82.

*Z ISDN2 Telephone

Number

Enter the area code and local number in the
text boxes corresponding to the port
numbers on the ISDN unit.

The text boxes correspond to the port
numbers on the ISDN unit in the following
way.

Al: Port 1 on the ISDN unit.

A2: Port 1 on the ISDN unit.

B1: Port 2 on the ISDN unit.

B2: Port 2 on the ISDN unit.

C1: Port 3 on the ISDN unit.

C2: Port 3 on the ISDN unit.

Area Code
Enter the area code of the ISDN line to be

used. Do not enter the first O of the area code.

Local Number

Enter the line number (local number) of the
ISDN line to be used.

When you select an empty field and then
press the ENTER button of the Remote
Commander, the setting of the previous field
is copied into the selected field.

* When using the PCSA-B768S ISDN Unit,
selecting the ISDN3 button displays the D1
to F2 text boxes. Fill in the D1 to F2 text
boxes according to the lines that you are
using.

iZ ISDN4 Sub Address
The A1 to C2 (or Al to F2) fields appear.

Sub Address

Enter sub-addresses when registering them.
Sub-addresses can only be composed of
numbers.

The SPID (Service Profile Identifier) pages
are used only for customers in the USA and
Canada.

For details, see “SPID Settings for
Customers in the USA and Canada” on page
82.

SPID

The Al to C2 (or Al to F2) fields appear.
Enter SPID (Service Profile Identifier).
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Auto SPID

When you select “Auto SPID”, you can
automatically set up the Area Code and
Local Number on the Telephone Number
page and SPID items.

SPID Settings for Customers
in the USA and Canada

If you connect to an ISDN switch type,
configuration of SPID (Service Profile
Identifier) is required.

If “Auto SPID” is not available in your area,
set up SPID manually using the ISDN setup
menu.

1 Open the Basic Setup page of the
ISDN setup menu.

2 Enter the country code in the Country/
Region Code text box depending on
the network switch type you are using.

AT&T 5ESS (National ISDN), NTI
DMS-100 (National ISDN): Enter “1”.

AT&T 5ESS (Point-to-Point Custom
ISDN): Enter “1*12”.

NTI DMS-100 (Custom ISDN): Enter
“IE117.

3 Open the Telephone Number page to
enter the LDN (Local Directory
Number) in the Local Number text
boxes.

When you use the AT&T SESS
(Point-to-Point Custom ISDN)
switch type

Enter the same LDNs in the A1 and
A2 (B1and B2, C1 and C2, depending
on the number of lines you use) text
boxes.

When you use the NTT DMS-100
(National ISDN) or NTI DMS-100
(Custom ISDN) switch type

Enter the different LDNs in the Al
and A2 (B1 and B2, C1 and C2,
depending on the number of lines you
use) text boxes. These switch types are
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given a separate number for each
channel.

When you use the AT&T SESS
(National ISDN) switch type

You may enter the same or different
numbers in two channels.

4 Open the SPID page (ID page) to enter

the SPID.

The SPID is generally comprised of 12
digits, including a 7 digit LDN (Local
Directory Number). Be sure to enter the
different SPID number in each of the
Aland A2 (B1 and B2, C1 and C2,
depending on the number of lines you
use) text boxes if you have entered the
separate LDNs in the Local Number
text boxes for each channel in step 3.

For the AT&T SESS (National
ISDN) switch type

Enter the SPID in the A1 text box
only.

For the NTI DMS-100 (National
ISDN), NTI DMS-100 (Custom
ISDN),AT&T 5ESS (National ISDN)
switch type

Enter the different SPID numbers in
the Al and A2 text boxes.

For the AT&T 5ESS (Point-to-Point
Custom ISDN) switch type

You do not need to set up the SPID,
then no entry in the A1 and A2 (B1
and B2, C1 and C2, depending on the
number of lines you use) is required.

5 After the settings are completed,
select “Save”, then press the ENTER
button.

Annotation Setup Menu

The Annotation setup menu is used for the
annotation function allowing you to write
letters or graphics on the screen using a pen
tablet.



& Annotation | Apnotation

Enable

Allows you to select whether the annotation
function is enabled.

On: Enables the annotation function.

Off: Disables the annotation function.

Color

Allows you to select the color of the letters
or graphics written on the screen with a pen
tablet.

You can select from among “Black”, “Red”,
“Blue”, “Green”, “Yellow”, “Orange”,
“Purple” and “White”.

Line Density

Allows you to select the density of the line
written on the screen with a pen tablet.
You can select from among “Thick”,
“Medium” and “Thin”.

Camera Setup Menu

£ Camera Camera

Fade In

Allows you to select whether to use the fade-
in function when the camera moves to the
preset position. The picture in the preset
position fades in on a monitor screen.

On: Enables the fade-in function.

Off: Disables the fade-in function.

Second Camera Input

Allows you to select the input connector on

the Communication System to which the

second camera is connected.

RGB: Connects the second camera to the
RGB IN connector.

YPbPr: Connects the second camera to the
VIDEO IN YPbPr jacks.

S-VIDEO: Connects the second camera to
the S VIDEO IN connector.

The “S-VIDEO” setting is not available on the
PCS-XG55/XG55S.

General Setup Menu

| & Generali | Device Setup

Terminal Name

Input the local terminal name transmitted to
a remote party (up to 30 characters).

Standby Mode

Allows you to select whether the

Communication System enters standby

mode if it is idle for a specified period of

time.

On: Allows the System to go on standby.

Off: Does not allow the System to go on
standby.

Standby Time

Specify the time the system must remain idle
before entering the standby mode. This time
can be set between 1 and 99 minutes.

For details on the standby mode, see
“Standby Mode Function” on page 42.

Last Number Registration

Allows you to select whether to register the

remote party in the Phone Book after the

communication ends.

Off: The registration of the remote party
does not take place.

On: If the remote party is not registered in
the Phone Book, the message “Register
this participant in the list?”” appears on
the monitor screen when communication
ends. When you select “OK”, the List
Edit menu opens.

Control by Far End

When “Far End Camera Control” is set to
“On” in the Communication setup menu,
you can temporarily reject the camera
control command transmitted by the remote
party.

On: Accepts the camera control command.
Off: Rejects the camera control command.

Language

Allows you to select the menu and display
language used by the system. You can select
from the following languages: English,
French, German, Japanese, Spanish, Italian,
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Simplified Chinese, Portuguese, Traditional
Chinese, Korean, Dutch, Danish, Swedish,
Finnish, Polish, Russian, Arabic, Thai,
Norwegian, Turkish, Welsh, Czech and
Hungarian.

System LED Brightness (PCS-XG80/
XG80S only)

Allows you to select the LED brightness
level of the Communication System.

You can select from among “Bright”, “Off”
and “Dark”.

Camera LED Brightness

Allows you to select the LED brightness
level of the PCSA-CXG80 HD Camera Unit
connected.

You can select from among “Bright”, “Off”
and “Dark”.

RF Remote Control Reception
Allows you to select the receiver of the RF
signal from the supplied PCS-RF1 Remote
Commander.

System: Receives the RF signal with the

receiver on the Communication System.

Camera: Receives the RF signal with the
receiver on the PCSA-CXG80 HD
Camera Unit.

| ¥¥ General2 Clock Set

NTP

Allows you to select whether to obtain clock

information from the server with NTP.

On: Obtains clock information from the
server.

Off: Does not obtain clock information from
the server.

Primary NTP Server

Enter the address of the primary NTP server
from which the clock information is
obtained.

Secondary NTP Server

Enter the address of the secondary NTP
server from which the clock information is
obtained.
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Time Zone

Allows you to select the country or region
where you are using the Communication
System.

Clock Display Pattern

Allows you to select the display pattern of
the clock.

You can select from among “Year/Month/
Day”, “Month/Day/Year”, “Day/Month/
Year”, “Year-Month-Day” and
“Day.Month.Year”.

Date
Enter the current date (year/month/day).

Time
Set the current clock.

Time Update
Selecting “Execute” and pressing the
ENTER button on the Remote Commander

updates the clock setting when “NTP” is set
to “On”.

L% General3 Menu Screens

Allows you to select whether to display the
items of the Tools and Setup menus.

Display Time in Communication

Off: Displays neither the elapsed nor current
time during communication.

Time Display: Displays the elapsed time
during communication.

Current Time: Displays the current time
during communication.

Display Terminal Name

Off: Does not display the connected
terminal names.

Always show: Always displays the
connected terminal names.

Show temporarily: Displays the connected
terminal names for a brief moment.

Guide

On: Displays the instruction that guides the
operation.

Off: Does not display the instructions.



Display Indicator

On: Displays the indicators such as
“Memory Stick” and tablet.

Off: Does not display the indicators.

Communication Mode Display

On: Displays the communication mode
when the system is connected to the
remote site.

Off: Does not display the communication
mode when the system is connected to
the remote site.

Display On-Screen Keyboard

On: Displays the on-screen keyboard.

Off: Does not display the on-screen
keyboard.

For details on the on-screen keyboard, see
“Entering Characters Using the On-Screen
Keyboard” on page 59.

Menu Transparency

Allows you to select the degree of
transparency of the superimposed menu
display over the background picture. You
can select from among “High”, “Medium”
and “Low”.

| % Generald
Communication

Allows you to switch the picture with one
press of a button on the Remote
Commander.

You can set the function to be assigned to
each of the F1 to F4 (function) buttons.

* You cannot set “Function Keys in
Communication” during communication. Set
this item before starting communication.

* The “S-VIDEO” setting is not available on
the PCS-XG55/XG55S.

Function Keys in

F1

Allows you to select the video input
switched by pressing the F1 button on the
Remote Commander. You can select from
among “Far/Near”, “Camera”, “S-VIDEO”,
“RGB”, “YPbPr” and “No Operation”.
This item is preset to “Far/Near” at the
factory. This setting allows you to switch the

cameras to be controlled between the local
and remote sites during communication by
pressing the F1 button on the Remote
Commander.

Even if “F1” is set to any option other than
“Far/Near”, “F1” is fixed to “Far/Near”
while the Video Input or Layout menu is
displayed on the screen. In some other cases,
the function of the F1 to F4 buttons may be
fixed regardless of the setting for practical
convenience, in which case the functions of
the button are shown in the instruction
display.

F2

Allows you to select the video input
switched by pressing the F2 button on the
Remote Commander. You can select from
among “Camera”, “S-VIDEO”, “RGB”,
“YPbPr” and “No Operation”.

F3

Allows you to select the video input
switched by pressing the F3 button on the
Remote Commander. You can select from
among “Camera”, “S-VIDEO”, “RGB”,
“YPbPr”, “Zoom (RGB)” and “No
Operation”.

When “Zoom (RGB)” is selected, a 4:3
aspect ratio picture will be enlarged.

F4

Allows you to select the video input
switched by pressing the F4 button on the
Remote Commander. You can select from
among “Camera”, “S-VIDEO”, “RGB”,
“YPbPr” and “No Operation”.

Home Menu Setup Menu

_ Home Menu1

Allows you to select the items that show or
hide in/from the Home menu.

Some items may not be set during
communication.
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Clock Display

On: Allows display of the current time in the
Home menu.

Off: Does not display the current time.

Local Terminal Name

On: Displays the local terminal name in the
Home menu.

Off: Does not display the local terminal
name.

Number Display

Allows you to select the identification of the

local system, such as the IP address and user

name, to be displayed in the Home menu.

SIP:User Name: Displays the user name
registered in the SIP server.

SIP:Address: Displays the SIP address.

GK:User Alias: Displays the user name
registered in the gatekeeper when you
use the gatekeeper.

GK:User Number: Displays the user
number registered in the gatekeeper
when you use the gatekeeper.

NAT:Address: Displays the NAT address
when you connect the system to a
network using NAT.

IP: Address: Displays the IP address.

No display: Does not display any
identification, such as the IP and user
name, for the system.

Terminal Status

On: Displays the local terminal status in the
Home menu.

Off: Does not display the local terminal
status.

Warning Messages

On: Displays a warning message in the
Home menu when an abnormality
occurs.

Off: Does not display a warning message.

Home Menu2

Allows you to select whether to display the
menu buttons in the Home menu.

Connect Button Display

Select the buttons for connection to be
displayed in the Home menu.

Simple: Displays “Connect” button only.
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Individual: Selects whether to display
“Phone Book”, “History” or “Detailed
Dial” depending on the setting of each
button.

Off: Does not display the buttons for
connection.

Phone Book Button
On: Displays “Phone Book™.
Off: Does not display “Phone Book™.

History Button
On: Displays “History”.
Off: Does not display “History”.

Detailed Dial Button
On: Displays “Detailed Dial”.
Off: Does not display “Detailed Dial”.

Camera Button
On: Displays “Camera”.
Off: Does not display “Camera”.

Tools Button

Off: Does not display “Tools”.
On: Displays “Tools”.

One-Touch Dial

On: Displays the one-touch dial buttons.

Off: Does not display the one-touch dial
buttons.

Direct Dial

Off: Does not display “Dial” and the text
box for direct dialing.

On: Displays “Dial” and the text box for
direct dialing.

| A Home Me"“3| Home Menu3

Allows you to select whether to display the
indicators (status information) in the Home
menu.

Video Input Display

On: Displays the current video input name.

Off: Does not display the current video input
name.

Audio Input Display

On: Displays the current audio input.

Off: Does not display the current audio
input.



Audio Level Meter

On: Displays the current audio input level.

Off: Does not display the current audio input
level.

Volume

On: Displays the volume meter for a certain
duration when the volume is adjusted.

Off: Does not display the volume meter.

LAN Status

On: Displays the current status of LAN
connection.

Off: Does not display the current status of
LAN connection.

ISDN Status

On: Displays the currently used ISDN unit
port.

Off: Does not display the currently used
ISDN unit port.

Administrator Setup Menu

The Administrator setup menu is used for
the system administrators. If you have set
the password for each menu, you need to
enter it when accessing the setup menus or
Phone Book to change the items. Entering
the password is also required to access the
Administrator setup menu.

@ Administrator1 Password

Administrator Password

Set the system administrator password (up to
8 characters). This allows the system
administrator to modify the Setup and Phone
Book items.

* Be aware that setting other passwords but
leaving “Administrator Password” blank
allows for modification and connection
without password input.

* Make sure to write down “Administrator
Password”. If you should forget
“Administrator Password”, consult your
Sony dealer. In this case, the memory of the
Communication System is initialized before
repair, and the data in the Phone Book and

History lists, as well as various setting data,
are erased.

Phone Book Modification Password
Set the password used to modify the Phone
Book (up to 8 characters).

Save Settings Password

Set the password used to save settings (up to
8 characters).

Remote Access Password

Set the password to access the system
through a Web browser (up to 8 characters).

Streaming Broadcast Password

Set the password used when a remote party
receives streaming video and audio
broadcast by the local party (up to 8
characters).

@ Administrator2 Setup Passwordi

Allows you to select whether to require
“Save Settings Password” when saving each
setting.

Line Interface

Enabled: Requires “Save Settings
Password” when saving the Line
Interface settings.

Disabled: Does not require the password
when saving the Line Interface settings.

Dial

Enabled: Requires “Save Settings
Password” when saving the Dial setup
settings.

Disabled: Does not require the password
when saving the Dial setup settings.

Answer

Enabled: Requires “Save Settings
Password” when saving the Answer
setup settings.

Disabled: Does not require the password
when saving the Answer setup settings.

Multipoint (PCS-XG80/XG80S only)

Enabled: Requires “Save Settings
Password” when saving the Multipoint
settings.
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Disabled: Does not require the password
when saving the Multipoint settings.

IP Mode

Enabled: Requires “Save Settings
Password” when saving the IP Mode
settings.

Disabled: Does not require the password
when saving the IP Mode settings.

SIP Mode

Enabled: Requires “Save Settings
Password” when saving the SIP Mode
settings.

Disabled: Does not require the password
when saving the SIP Mode settings.

ISDN Mode

Enabled: Requires “Save Settings
Password” when saving the ISDN Mode
settings.

Disabled: Does not require the password
when saving the ISDN Mode settings.

Disabled: Does not require the password
when saving the QoS setup settings.

TOS

Enabled: Requires “Save Settings
Password” when saving the TOS setup
settings.

Disabled: Does not require the password
when saving the TOS setup settings.

SIP

Enabled: Requires “Save Settings
Password” when saving the SIP setup
settings.

Disabled: Does not require the password
when saving the SIP setup settings.

ISDN

Enabled: Requires “Save Settings
Password” when saving the ISDN setup
settings.

Disabled: Does not require the password
when saving the ISDN setup settings.

Q- Administrator3 Setup Password?2

Audio

Enabled: Requires “Save Settings
Password” when saving the Audio setup
settings.

Disabled: Does not require the password
when saving the Audio setup settings.

Video

Enabled: Requires “Save Settings
Password” when saving the Video setup
settings.

Disabled: Does not require the password
when saving the Video setup settings.

LAN

Enabled: Requires “Save Settings
Password” when saving the LAN setup
settings.

Disabled: Does not require the password
when saving the LAN setup settings.

QoS

Enabled: Requires “Save Settings
Password” when saving the QoS setup
settings.
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Q- Administratord Setup Password3

General

Enabled: Requires “Save Settings
Password” when saving the General
setup settings.

Disabled: Does not require the password
when saving the General setup settings.

Home Menu

Enabled: Requires “Save Settings
Password” when saving the Home Menu
setup settings.

Disabled: Does not require the password
when saving the Home Menu setup
settings.

Administrator

Enabled: Requires “Save Settings
Password” when saving the
Administrator setup settings.

Disabled: Does not require the password
when saving the Administrator setup
settings.



Annotation

Enabled: Requires “Save Settings
Password” when saving the Annotation
setup settings.

Disabled: Does not require the password
when saving the Annotation setup
settings.

Camera

Enabled: Requires “Save Settings
Password” when saving the Camera
setup settings.

Disabled: Does not require the password
when saving the Camera setup settings.

Encryption

Enabled: Requires “Save Settings
Password” when saving the Encryption
setup settings.

Disabled: Does not require the password
when saving the Encryption setup
settings.

Shared Phone Book

Enabled: Requires “Save Settings
Password” when saving the Shared
Phone Book settings.

Disabled: Does not require the password
when saving the Shared Phone Book
settings.

@ Administratord Streaming/

Recording

Streaming

Select whether to enable the streaming

broadcast.

Enabled: Permits the streaming broadcast.

Disabled: Does not permit the streaming
broadcast of a videoconference.

Recording

Select whether to enable the recording of
video and audio to a “Memory Stick.”
Enabled: Permits the recording.
Disabled: Does not permit the recording.

Video

Select a bit rate for streaming and recording

video.

Off: Disables the streaming and recording of
video.

64Kbps: Streams and records video at
64 Kbps.

128Kbps: Streams and records video at
128 Kbps.

384Kbps: Streams and records video at
384 Kbps.

512Kbps: Streams and records video at
512 Kbps.

When “Off” is selected, only audio can be
streamed and recorded.

Multicast Address

Enter the multicast address for streaming
broadcasts.

You can enter the unicast address in this menu.
If you set the unicast address, enter two or more
different numbers in “Audio Port Number” and
“Video Port Number” for streaming
broadcasts.

Audio Port Number
Enter the audio port number for streaming
broadcasts.

Video Port Number

Enter the video port number for streaming
broadcasts.

HOP
Enter a number from 0 to 255 as the HOP for
streaming broadcasts.

@ Administratoré Access Permit

Web Monitor

Allows you to permit the monitoring

communication status through a Web

browser (automatic update of JPEG images).

On: Permits monitoring with a Web
browser.

Off: Does not permit monitoring with a Web
browser.

Web Access

Select whether to permit access to the

Communication System via a Web browser.

Enabled: Permits access via a Web browser.

Disabled: Prohibits access via a Web
browser.
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Telnet Access

Select whether to permit access to the
Communication System via Telnet.
Enabled: Permits access via Telnet.
Disabled: Prohibits access via Telnet.

SSH Access

Allows you to select whether to permit
access to the Communication System via
SSH (Secure Shell).

Enabled: Permits access via SSH.
Disabled: Prohibits acces via SSH

Image Flip for First Camera

Allows you to select whether to rotate the

camera image 180 degrees when the first

camera is installed on a ceiling.

Flip Vertical: Rotates the image 180
degrees.

Off: Does not rotate the image 180 degrees.

Image Flip for Second Camera

Allows you to select whether to rotate the

camera image 180 degrees when the second

camera is installed on a ceiling.

Flip Vertical: Rotates the image 180
degrees.

Off: Does not rotate the image 180 degrees.

* The “Image Flip” function will be enabled
after system rebooting.

* The “Image Flip” function cannot be used
with the PCSA-CXG80 HD Camera Unit.

@ Administrator7 Other

Use History

Select whether to display the history lists in
order to use for dialing, etc.

On: Displays the history lists.

Off: Does not display the history lists.

Save Setup

Saves the data for each setting to a “Memory
Stick”. The data for each setting saved on the
“Memory Stick™ is overwritten.

Phone Book and History data are not saved.
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Load Setup

Loads the data for each setting from a
“Memory Stick”. The data for each setting
saved on the System is overwritten.

When saving and loading settings, make sure
that the version of the system from which the
data was originally saved is the same as the
version of the local system. If the versions
differ, the data may not be properly recognized.

AMX Device Discovery

Select whether to export AMX Device
Discovery information onto the network.
Off: Disables this function.

On: Enables this function.

When the AMX system is connected to the
Communication System via serial
connection, AMX Device Discovery
information is output via that serial
connection.

AMX systems are external control devices
that can be used to control the
Communication System. When the AMX
system receives Device Discovery
information from the Communication
System, the System automatically falls
under the control of the AMX system.

HOP
Enter a number from 0 to 255 as the HOP
Display Terminal Name.

1080i Mode (PCS-XG80/XG80S only)

Allows you to select whether to transmit or

receive the picture in 10801 mode.

Transmission and reception of the picture in

10801 mode is available only for connection

via LAN.

You can connect to a remote party in 1080i

mode only by using the button in the Home

menu.

Off: Does not use 1080i video format.

On: Uses 1080i video format. When set to
“On”, the system reboots automatically.

¢ The 1080i Mode is not available for S video
or RGB input signal.

¢ When “1080i Mode” is set to “On”, a remote
party must enable communication in 10801
video format.



When “1080i Mode” is set to “On”,
presentation and PinP, PandP and Side by
Side displays are not available.

When “1080i Mode” is set to “On”, the
Annotation function is not available.

When “1080i Mode” is set to “On”, the Web
Access function is not available even if
“Web Access” is set to “Enabled” in the
Administrator setup menu.

Auto Restore

Allows you to select whether to
automatically turn on the Communication
System if an power interruption occurs and
is then restored.

On: Enables the Auto Restore function.
Off: Disables the Auto Restore function.

Internet Protocol

IPv4: Uses the internet protocol version 4
(IPv4) that is commonly used.

IPv6: Uses the next-generation internet
protocol version 6 (IPv6).

The setting of “Internet Protocol” is common
to both LAN1 and LAN2.

When “Internet Protocol” is set to “IPv6”,
some of the functions of this system are
restricted, and some of the Administrator
setup menu are not displayed.

For details, see “Restrictions on the Use
of IPv6” on page 98.

Q- Administrator8 Phone Book

Save Phone Book

Allows you to save the data in the Phone
Book on a “Memory Stick”. The data
already stored on the “Memory Stick” is
overwritten.

Load Phone Book

Allows you to load the data in the Phone
Book from a “Memory Stick.” The data
already stored in the Phone Book is
overwritten.

When loading Phone Book data, make sure that
the version of the system from which the data
was originally saved is the same as the version

of the local system. If the versions differ, the
data may not be properly recognized.

Clear Phone Book
Allows you to delete a Phone Book on the
system.

Auto Dialing

Allows you to select whether to
automatically dial a specified remote party
in the Private Phone Book created in a
“Memory Stick”, when the “Memory Stick”
is inserted.

On: Enables the Auto Dialing function.
Off: Disables the Auto Dialing function.

For details, see “To dial a specified remote
party in a Private Phone Book
automatically” on page 130.

Create Private Phone Book

Allows you to create an empty folder and
file for a Private Phone Book on a “Memory
Stick” inserted into the system.

For details, see “Creating a Private Phone
Book” on page 128.

Delete Private Phone Book

Allows you to delete the Private Phone Book
on a “Memory Stick” inserted into the
system.

Copy to Private Phone Book

Allows you to copy the entire contents of the
Phone Book to a Private Phone Book on a
“Memory Stick” inserted into the system.

Encryption Setup Menu

The Encryption setup menu is used to
connect to a remote party using the
encryption function.

The encryption function allows you to hold
a strictly confidential connection.

For details on an encrypted connection, see
Chapter 5.

When an encrypted connection is made, the
maximum bandwidth to be used is restricted to
6 Mbps.
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’m\ Encryption

Encryption Mode

Select whether you use the encryption

feature.

Off: Disables use of the encryption feature.

Connect Priority: Connects with the
encryption feature to a remote party with
standard encrypted connection enabled.
Connects without the encryption feature
to a remote party with standard
encrypted connection disabled or with
the encryption feature set to off.

Encrypt Priority: Connects only to a
remote party with standard encrypted
connection enabled.

Shared Phone Book Setup
Menu

This menu is used to configure the settings
when using the Shared Phone Book located
on the server.

For details on the Shared Phone Book, see
“Using the Shared Phone Book” on page
130.

) Shared Phone Book| ghared Phone
Book

SPB Mode

Selects whether to use the server managing

the Shared Phone Book.

On: Enables use of the server managing the
Shared Phone Book.

Off: Disables use of the server managing the
Shared Phone Book.

SPB Server Address
Enter the IP address for the server managing
the Shared Phone Book.

SPB Server Password

Enter the password for the server managing
the Shared Phone Book.
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Displaying the Machine Status

The Machine Status menu allows display of the versions, communication
mode, line connection quality, etc. of the Communication System and the

connected equipment.

Displaying the Machine Status Menu

1 Press the TOOLS button on the Remote Commander or use the 4, ¥ «or
» button to select “Tools”, then press the ENTER button.

The Tools menu appears,

1IPELA

B Tools
g4t Streaming [Suspended]
% Recording [Suspended]
o [Boos ]
7|\:| Icon display
32 Reject Answer
75_\ Screen Capture

2 Usethe 4, ¥, «or » button on the Remote Commander to select “Machine

Status”, then press the ENTER button.

The Machine Status menu appears.

1I2ELn
E2 Machine Status

MT‘ Machine Information

[ Peripheral Status ]

[.E8 BacktoTools| [ Communication Mode Status |
LAN Line Status.
Network Routing Check

Information screens enabled for display by the Machine Status

menu
Machine Information (see page 95)
Peripheral Status (see page 95)

Communication Mode Status (see page 96)

LAN Line Status (see page 96)

Network Routing Check (see page 107)

Displaying the Machine Status
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3 Use the 4, ¥, « or #» button on the Remote Commander to select the
information to be displayed, then press the ENTER button.

The selected display appears.

94 Displaying the Machine Status



Machine Information

The Machine Information menu shows the
versions of the HD Visual Communication
System and the connected equipment for
exclusive use, installed software versions,
etc.

Host Version
Displays the software version of the HD
Visual Communication System.

Software Option

Displays the optional software installed.

None: No software is installed.

Presentation: The PCSA-DSG80 HD Data
Solution software is installed.

Multipoint: The PCSA-MCG80 HD MCU
software is installed.

Option I/F

Displays the optional connected equipment.

None: No optional equipment is connected.

ISDN (B768): The PCSA-B768S ISDN
Unit is connected.

ISDN (B384): The PCSA-B384S ISDN
Unit is connected.

Tablet: Pen tablet (Bamboo MTE-450
manufactured by Wacom Co., Ltd.) is
connected.

Host Name
Displays the host name.

IP Address
Displays the IP address for LAN1 (LAN on
the PCS-XG55/XG55S).

IP Address (LAN2) (PCS-XG80/XG80S
only)
Displays the IP address for LAN2.

MAC Address
Displays the MAC address for LAN1 (LAN
on the PCS-XG55/XG55S).

MAC Address (LAN2) (PCS-XG80/
XG80S only)
Displays the MAC address for LAN2.

Serial Number
Displays the serial number.

Machine version

Selecting “Next” in the Machine
Information menu shows the codec version,
etc.

Peripheral Status

Video Input
Displays the input video name.

Audio Input (MIC)

Displays microphone input name.

Audio Input (AUX)

Displays the external audio input name.

Video Output

Displays the On/Off setting of “1080i
Mode” and the 50 Hz/60 Hz setting of
“Frequency”.

Audio Output
Displays the audio output equipped with this
system.

LAN Mode (LAN1)
Displays the LAN Mode for LAN1 (LAN on
the PCS-XG55/XG558S).

LAN Mode (LAN2) (PCS-XG80/XG80S

only)
Displays the LAN Mode for LAN2.

Gatekeeper

Displays the status of registration to
gatekeeper with the following messages:
Gatekeeper Requested, Gatekeeper
Confirmed, Gatekeeper Reject, Registration
Requested, Registration Confirmed,
Registration Failed, Registration Rejected,
Registration Timeout, Unregistration
Requested and Unregistration Confirmed.

First Camera
Displays the name of the first camera.

Second Camera
Displays the name of the second camera.
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Communication Mode Status

The Communication Mode Status menu
shows the status of current communication
when communication is in progress, and the
status of previous communications when
communication is not in progress.

The ISDN Line Status, LAN Line Status or
LAN Connection Status will also be
displayed depending on the line interface
used.

Communication Mode Status

The current communication status will be
displayed. When two or more points are
connected to the system, selecting “Next” in
the lower part of the page displays the next
page.

For the items described with both “(Encode)”
and “(Decode)”, the descriptions under
“(Encode)” show the setting status of the local
system and those under “(Decode)” show the
status of the receiving.

Far End Terminal Name
Displays the terminal name of a remote
party.

Remote Address
Displays the address of a remote party.

Audio Mode

Displays the current audio encoding format.

Video Mode

Displays the current video encoding format.

The audio encoding and video encoding
formats used for communication with a remote
party may differ from the settings in this menu,
depending on the status of the system on the
remote site.

Frame Rate

Displays the maximum frame rate of motion
pictures.

Rate

Displays in real time the number of
connected lines and their transfer rates.
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Line I/F
Displays the line interface being used.

Camera Control
Displays whether the unit is ready to operate
both cameras.

H239

Displays whether the unit is ready to use the
H.239 presentation mode.

Check Code
Displays the encryption check code.

LAN Line Status

The LAN line status will be displayed on
one page for each point connected to the
system. The connected point is shown at the
upper left corner of each page. Selecting
“Next” in the lower part of the page displays
the next page.

Bit rate - Encode

Displays by category (audio, video and
H.239 (presentation)) the transfer rates for
sending data.

Bit rate - Decode

Displays by category (audio, video and
H.239 (presentation)) the transfer rates for
receiving data.

Number of lost packets

Displays by category (audio, video and
H.239 (presentation)) the number of packets
lost during transfer on the network.

Number of recovered packets
Displays by category (audio, video and
H.239 (presentation)) the number of lost
packets that were recovered with the
system’s QoS function.

Number of received packets

Displays by category (audio, video and
H.239 (presentation)) the number of packets
received during communication.



Network Routing Check

The Network Routing Check menu is used to
check the network routing, and it shows the
checking results.
You can start the network routing check by
selecting “Start Measurement” in the lower
part of the menu.

For details, see “About the Network Routing
Check” on page 107.

IP address of remote site
Enter the IP address of the remote terminal
you want to check.

Line I/F

LAN1: Select to perform the routing check
for the network connected to the =41
connector (&= connector on the
PCS-XG55/XG55S).

LAN2: Select to perform the routing check
for the network connected to the =2
connector.

The “LAN2” setting is not available on the
PCS-XG55/XG55S.

Gateway
Displays the results of check for the default
gateway.

ping

Displays the results of check for
reachability, packet loss, RTT (Round-Trip
Time) and H.323 (H.323 communication
availability).

traceroute

Displays the results of check for HOP
(number of routers passed through to reach
the remote site) and total RTT.

Start Measurement

Select this button to start a network routing
check.

Previous

Select this button to restore the Machine
Status menu.

Restrictions on the
Use of LAN2
(PCS-XG80/XG80S
only)

When you use two LAN connections, use
the == 1 (LAN1) connector to connect a
private network in your company and the
@2 (LAN2) connector to connect to an
intranet outside your company.

The following functions of the system are
restricted when using the =2 (LAN2)
connector.

* In the event of using the == 1 (LAN1)
connector to connect to an intranet outside
your company, make sure to set “Web
Access”, “Telnet Access” and “SSH Access”
to “Disabled” on the Access Permit page of
the Administrator setup menu (page 89).

* The @2 (LAN2) connector cannot be used
on its own.

Items that cannot be set with LAN2

* NAT Mode

* Gatekeeper

e SNMP Mode

e SIP

e NTP

Shared Phone Book
AMX Device Discovery
H.460

« DNS

* Streaming

1Pv6

¢ Web Access, Telnet Access, SSH Access

Item that can be set with either
LAN1 or LAN2

* PPPoE

Items to be set with LAN1 or LAN2
individually

e DHCP Mode
¢ IP Address
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» Network Mask
* Gateway Address
* LAN Mode

Items to be set with LAN1 and LAN2
commonly

¢ Used Port Number (TCP, UDP)

* QoS

* TOS

¢ Auto Answer

* Reject Answer

Do not set the same subnet for the LAN1 and
LAN?2 connections.

98 | Restrictions on the Use of IPv6

Restrictions on the
Use of IPv6

The functions of the system are restricted as
follows when using the Internet Protocol
IPvo6.

Unusable functions with IPv6

SNMP Mode

NTP

Shared Phone Book
TOS

Network Routing Check
AMX Device Discovery
LAN2

e o o o o o o



Setting Up the Network Configurations

This section describes how to set up the network configurations for use with
various networks.

For details on the LAN setup menu, see “LAN Setup Menu” (page 76).

For details on configurations, consult with the system administrator.

LAN Connection via DHCP (LAN1/LAN2)

Configuration example

LAN (A) LAN (B)

DHCP Server 1

Set “DHCP Mode” to “Auto” under the Basic Setup page in the LAN setup

menu.
1IPELA
& Setup LAN Basic Setup
# LANT Host Name L ]
DHCP Mode
1P Address [
NeworkMask [
Gateway Address [ ]
Primary DNS [
Secondary DNS 7
LAN Mode

The setting has been configured properly if the IP address appears in the Home
menu.

To connect to a remote party
Select “IP” under “Line I/F”, enter the remote party’s IP address, and dial.
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LAN Connection through a Router (LAN1/LAN2)

Configuration example

Virtual
LAN (A) Private LAN (B)
Network
192.100.10.1 (VPN) 192.100.20.1
1

L | L |
Router Router !

192.100.20.20

192.100.10.10

Enter a name in “Host Name” under the Basic Setup page in the LAN setup
menu, and enter the appropriate values for “IP Address”, “Network Mask”,
and “Gateway Address”.

I1IPELA
& Setup LAN Basic Setup
Host Name ETENN
DHP Mode
IP Address
Network Mask
Gateway Address
Primary DNS 1
Secondary DNS L 1
LAN Mode

Gance

The setting has been configured properly if the correct IP address appears in
the Home menu.

To connect to a remote party

100

Select “IP” under “Line I/F”, enter the remote party’s IP address, and dial.
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LAN Connection through a Gatekeep

Configuration example

LAN (A)
192.100.10.1
Router
192.100.10.10
User alias: PCS-A
User number: 100
Gatekeeper

192.100.10.20

1 Enter aname in “Host Name” under the Basic Setup page in the LAN setup
menu, and enter the appropriate values for “IP Address”, “Network Mask”,

and “Gateway Address”.

er (LAN1 Only)

LAN (B)

192.100.20.1
Router

192.100.20.20
User alias: PCS-B

User number: 200

1I/ELA
& Setup LAN Basic Setup
Host Name E——
DHCP Mode
IP Address
Network Mask
Gateway Address
Primary DNS L ]
Secondary DNS ]
LAN Mode

2 set “Gatekeeper Mode” to “On” under the Gatekeeper page of the LAN
setup menu, and enter the appropriate values for “Gatekeeper Address”,

“User Alias”, and “User Number”.

1IPELA
& Setup LAN Gatekeeper
% LAN4 Gatekeeper Mode on _ [+]
Address [192.100.10.20
User Alias
User Number
H.460

The IP address registered is displayed in the Home menu.
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To connect to a remote party

Select “IP” under “Line I/F”, enter the user name or user number set by the
remote party, and dial.

LAN Connection through NAT (LAN1 Only)

Connection using NAT allows one IP address to be shared by several
computers on the same LAN. This section describes how to set up visual
communication in NAT and global IP environments.

Configuration example

210.10.10.1
192.100.10.1 210.20.20.1

Internet

192.100.10.10 210.20.20.2
(Global address)

1 Enter aname in “Host Name” under the Basic Setup page in the LAN setup
menu, and enter the appropriate values for “IP Address”, “Network Mask”,
and “Gateway Address”.

1ImELA
& Setup LAN Basic Setup

Host Name ET

DHCP Mode

IP Address

Network Mask

Gateway Address

Primary DNS L ]

Secondary DNS ]

LAN Mode

2 Set “NAT Mode” to “On” in the NAT Setup page of the LAN setup menu,
and enter the appropriate IP address in “WAN IP Address”.
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1IPELA
= Setup LAN NAT Setup

% LANS NAT Mode
WAN IP Address

Gance

The setting has been configured properly if the correct WAN IP address
appears in the Home menu.

To display the NAT address in the Home menu, you must set “Number
Display” to “NAT:Address” in the Home Menul page of the Home Menu
setup menu (page 86).

3 Remote parties must configure the Basic Setup page in the LAN setup
menu in the same way.

Remote parties do not need to configure the settings in the NAT Setup page of the
LAN setup menu as they are not in a NAT environment.

To connect to a remote party
Select “IP” under “Line I/F”, enter the remote party’s IP address, and dial.

When using the terminal in the NAT environment, you can connect to a remote party
(global IP), but for a remote party to connect to you, you must configure your router
settings. For details on router settings, consult with the system administrator.

LAN Connection with H.460 Firewall Traversal (LAN1 Only)

You can use H.460 to traverse firewalls and connect with the terminals on
other networks.
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Configuration example

192.100.10.1 192.200.20.1

Internet - 1 |
Router
e Traversal 192.200.20.10
192.100.10.10 server

User Alias: PCS-A
User Number: 100 210.20.20.10
(Global address

-~

1 Enter aname in “Host Name” under the Basic Setup page in the LAN setup
menu, and enter the appropriate values for “IP Address”, “Network Mask”,
and “Gateway Address”.

1PELA
& Setup LAN Basic Setup

Host Name

DHo Mode

IP Address

Network Mask

Gateway Address

Primary DNS L 1

Secondary DNS |:|

LAN Mode

2 Set “H.460” to “On” under the Gatekeeper page of the LAN setup menu.
Set “Gatekeeper Mode” to “On” and enter the appropriate value for

“Gatekeeper Address”.
1IPELA
& Setup LAN Gatekeeper

5 LAN4 Gatekeeper Mode

Address

User Alias
User Number
H.460

N

8|

3

3

3
[«] [+

Gance

The IP address registered is displayed in the Home menu.

To conduct a video conference

Select “IP” under “Line I/F”, enter the remote party’s IP address, and dial.
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LAN Connection Using PPPoE (LAN1/LAN2)

When using PPPoE, you can connect via LAN without a router.
A modem (using bridge mode) is required when using FLET’S ADSL.

Configuration example

Local IP

network BFLET'S oONu

211.10.10.10

210.10.10.10

1 Set “PPPoE” to “LANI” or “LAN2” under the PPPoE page in the LAN
setup menu, and enter the PPPoE user name and PPPoE password given to
you by the provider.

* The “LAN1” setting is called the “On” setting on the PCS-XG55/XG55S.
* The “LAN2” setting is not available on the PCS-XG55/XG55S.

IPELA
& Setup LaN PPPOE
2 LAN2 PPPOE
User Alias Sony@aaanejp
Password

Fixed IP for PPPOE
Fixed IP Address for PPPOE
ons
Primary DNS L ]
Secondary DNS ]

Save Cancel

2 1t you have a fixed IP from the provider, set “Fixed IP for PPPoE” to “On”,
and enter your fixed IP address for PPPoE in “Fixed IP Address for
PPPoE” under the PPPoE page in the LAN setup menu.

The setting has been configured properly if the correct IP address appears
in the Home menu.

If the fixed DNS server address is specified by the provider, set “DNS” to
“Specify”, and enter the specific addresses in “Primary DNS” and “Secondary
DNS”.

3 Remote parties must configure in the same way.
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To connect to a remote party
Select “IP” under “Line I/F”, enter the remote party’s IP address, and dial.

ISDN Connections

1 Enterthe appropriate numbers for “Area Code” and “Local Number” in the
Telephone Number page of the ISDN setup menu.

Do not enter the first 0 of the area code.
For details on the ISDN setup menu, see “ISDN Setup Menu” (page 81).

For details on configurations, consult with the system administrator.

[ELIWN
& Setup ISDN Number
Area Code Local Number

Al J J
Az ] J
B3 [ J J
B2 J J
ci I J
c2| J 1 J
Auto SPID

The setting has been configured properly if the correct line number appears
in the Home menu.

2 Remote parties must configure in the same way.

When connecting to the ISDN unit, use the ports in ascending order.
Yes: 1,2, 3...
No: 1,6,5...

To connect to a remote party

Select “ISDN” under “Line I/F”, enter the remote party’s line number, and
dial.

For details on how to start a visual communication, see “Starting a
Connection by Calling a Remote Party” (page 108).
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About the Network Routing Check

Before connecting a remote system, you can check the network routing to
assure smooth connection with the system.

For the network routing check, knowledge of network is required. Consult your
network administrator or Sony dealer.

If you have any questions about the checked result, consult your network
administrator or Sony dealer.

To start the network routing check

Open the Network Routing Check menu of the Machine Status menu on the
local system that performs the routing check, then set the necessary items on
the menu.

Select “Start Measurement” to start the network routing check.

1IPELA
3 Machine Status > Network Routing Check

IP Address of Remote Site XXX XXX XXX XXX

Line I/F LAN1 52

Gateway Result
ping Result
Packet Loss (%)
RTT
I H.323 Communication
traceroute HOP
Total RTT

Start Measurement|

For the procedure how to open the Network Routing Check menu, see
“Displaying the Machine Status” on page 93.

While the network routing check is being performed, you cannot use any other functions
including communication. When the routing check is complete, the checked results are
displayed on the Network Routing Check menu.
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Chapter 3: Basic
Connection

This chapter describes how to connect to a remote party after the administrator
has completed various registrations and settings for the system.

The chapter explains a point-to-point communication via a LAN connection,
ISDN connection using the optional PCSA-B384S or PCSA-B768S ISDN
Unit or SIP.

For use of optional equipment, see Chapter 4.
To conduct an encrypted communication, see Chapter 5.

To conduct a multipoint communication, see Chapter 6.

Starting a Connection by Calling a
Remote Party

You can start a communication with a remote party by dialing. Once you have

made a connection to the remote party, you can begin talking just as with a

normal phone call and start communication.

You can call a remote party using the various methods described below. Use

any one depending on the settings in the Home menu or connecting status.

* To call a remote party by using the Connect menu (page 109)

* To call a remote party by entering their address or number directly (Direct
Dial) (page 110)

* To call a remote party by using the one-touch dial buttons (page 112)

* To call a remote party by using the history list (page 113)

* To call a remote party registered in the Phone Book (page 114)

* To call a remote party not registered in the Phone Book by setting the
necessary items in the Detailed Dial menu (page 116)

Turning On the Power
1 Turn on the TV monitor.
2 Turn on other equipment you are using for the communication.

3 Press the /) (power) switch on the Communication System to turn it on.
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/() (power) switch
/(Y (power) indicator

The indicator on the System starts flashing, then lights in green when the

power is on.

The Home menu appears on the monitor screen and the picture shot by the

local camera also appears.

After the power is turned on, the camera moves automatically for trial operation. Be

careful not to catch your finger.

Calling a Remote Party by Using the Connect Menu

This method is available when the Connect button is displayed in the Home

menu.
1IPELA Ana PRGN T Ready to connec L 5112008 1300
A Home
% Connect

Connect button

1 Usethe 4, ¥, «or#» button on the Remote Commander to select “Connect

in the Home menu, then press the ENTER button.
The Connect menu appears.
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IPELA 5/1112008 13:00

Enter Number/Address
Select from Phone Book
@ Connect Select from History.

2 Use the 4, ¥, « or » button on the Remote Commander to select how to
call a remote party, then press the ENTER button.

The menu screen will change according to the item you select.

Enter Number/Address: The Detailed Dial menu appears on the screen.
For the procedure to be followed, see “Calling a Remote Party Not
Registered in the Phone Book” on page 116.

Select from Phone Book: The Phone Book appears on the screen.

For the procedure to be followed, see “Calling a Remote Party Registered
in the Phone Book” on page 114.

Select from History: The history list appears on the screen.

For the procedure to be followed, see “Calling a Remote Party by
Selecting Them in the History List” on page 113.

Calling a Remote Party by Entering Their Address or Number
Directly (Direct Dial)

When “Direct Dial” is set to “On” in the Home Menu setup menu, the number
input box, Dial button, etc. are displayed in the Home menu, allowing you to
use the direct dial function.

IPELA AAA 1P 0 =3 ly to connect.  5/11/2008 13:00
A Home

[P o [v] ][ pial

Line interface Dial
Number input box
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1 Usethe 4, ¥, «or % button on the Remote Commander to select “Line I/
F” in the Home menu, then press the ENTER button.

2 Use the 4, ¥, <« or # button on the Remote Commander to select the line
interface to be used, then press the ENTER button.

IP: Connects to the system on the remote site via a LAN connected to the
&1 (LAN1) connector (&7 (LAN) connector on the PCS-XG55/
XG558).

ISDN: Connects to the system on the remote site via an ISDN line.

TEL: Connects to a phone on the remote site via an ISDN line for a voice
meeting.

* When a checkmark is put to “SIP” under “Line Interface” of the Line Interface
setup menu, you can select “SIP” from the line interface select box.

* When “Use LAN2” is set to “On”, you can select “IP(2)” from the line interface
select box.

3 Use the 4, ¥, « or » button on the Remote Commander to select the
number input box, then press the ENTER button.

4 Enter the remote party’s IP address or line number with the number buttons
on the Remote Commander, then press the ENTER button.

The format of the address for a SIP connection is the following:
* 4000 (number assigned by the SIP server)

* 4000@sip.com

¢ 192.168.1.1 (when the IP address and SIP server are not used)

5 Press the CONNECT ( @ ) button on the Remote Commander. Or use the
4, ¥, «or» button on the Remote Commander to select “Dial”, then press
the ENTER button.

The system begins dialing the IP address or telephone number entered in
step 4. “Dialing” appears on the monitor screen.

When the system connects to the remote system, the message “Session
Connected.” appears on the screen and the picture on the remote site is
displayed. Now you can start communication with the remote party.

;?‘
) L

Picture on the local site

Picture on the remote site
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To cancel dialing before connecting with the remote party
While “Dialing” is displayed on the monitor screen, press the DISCONNECT
(=) button or the ENTER button on the Remote Commander.

Calling a Remote Party Using the One-Touch Dial Buttons

When “One-Touch Dial” is set to “On” in the Home Menu setup menu, the
one-touch dial buttons are displayed in the Home menu, allowing you to use
the one-touch dial function.

For registration of the one-touch dial buttons, see “Registering a Remote
Party — Phone Book” on page 122.

1 Open the Home menu.

2 Select the one-touch dial button for which the remote party you want to call
is registered with one of the F1 to F4 buttons on the Remote Commander.
Or select the one-touch dial button you want to call in the Home menu by
pressing the 4, ¥, « or # button on the Remote Commander, then press the
ENTER button. Select “Connect” from the displayed submenu with the 4,
¥, « or # button, and press the ENTER button.

IPELA AAA IPXXCXHKX XXXHK (I Ready to connect.  5/11/2008 1300
A Home

Camera
EXETr— ® ® oo 0lll|leae e
2
@ History Room 101 Room 201 Office A Office E
& Phone Book

[ &+ Detailed Dial ] [P [~ [ & pial

One-touch dial buttons

The system begins dialing the selected remote party. “Dialing” appears on
the monitor screen. When the system connects to the remote system,

“Session Connected.” appears on the screen and the picture on the remote
site is displayed. Now you can start communication with the remote party.

To cancel dialing before connecting with the remote party
While “Dialing” is displayed on the monitor screen, press the DISCONNECT
(=) button or the ENTER button on the Remote Commander.
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Calling a Remote Party by Selecting Them in the History List

1 Usethe #, ¥, «or» button on the Remote Commander to select “History”
in the Home menu, then press the ENTER button. Or select “Connect” in
the Home menu with the 4, ¥, « or ® button and the ENTER button to
display the Connect menu, then select “Select from History”.

The History menu appears.

1ImELA 51172008 1300
History
1\ Home T 200810501 00:00 (12:3456)
Answer Dial History2
555-555-555 2008/05/26 00:00 (03:25:45)
Wissed Call Dial History
17.47.47.47 2008105726 00:00 (01:00:17)

Dial History4
18.18.18.18 2008/05/26 00:00 (01:00:18)

Dial History6
20202020 2008/05/26 00:00 (01:00:20)

& Phone Book 66.66.66. A
Dial Historyd
& Detailed Dial 80.68.66.88

You can display the History menu by selecting “History” from the Phone Book or
Detailed Dial menu.

2 Use the 4, ¥, « or # button on the Remote Commander to select “Dial
(outgoing call history)”, “Answer (incoming call history)” or “Missed Call
(incoming call history in absence)”, then press the ENTER button or #
button.

The selected history list appears.

1IPELA 5/11/2008 13:00
History
i Home R 200810501 00:00 (12:38:59)
Answer Dial Historyz
555-555-555 2008/05/26 00:00 (03:25:45)
Missed Call Dial Historya
17.47.17:

Dial History4
18.18.18.18 2008/05/26 00:00 (01:00:18)

Dial History6

20202020 2008/05/26 00:00 (01:00:20)
3 Phone Book 66.66.66.66 :08 (00:00:
Dial History8
@+ Detailed Dial 88.88.88.88

3 Usethe 4, ¥, «or» button on the Remote Commander to select the remote
party you want to call.

4 press the CONNECT ( @ ) button on the Remote Commander. Or press
the ENTER button to display the submenu, select “Connect” with the 4, ¥,
« or #» button, and press the ENTER button.
The system begins dialing the selected party. “Dialing” appears on the
monitor screen. When the system connects to the remote system, “Session
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Connected.” appears on the screen and the picture on the remote site is
displayed. Now you can start communication with the remote party.

To cancel dialing before connecting with the remote party

While “Dialing” is displayed on the monitor screen, press the DISCONNECT
(=) button or the ENTER button on the Remote Commander.

You can select the items below from the submenu:

“Cancel”: Cancels selection from the history list.

“Edit”: Displays the List Edit menu for registration in the Phone Book.
“Delete”: Deletes the selected call from the history list.

Calling a Remote Party Registered in the Phone Book

For the registration in the Phone Book, see “Registering a Remote Party —
Phone Book” on page 122.

1 Usethe 4, ¥, @« or # button on the Remote Commander to select “Phone
Book” in the Home menu, then press the ENTER button. Or select
“Connect” in the Home menu with the 4, ¥, « or # button and the ENTER
button to display the Connect menu, then select “Select from Phone Book”.
The Phone Book appears on the monitor screen.

1ImELA
3 Phone Book
Default Group _
1A Home PY P ° o o
X
(G| gas
oo 101 Room 102 offce A
[ Groups | | isonoresisers | | passasszssass | | isonoa7eseczio
New Entry
° °
Group Edit -. -. o
Room 201 Room 202 Office E
M Group?7 1P0.0.0.0 1P 123.456.789.012 ISDN 01-2345-6789
{3 History. M Groups
&+ Detailed Dial

2 Usethe 4, ¥, «or» button on the Remote Commander to select the Group
in which the remote party you want to call is registered, then press the
ENTER button.

3 Use the 4, ¥, @« or » button on the Remote Commander to select the remote
party you want to call.

4 press the CONNECT ( @ ) button on the Remote Commander. Or press

the ENTER button to display the submenu, select “Connect” with the 4, ¥,
« or # button, and press the ENTER button.
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1IPELA
4 Phone Book

Ao | T (2l

Room 101
1SDN 01-2345-6789

New Entry
Group Edit

{3 History
¢ Detailed Dial

The system begins dialing the selected party. “Dialing” appears on the
monitor screen. When the system connects to the system on the remote site,
the message “Session Connected.” appears on the screen, and the picture
on the remote site is displayed.

Now you can start communication with the remote party.

To cancel dialing before connecting
While “Dialing” is displayed on the monitor screen, press the DISCONNECT
(=) button or the ENTER button on the Remote Commander.

To switch the display in the Phone Book between the list and the
thumbnails

Each time the F1 button on the Remote Commander is pressed, the display
changes between the list and the thumbnails.

To change the order of display

Each time the F2 button on the Remote Commander is pressed, the display
changes between the list of remote parties’ names in ascending alphabetical
order and that list in descending alphabetical order.

To display the Phone Book during communication
Press the # button on the Remote Commander during communication.

To call a remote party registered in the Private Phone Book

1 Insert the “Memory Stick” that contains the Private Phone Book into the
Memory Stick slot on the Communication System.

The Phone Book changes to the Private Phone Book.

2 Select “Private Phone Book” in the Home menu, and press the ENTER
button.

3 Use the 4, ¥, <« or # button on the Remote Commander to select a remote
party you want to call from the Private Phone Book.

4 press the CONNECT ( @ ) button on the Remote Commander. Or press

the ENTER button to display the submenu, select “Connect” with the 4, ¥,
« or #» button, and press the ENTER button.
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If the auto dialing feature of the Private Phone Book is activated, the system begins
dialing when the “Memory Stick” is inserted.

Calling a Remote Party Not Registered in the Phone Book

1 Usethe 4, ¥, «or # button on the Remote Commander to select “Detailed
Dial” in the Home menu, then press the ENTER button. Or select
“Connect” in the Home menu with the 4, ¥, « or # button and the ENTER
button to display the Connect menu, then select “Enter Number/Address”.

The Detailed Dial menu appears on the screen.

1IPELA
@+ Detailed Dial

£ Home Dial to:

Line VF
Communication

Bit Rate 1024kbps [+
Number of Lines [1B (64K) |+

2 Select the line interface to be used for connection.

Use the 4, ¥, « or ® button to select “Line I/F”, then press the ENTER

button. The setting items appear. Press the 4, ¥, < or # button to select the

line interface to be used to connect to the remote party, then press the

ENTER button.

IP: Connects to a remote party via a LAN connected to the &= 1 (LAN1)
connector (&7 (LAN) connector on the PCS-XG55/XG55S).

ISDN: Connects to a remote party via an ISDN.

ISDN (2B): Connects to the H.221-format system via 2B channels of the
ISDN connection.

TEL: Connects to the phone of a remote party to conduct a voice meeting
via the ISDN connection.

* When a checkmark is put to “SIP” under “Line Interface” of the Line Interface
setup menu, you can select “SIP” from “Line I/F”.
* When “Use LAN2” is set to “On”, you can select “IP(2)” from “Line I/F”.

3 Configure the LAN or ISDN line to be used for connection.
When using the LAN
@ Enter the IP address of a remote party to connect in the IP text box.
Use the 4, ¥, « or # button on the Remote Commander to select the IP
text box, then press the ENTER button. Next, enter the IP address with
the number buttons on the Remote Commander or the on-screen
keyboard, and press the ENTER button.
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Enter the host name and domain name (ex. host.domain) when using
the DNS server, or enter the party’s user name and user number
registered in the LAN setup menu on the remote party’s system when
using the gatekeeper, then press the ENTER button.

¢ You can enter a dot (.) with the » or DOT button on the Remote Commander,
or “#” or “Dot” on the on-screen keyboard.

¢ To delete the last entered character, use the BACK SPACE button on the
Remote Commander or “Back Space” on the on-screen keyboard.

¢ To delete the entered IP address, use the RETURN button on the Remote
Commander or “Cancel” on the on-screen keyboard.

® Select the communication bit rate.

Use the 4, ¥, « or » button to select “Communication Bit Rate”, then
press the ENTER button. Press the 4, ¥, « or ® button to select the
communication bit rate from the displayed submenu, then press the
ENTER button.

When using the ISDN
@ Enter the telephone number of a remote party to connect in the A text

box.

Use the 4, ¥, « or # button on the Remote Commander to select the A
text box, then press the ENTER button. Next, enter the telephone
number with the number buttons on the Remote Commander or on-
screen keyboard, and press the ENTER button.

Do not enter the prefix number in the telephone number text box, when the prefix
setting is on. For details on prefix settings, see “Dial Setup Menu” on page 65.
Even when you connect multiple ISDN lines (2B (128K) or more number of
lines), entering one telephone number of the remote party enables you to connect
all the lines used automatically.

When you select ISDN (2B (128K)), the A1 and A2 text boxes appear. You can
enter a separate ISDN line number in each text box. Pressing the ENTER button
on the Remote Commander while the A2 text box is selected copies the number
entered in the Al text box to the A2 text box.

To delete the last entered character, use the BACK SPACE button on the Remote
Commander or “Back Space” on the on-screen keyboard.

To delete the entered ISDN telephone number, use the RETURN button on the
Remote Commander or “Cancel” on the on-screen keyboard.

@ Select the number of ISDN lines to use during the call.

Use the 4, ¥, « or # button on the Remote Commander to select
“Number of Lines”, then press the ENTER button. Press the 4, ¥, «or
* button to select the number of channels to be used when calling a
remote party from the displayed items, then press the ENTER button.
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To connect to the remote party by entering all the telephone numbers for the
ISDN lines used

If the system of the remote party is not equipped with the bonding function, entering
one remote party’s telephone number does not allow automatic connection of
multiple ISDN lines used to connect to the remote party. To connect to the remote
party by entering all the telephone numbers, register the remote party’s telephone
numbers for the ISDN lines to be used referring to “Registering a Remote Party —
Phone Book”(page 122), then connect to the remote party according to the
procedure described in “Calling a Remote Party Registered in the Phone Book™
(page 114).

4 Press the CONNECT ( @) button on the Remote Commander, or use the
4+, ¥, «or=» button to select “Connect” in the lower part of the menu, then
press the ENTER button on the Remote Commander.

The system begins dialing the IP address or ISDN telephone number
entered in step 3. “Dialing” appears on the monitor screen.

When the system connects to the remote system, the message “Session
Connected.” appears on the screen, and the picture on the remote site is
displayed. Now you can start communication with the remote party.

To cancel dialing before connecting
While “Dialing” is displayed on the monitor screen, press the DISCONNECT
('@ ) button or the ENTER button on the Remote Commander.

To save the entered IP address or ISDN telephone number in the
Phone Book

When you enter the IP address or ISDN telephone number, the Save button
appears at the lower part of the menu.

Select “Save” with the 4, ¥, <« or # button, then press the ENTER button on
the Remote Commander. The List Edit menu is displayed. Save the address or
number you entered into the Phone Book.

For details on the List Edit menu, see “Registering a Remote Party — Phone
Book” on page 122.

Redial function

Once you have input the IP address or ISDN telephone number using the
Detailed Dial menu, it will be entered in the text box of the Detailed Dial menu
the next time you open the menu.

The redial function is not available:
¢ Once you have turned off the power of the system or set it to standby mode.
* When you cancel dialing the entered IP address or ISDN telephone number.
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Receiving a Call from a Remote Party

Operations for answering a call differ depending on the setting of the answer
mode.

Auto answer mode

The system automatically receives a call from a remote party and you can start
connecting. Although no operation is necessary to start, the picture on the local
site will be displayed on the remote site screen even if you are not ready to
begin.

Manual answer mode

When there is an incoming call, the Communication System rings. You need
to connect the call manually.

You can start connecting when you are ready.

* You cannot answer the call unless the power switch on the Communication System is
on.
* Make sure that the TV monitor is turned on.

For setting of the answer mode, see “Auto Answer” in the Answer setup menu
on page 66.

Answering a Call from a Remote Party

To answer a call in auto answer mode

When you receive a call, the Communication System rings and the message
“Answering...” appears on the monitor screen. The system is automatically
connected and the picture of the remote party is displayed on the local monitor
screen and the sound is heard. The picture and sound on the local site will be
enabled on the remote site at the same time.

The message “Session Connected.” appears on the monitor screen.

You are now ready to start communication.

Picture on the local site

—— Picture on the remote site
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See pages 133 to 143 to adjust the sound and picture during communication.

To receive a call in manual answer mode

When you receive a call, the Communication System rings and the message
“Incoming call. Answer?” appears on the monitor screen.

Press 4, ¥, « or » to select “OK?”, then press the ENTER button. The system
is then connected. Once the connection is made, the picture of the remote party
is displayed on the local monitor screen and the sound is heard. The picture and
sound on the local site will be enabled on the remote site at the same time.
The message “Session Connected.” appears on the monitor screen.

You are now ready to start a communication.

See pages 133 to 143 to adjust the sound and picture during communication.

When you do not want to answer the call
Press #, ¥, « or # to select “Cancel”, then press the ENTER button. Ringing
stops, and the connection is canceled.

When the system fails to make an ISDN connection

120

If the system fails to connect to the remote party, the message “Cannot
complete connection. (an ISDN cause code and a message are displayed here)”
appears on the monitor screen.

For details on ISDN cause codes and messages, see “On-Screen Messages”
on page 233.
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Ending the Connection

1 Press the DISCONNECT (= ) button on the Remote Commander.
The message “Disconnect?” appears on the monitor screen.

2 Press the DISCONNECT (=) button on the Remote Commander again,
or press the 4, ¥, « or # button on the Remote Commander to select “OK”,
then press the ENTER button.

The system is disconnected.

The power of the Communication System remains on even if the system is
disconnected.

To cancel disconnection of the system
Select “Cancel” with the 4, ¥, @« or # button on the Remote Commander, then
press the ENTER button.

To register the connected remote party in the Phone Book

You can easily register the remote party who has just disconnected.

If you set “Last Number Registration” to “On” on the Device Setup page of the
General setup menu, the message “Register this participant in the list?”
appears after a communication with an unregistered remote party is finished.
When you select “OK”, the List Edit menu appears.

If the “Last Number Registration” is set to “Off”, the message does not appear.

For “Last Number Registration” setting, see “General Setup Menu” on page
83.
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Registering a Remote Party — Phone
Book

You can register the telephone number or IP address of a remote party in the
Phone Book, allowing you to dial the party very easily.

Up to 1000 remote parties can be registered in the Phone Book. You can also
store a still image such as a participant’s portrait in the index list.

You can also create a Private Phone Book on a “Memory Stick” separately
from the Phone Book in the Communication System.

Registering a New Remote Party

1 Use the 4, ¥, « or  button on the Remote Commander to select “Phone
Book” in the Home menu, then press the ENTER button. Or select
“Connect” in the Home menu with the 4, ¥, <« or # button and the ENTER
button to display the Connect menu, then select “Select from Phone Book™.
The Phone Book opens.

1IPELA
& Phone Book > Default Group

> rome

B

New Entry

Group Edit

(3 History
-+ Detailed Dial

The Phone Book can be displayed by selecting “Phone Book” in the History or
Detailed Dial menu.

2 Use the 4, ¥, « or » button on the Remote Commander to select “New

Entry”, then press the ENTER button.
The List Edit menu appears.
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1IPELA
2 Phone Book

Group Select None Specified [+
. Dial
Dial to: Specified None Specified |+

Communication
B 1024Kbps. ~

Number of Lines 2B (128K)

3 Set the items in the List Edit menu.
Use the 4, ¥, « or # button and the ENTER button on the Remote
Commander to select the setup item.
To enter the characters, use the number buttons on the Remote Commander
or the displayed on-screen keyboard, and press the ENTER button. To
select the item, use the 4, ¥, <« or # button and press the ENTER button.

Index
Enter the name of a remote party in the Index text box. You can use up to
39 letter and number characters.

Group Select
Select the group set in the Phone Book.

Dial to:

Enter the IP address or line number of a remote party depending on the line

interface you select.

When you select “IP” from ‘“Line I/F”’: Enter the remote party’s IP
address. Enter the host name and domain name (ex. host.domain) when
using the DNS server, or enter the party’s user name and user number
when using the gatekeeper (page 78).

When you select “ISDN” from “Line I/F”’: Enter the remote party’s line

number. If you register the sub-address in the Phone Book, enter an
asterisk between the line number and sub-address. The sub-address can
only be composed of numbers.
When “More Options Enable” is set to “On” in the Dial setup menu
(page 65), six line input text boxes, Al, A2, B1, B2, C1 and C2, are
displayed. Be sure to enter the remote party’s number to the Al text
box.

When you select “TEL” from “Line I/F”’: Enter the telephone number of
a remote party. (ex. 0390123456)

When you select “SIP” from “Line I/F”’: Enter the address of a remote
party or the number assigned by the SIP server.

The format of the address is the following:

* 4000 (number assigned by the SIP server)

* 4000 @sip.com

¢ 192.168.1.1 (when the IP address and SIP server are not used)
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Icon/Image
Select the icon or a still image stored on a “Memory Stick” to be displayed
on the Phone Book.

You cannot select a still image unless a “Memory Stick” in which still images are
stored is inserted.

One-Touch Dial Specified

Select whether to display the one-touch dial buttons in the Home menu.
Assign the F1, F2, F3 or F4 function button on the Remote Commander to
each one-touch dial button.

Line I/F

Select the line interface you are using to connect to a remote party. Select
from among IP, ISDN, TEL and SIP. Selecting any interface switches the
setting items in the List Edit menu.

* When a checkmark is put to “SIP” under “Line Interface” of the Line Interface
setup menu, you can select “SIP” from “Line I/F”.
* When “Use LAN2” is set to “On”, you can select “IP(2)” from “Line I/F”.

Communication Bit Rate

Select the communication bit rate when you select “IP” or “SIP” with
“Line I/F”.

Number of Lines

Select the number of ISDN channels to be used when you select “ISDN”
with “Line I/F”.

You can select “Number of Lines” only when the PCSA-MCG80 HD MCU
software is installed in the Communication System.

Auto Dial

Set this item only for the Private Phone Book (page 128). Setting “Auto
Dial” to “On” allows you to automatically dial one of the lists in the Private
Phone Book simply by inserting the “Memory Stick” in which the Private
Phone Book is registered.

4 Use the 4, ¥, @ or » on the Remote Commander to select “Save”, then
press the ENTER button.

The settings are registered in the Phone Book.

When a connection with a remote party not registered in the Phone Book is terminated,
you can register this remote party to the Phone Book. In this case, the IP address or line
number is shown in “Index” as the name of the remote party. Modify it if necessary.
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To connect to the remote party without using bonding

If the system of the remote party is not equipped with the bonding function,
entering one telephone number does not allow you to connect all the line
numbers used to connect to the remote party. To connect to the remote party
by entering all the ISDN line numbers used, you can set the connection without
using the bonding function of this system.

When you set “More Options Enable” to “On” in the Dial setup menu (page
65), the A1, A2, B1, B2, C1 and C2 text boxes appear in the List Edit menu.
Enter all the telephone numbers for the ISDN lines selected by “Number of
Lines”.

When you set “Number of Lines” to “2B”, you can connect to the remote party by
selecting “ISDN (2B)” from “Line I/F” in the Detailed Dial menu.

To set up more detailed options

When “More Options Enable” is set to “On” in the Dial setup menu, the More
Options button is shown at the lower part of the List Edit menu.

Select the More Options button with the 4, ¥, 4« or # button on the Remote
Commander and press the ENTER button to open a menu for more detailed
dial settings. You can change the settings of the desired items.

The contents set with the More Options button have priority over those set in the Dial
setup menu.

Editing the Contents of the Phone Book

You can edit the telephone number, IP address, name or setting registered in
the Phone Book.

1 Open the Phone Book.

2 Usethe 4, ¥, « or » button on the Remote Commander to select the remote
party to be modified, then press the ENTER button.

The submenu appears.

Cancel

Connect

Edit

Copy

Delete

3 Press the 4, ¥, <« or # button on the Remote Commander to select “Edit”,
then press the ENTER button.

The List Edit menu appears.
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4 Modify the telephone number, IP address, name or setting.

5 Use the 4, ¥, « or # button on the Remote Commander to select “Save”,
then press the ENTER button.

The modification is completed.

Copying a Registered Party in the Phone Book
1 Open the Phone Book.

2 Usethe 4, ¥, «or» button on the Remote Commander to select the remote
party to be copied, then press the ENTER button.
The submenu appears.

3 Press the 4, ¥, « or » button on the Remote Commander to select “Copy”,
then press the ENTER button.

The items for the selected party are copied, and the name is followed by “~
2”. You can use the setting after modifying the necessary items.

Deleting the Registered Remote Party
1 Open the Phone Book.

2 Usethe 4, ¥, « or » button on the Remote Commander to select the remote
party to be deleted from the Phone Book, then press the ENTER button.

The submenu appears.

3 Press the 4, ¥, « or # button on the Remote Commander to select
“Delete”, then press the ENTER button.

The message “Delete Entry?” appears.

4 Use the 4, ¥, « or # button on the Remote Commander to select “OK”,
then press the ENTER button.

The selected party is deleted.

To cancel deleting
Select “Cancel” in step 4, then press the ENTER button.

Creating a Group in the Phone Book (Group Edit)

You can create groups into which the registered remote parties are grouped.

To register a new group

1 Open the Phone Book.
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2 Use the 4, ¥, « or # button on the Remote Commander to select “Group
Edit”, then press the ENTER button.
The Phone Book > Group Edit menu appears.

1ImTELA
¥ Phone Book > Group Edit

3 Use the 4, ¥, « or » button on the Remote Commander to select “New
Entry”, then press the ENTER button.

The group name input menu appears.

1IPELA
I Phone Book > Group Edit
B New Entry
& Previous
Group Edit

Cancel

4 Enter the group name using the number buttons on the Remote
Commander and the on-screen keyboard, then press the ENTER buttons.

You can use the alphabetical letters, numbers and symbols.

5 Use the 4, ¥, « or # button on the Remote Commander to select “Save”,
then press the ENTER button.
The registered group button is displayed.

IPELA
El Phone Book > Group Edit
B New Entry
i TOKYO TOKYO

Registering a Remote Party — Phone Book 127

uonosuuo) odiseq g Jeideyn



6 Use the 4, ¥, @« or % button on the Remote Commander to select
“Previous”, then press the ENTER button.

The Phone Book is restored.

To modify the group name

1 Open the Phone Book > Group Edit menu, select the group button you
want to modify using the 4, ¥, < or # button on the Remote Commander,
and press the ENTER button.

The submenu appears.

1IPELA
B Phone Book > Group Edit
s New Entry
M TOKYO Cancel

Delete

2 Use the 4, ¥, « or #» button on the Remote Commander to select “Edit”,
then press the ENTER button.

The group name input menu appears.

3 Modify the group name using the number buttons on the Remote
Commander and the on-screen keyboard, then press the ENTER buttons.

4 Use the 4, ¥, « or » button on the Remote Commander to select “Save”,
then press the ENTER button.
The modified group button is displayed in the Phone Book > Group Edit
menu.

* You can operate the following with a submenu in the Group Edit menu.
“Cancel”: Cancels selection of the group button.
“Delete’: Deletes a group in which no party is registered.

* You cannot delete a group button for which any remote parties are registered.

Creating a Private Phone Book

You can create your own Phone Book (Private Phone Book) on a “Memory
Stick”. Once the Private Phone Book is registered, inserting the “Memory
Stick” into the Communication System changes the Phone Book to the Private
Phone Book. You can also activate the Auto Dial feature, allowing you to
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automatically start dialing one of the remote parties registered in the Private

Phone Book simply by inserting the “Memory Stick”.

To register a new remote party in a Private Phone Book

1 Inserta “Memory Stick” in which you want to register a remote party into

the Memory Stick slot on the Communication System.
Insert the “Memory Stick” in the direction of the arrow with the mark
facing upward.

2 Open the Phone Book page in the Administrator setup menu.

1IPELA
& Setup Administrator  Phone Book
Save Phone Book
Load Phone Book
Clear Phone Book
Auto Dialing
Create Private Phone Book
Delete Private Phone Book

Copy to Private Phone Book

Cancel

For how to open the menu, see “Registering Local Information” on page

61.

3 Select “Create Private Phone Book”.
An empty folder and file for a Private Phone Book are created in the
“Memory Stick”.

4 Register a new remote party.
The procedure is the same as that for registering in the Phone Book.

Proceed with steps 2 to 4 in “Registering a New Remote Party” on page

122.

The procedures for how to edit the contents of the Private Phone Book,

how to delete the registered remote party, or how to copy one of the

registered parties in the Private Phone Book are the same as those for the

Phone Book. Open the Private Phone Book and proceed with the steps
described on pages 125 to 126.
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To copy all the contents of the Phone Book to the Private Phone Book

Insert the “Memory Stick” in which you want to store the Private Phone Book
into the Memory Stick slot on the Communication System, then select “Copy
to Private Phone Book” in the Administrator setup menu. All the data
registered in the Phone Book are copied to the inserted “Memory Stick”.

To delete the Private Phone Book from the “Memory Stick”

Insert the “Memory Stick” from which you want to delete the registered
Private Phone Book into the Memory Stick slot on the Communication
System, then select “Delete Private Phone Book™ on the Phone Book page in
the Administrator setup menu. All the data are deleted from the inserted
“Memory Stick”.

To dial a specified remote party in a Private Phone Book automatically

If you set “Auto Dialing” in the Administrator setup menu to “On”, you can
automatically dial one of the registered remote parties in the Private Phone
Book simply by inserting the “Memory Stick” in which the Private Phone
Book is registered.

1 Open the Private Phone Book.

2 Usethe 4, ¥, « or» button on the Remote Commander to select the remote
party to dial automatically, then press the ENTER button.

3 Press the 4, ¥, <« or # button on the Remote Commander to select “Edit”,
then press the ENTER button.

The List Edit menu appears.

4 Use the 4, ¥, « or # button on the Remote Commander to select “Auto
Dialing”, then press the ENTER button.

The setting is registered and “AUTO” appears in the Private Phone Book.

Using the Shared Phone Book

Using the Shared Phone Book function enables multiple Sony Visual
Communication Systems to access to a Phone Book located on a server.

For detailed configuration, consult your network administrator.

* You can dial a remote party registered in the Shared Phone Book in the same manner
as with the Phone Book. However, you cannot dial a remote party registered in a
multipoint connection list.
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* You cannot register a new party, delete a registered party, attach an image, or edit the
Shared Phone Book. In addition, you cannot copy the remote parties registered in the
Shared Phone Book to the Private Phone Book.

System configuration example
In this system configuration, sharing of a Phone Book using H.350 is enabled.

H.350/LDAP

Shared Phone Directory server
Book server

Using the Shared Phone Book

Check that “SPB Mode” is set to “On” in the Shared Phone Book setup menu,
and enter appropriate values for “SPB Server Address” and “SPB Server
Password”.

uonosuuo) odiseq g Jeideyn

I1IPELA
& Setup Shared Phone Book
&7 Shared Phone Book [ =Y T S
SPBServerAddress [ ]
SPB ServerPassword [

When “SPB Mode” is set to “On”, the Shared Phone Book menu button
appears on the screen.
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To display the Shared Phone Book
Select “Shared Phone Book™ in the Phone Book, and press the ENTER button.
The display switches to the Shared Phone Book.

1IPFELA
§) Phone Book

ﬁ Home. Default Group
Room 101 Rocm 102
ISDN 01-2345.6789 | | 1P 255.255.256.255

& Phone Book
&+ Detailed Dial

To restore the Phone Book, select “Phone Book™ in the menu, and press the
ENTER button.

The procedure for dialing the registered remote party in the Shared Phone
Book is the same as that for the Phone Book.

For details on dialing, see see “Calling a Remote Party Registered in the
Phone Book” on page 114.
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Adjusting the Sound

Adjusting the Volume of the Received Sound

You can adjust the volume of the sound to be received from a remote party.
Press the VOLUME + button on the Remote Commander to increase the
volume, VOLUME - button to decrease it. The volume level indicator appears
on the monitor screen. The indicator will automatically disappear if you do not
operate the buttons for a certain time.

(| ——— 1 1

* You need to set the volume of the TV monitor to an appropriate level first.
« If feedback or distortion caused by increasing the volume occurs, decrease the
volume.

Turning Off the Sound Momentarily — Muting Function

You can momentarily turn off the sound to be sent to the remote party during
communication.

Press the MIC ON/OFF button on the Remote Commander.

The sound of the local party is not heard by the remote party. The EJES]
indicator appears on the monitor screen of the local site.

The indicator appears on the monitor screen of the remote site,
indicating that the sound of the local party is not transmitted.

To restore the sound

Press the MIC ON/OFF button again.

The indicator on the local site and the indicator on the remote
site disappear and the sound is heard by the remote party.
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Turning Off the Sound on Answering — Mic on Answer Function

You can turn off the sound to be sent to a remote party when you have
answered a call from the remote party.

If you set “Mic on Answer” to “Off” in the Answer setup menu, only the
picture on the local party will be sent to the remote party when answering a
call. The indicator appears on the monitor screen.

For the setting, see “Mic on Answer” in the Answer setup menu on page 60.

To send the sound to the remote party
Press the MIC ON/OFF button on the Remote Commander.
The indicator disappears and the sound is heard by the remote party.

Synchronizing Audio and Video — Lip Sync Function

During the communication a time lag may occur between the sound and
picture to be sent to the remote party, which prevents smooth communication.
Using the Lip Sync function adjusts to synchronize audio and video. However,
this may delay transmission of audio synchronized with video.

The Lip Sync function is enabled if you set “Lip Sync” to “Auto” on the Basic
Setup1 page in the Audio setup menu.

For the setting, see “Lip Sync”in the Audio setup menu on page 72.

To enable the Lip Sync function of the remote party, you have to ask them to do so.

Reducing Echo — Echo Canceller

134

The Communication System is equipped with the echo canceller function,
allowing the echo that occurs during audio transmission to be reduced.
Setting “Echo Canceller” to “On” on the Basic Setupl page in the Audio setup
menu activates the built-in echo canceller.

When using an external echo canceller, set “Echo Canceller” to “Off”.

For details on the setting, see “Echo Canceller” in the Audio setup menu on
page 71.
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Connection example for using an external echo canceller

External microphone PCS-A1 Microphone
mixer (not supplied)

Speaker @
LINE LINEIN

i O
External echo canceller @ ; D

* The AUDIO 1 IN jack is not available on the PCS-XG55/XG55S. Use the AUDIO IN jack on the
front of the unit.

For details on connecting the external echo canceller, refer to the operating
instructions for the echo canceller you are using.
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Adjusting the Camera

You can adjust the image shot by the local camera that is sent to the remote
party to obtain the desired angle and size.

During communication you can also control the camera on the remote site to
adjust the image shot by the remote camera.

Adjusting the Camera Angle and Zoom

136

Determine the angle of view and the size of the picture to be displayed on the
monitor screen by adjusting the angle and zoom.

1 Press the CAMERA button on the Remote Commander, or press the 4, ¥,
« or # button to select “Camera” in the Home menu and press the ENTER
button.

The Camera menu appears.

IPELA 5/11/2008 13:00

2 Camera

Adjustments
Brightness
Preset

8
N}

2 Select the camera to be adjusted.
During communication pressing the F1 button on the Remote Commander
switches between the camera on the local site and that on the remote site.
When two cameras are connected, pressing the F2 button on the Remote
Commander switches between the first and second cameras.
The selected camera is shown at the top of the Camera menu.

3 Use the 4, ¥, «or » button on the Remote Commander to select
“Adjustments”, then press the ENTER button.

The Adjustments menu appears.
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IPELA

2 Adjustments > Camera Angle

Local Camera : First Camera
/ :
H\

/

Pantilt indicator Zoom indicator

4 Adjust the camera angle so that the desired angle of view is obtained with
the 4, ¥, « or » button on the Remote Commander.
The selected camera pans and tilts, then the adjusted picture will be
displayed in the small window or in full screen.

5 Use the ZOOM button on the Remote Commander to zoom in or out.
Press the T (Telephoto) button to zoom in and the W (Wide angle) button
to zoom out.

For details on digital zoom, see “To use the digital zoom function” on page
142.

To control the remote camera

* To control the remote camera, set “Far End Camera Control” (page 69) to
“On” in the Communication setup menu for both the local and remote sites.
If this setting is not configured properly, you will not be able to control the
remote camera.

* You cannot control the remote camera during a session if the remote control
format of the remote camera is not H.281. If you cannot control the remote
camera, ask the remote party about the remote control format of his camera.

* If the local and remote parties try to control the same camera at the same
time, the camera may not operate correctly.

Adjusting the Brightness

Normally, the brightness is automatically adjusted to obtain optimum levels.
You can also adjust it manually.

It is recommended that the brightness be adjusted automatically to obtain
optimum brightness.

To adjust the brightness manually

1 Press the CAMERA button on the Remote Commander, or press the 4, ¥,
< or » button to select “Camera” in the Home menu and press the ENTER
button.
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The Camera menu appears.

IPELA 5/11/2008 13.00

—

Brightness

Preset

Details

2 Select the camera to be adjusted.

During communication pressing the F1 button on the Remote Commander
switches between the camera on the local site and that on the remote site.
When two cameras are connected, pressing the F2 button on the Remote
Commander switches between the first and second cameras.

The selected camera is shown at the top of the Camera menu.

Use the 4, ¥, <« or » button on the Remote Commander to select
“Brightness”, then press the ENTER button.

The Brightness adjustment menu appears.

1IPELA 5/1112008 13:00

£ Adjustments > Brightness.

Auto Adjustment | v |

-

- ;

Press the ENTER button on the Remote Commander.

Use the 4, ¥, « or # button on the Remote Commander to select “Manual
Adjustment”, then press the ENTER button.

The brightness adjustment bar is selected.
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1IPELA 5/11/2008 1300

2 Adjustments > Brightness

Manual Adjustment | v

\
/ Previous

Brightness adjustment bar

6 Use the 4, ¥, « or # button button on the Remote Commander to adjust
the brightness of the screen.
Pressing the # button increases the brightness, and pressing the < button
decreases it.

Using the Preset Function

The settings for local or remote camera angle and zoom can be registered in
the preset memory. Once you have stored the settings, you can easily recall
them to move the camera.

Up to 100 settings can be registered for the local camera and up to 6 settings
for the remote camera.

The original position of the camera is registered in the Preset number 1 button
at the factory.

To register the preset setting

1 Press the CAMERA button on the Remote Commander, or press the 4, ¥,
< or » button to select “Camera” in the Home menu and press the ENTER
button.

The Camera menu appears.

IPELA 5/1112008 13:00

g
u Camera Previous

Brightness

Preset

F

Details

2 Select the camera whose angle and zoom setting you want to preset.
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During communication pressing the F1 button on the Remote Commander
switches between the camera on the local site and that on the remote site.
When two cameras are connected, pressing the F2 button on the Remote
Commander switches between the first and second cameras.

The selected camera is shown at the top of the Camera menu.

Use the 4, ¥, « or # button on the Remote Commander to select “Preset”,
then press the ENTER button.

The Preset Setting List appears.

IPELA

~1
£ Adjustments > Preset Setting List
Local Camera : First Camera

]
1 2 3

4 5
1/ 1

- |

4 Use the 4, ¥, « or » on the Remote Commander to select “New Entry”,

then press the ENTER button.
The Preset Save menu appears.

1IPELA

2

2 Adjustments > Preset Save

PresetNumber [1  [v]
Camera Angle
i m [ Regster in ThumbnailList

1/ 1 \

5 Use the 4, ¥, @« or # button on the Remote Commander to select “Preset

Number”, then select the number to which the setting is stored.
Only the numbers that have not been used for presetting are selectable.

Use the 4, ¥, « or # button on the Remote Commander to select
“Adjustments” under “Camera Angle”, then press the ENTER button, if
you want to adjust the camera zoom and angle.

The Adjustments menu is displayed and you can adjust the zoom and
angle.

For the adjustment procedures, see “Adjusting the Camera Angle and
Zoom” on page 136.
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7 After the adjustment is finished, press the RETURN button or the ENTER
button on the Remote Commander.
The Preset Save menu is restored.

8 When you want to register a thumbnail, use the 4, ¥, < or # button on the
Remote Commander to select “Thumbnails” and press the ENTER button
to check the checkmark for “Register in Thumbnail/List”.

9 Use the 4, ¥, <« or ® button on the Remote Commander to select “Save”,
then press the ENTER button.
The angle and zoom settings are stored in the selected number, and the
preset number is listed in the Preset Setting List.

To move the camera to the preset position

1 Press the CAMERA button on the Remote Commander, or press the 4, ¥,
« or # button to select “Camera” in the Home menu and press the ENTER
button.

The Camera menu appears.

2 Usethe 4, ¥, « or » button on the Remote Commander to select “Preset”
in the Camera menu, then press the ENTER button.

The Preset Setting List appears.

1IPFELA

2 Adjustments > Preset Setting List
Local Camera : First Camera

5 Back to Home|

-
|

o

3 Use the 4, ¥, « or # button on the Remote Commander to select the preset
number you want to recall, then press the ENTER button.
You can also recall the preset numbers 1 to 6 by pressing the number
buttons 1 to 6 on the Remote Commander.
The submenu appears.

4 Ppressthe 4, ¥, « or # button on the Remote Commander to select “Load”,
then press the ENTER button.

The camera moves to the selected preset position.

You can select the items below from the submenu:
“Cancel”: Cancels selection of the preset position.
“Edit”’: Changes the selected preset position.
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“Delete’: Deletes the selected preset position.

Adjusting the Camera in the Detailed Setup Menu

When you select “Details” in the Camera menu, the more detailed setup menu
opens. You can adjust various items for camera adjustment.

Digital Zoom
Backlight
White Balance

Focus

Focus Adj -

BrightFace

Noise Reduction Filter

To use the digital zoom function
Set “Digital Zoom” to “On”.

To use backlight compensation function

When the subject is shot with a bright background, set “Backlight” to “On”.
The backlight compensation is activated and you can obtain a bright picture.

To adjust the white balance

Set the white balance depending on the shooting location.

Auto: Adjusts the white balance automatically.

Indoor: Select when shooting the subject indoors.

Outdoor: Select when shooting the subject outdoors.

ONE PUSH: Select when adjusting the white balance by shooting a white
object in the center of the screen.

To adjust the focus automatically

Select “Auto” in the Focus drop-down list and press the ENTER button. The
focus is automatically adjusted.

To adjust the focus manually
1 Select “Manual” in the Focus drop-down list.
2 Select “Focus Adjustment” and press the ENTER button.
3 Adjust the focus using the 4, ¥, < or # button on the Remote Commander.
To focus on a distant subject, press the # button.

To focus on a near subject, press the < button.
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To use the BrightFace function

The BrightFace function is provided if the scene is shot by the PCSA-CXG80
HD Camera Unit. When the function is enabled, brightness and contrast are
automatically adjusted and as the result the dark part of a scene is shot brighter
and the bright part is shot clearer. Even when the scene is shot in a dark room
or a backlit room with a window or window shade, human faces are shot
brighter.

To use the BrightFace function, set “BrightFace” to “High”, “Medium” or
“Low”.

Set “BrightFace” to “Off” when you do not use the BrightFace function.

The BrightFace function is not available with other camera than the PCSA-CXG80.

To use the Noise Reduction Filter

If you set up Noise Reduction Filter, picture noise can be reduced. You can
select the noise reduction level from among “High”, “Medium” and “Low”. If
you do not use Noise Reduction Filter, set it to “Off”.
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Selecting the Input Picture and Sound

You can switch the picture displayed on the monitor screen, and switch
between the input picture and audio.

Switching the Displayed Picture between the Local and Remote
Pictures

When the displayed picture on the monitor can be switched during
communication, pressing the LAYOUT button on the Remote Commander
displays the indication “F1: Switches the monitored picture between the
remote and local sites.” at the bottom of the monitor.

Each press of the F1 button on the Remote Commander switches the displayed
picture between those on the local and remote sites.

Selecting the Input Picture

1 Press the VIDEO INPUT button on the Remote Commander.
The Video Input > Near menu appears.

Video Input > Near

o @0 o&)o ©ee
EIENEDY (Olsviveo ] (Olrss ] [Olveuer ]
| Save || Cancel |

2 Use the 4, ¥, « or # button on the Remote Commander to select the video
input on the local site, then press the ENTER button.
The picture input from the selected equipment is displayed on the monitor
screen.

CAMERA: Selects the picture from the camera connected to the
CAMERA connector.

S VIDEO: Selects the picture from the equipment (second camera, etc.)
connected to the S VIDEO IN connector.

RGB: Selects the picture from the equipment connected to the RGB IN
connector.

YPbPr: Selects the picture from the equipment connected to the VIDEO
IN YPbPr jacks.

The “S-VIDEOQO” setting is not available on the PCS-XG55/XG55S.
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3 To store the selected input in the memory of the system, use the 4, ¥, « or
# button on the Remote Commander to select “Save”, then press the
ENTER button.

The Video Input menu disappears.
The stored video input is not deleted even after the system is turned off, and
is selected when the power is turned on again.

To change the video input name displayed in the Video Input menu

You can label the desired name for each video input on the Custom Input Label
page in the Video setup menu. When you switch the video input in step 2
above, the name you set is displayed in the Video Input menu.

For example, you can label: Cameral, Camera2, None, etc.

For details, see“Custom Input Label” in the Video setup menu on page 75.

Selecting the Video Input Using the F1 to F4 (Function) Buttons on
the Remote Commander

If you assign the video input (Camera, S-VIDEO, RGB or YPbPr) to any of the
F1 to F4 buttons on the Remote Commander in “Function Keys in
Communication” of the General setup menu, you can quickly switch the video
input only by pressing one of the F1 to F4 buttons.

The “S-VIDEO?” setting is not available on the PCS-XG55/XG55S.

For details, see “Function Keys in Communication” in the General setup
menu on page 85.

Switching the Sound to Be Sent to the Remote Party

You can switch the sound sent to the remote party between the sound from the
microphone and that from the connected equipment. Use “Audio Input” in the
Audio setup menu.

For details, see “Audio Input” in the Audio setup menu on page 71.

Switching Video and Audio at the Same Time

Set “Link to Audio Input” to “On” on the Link to Mic page of the Video setup
menu. When you switch the video input, the audio input automatically
switches to the one which has been set to link to the switched video input.

For details, see“Link to Audio Input” in the Video setup menu on page 75.
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Switching the Picture from the Remote System

146

You can switch the picture output from the remote system during
communication.

Press the VIDEO INPUT button, then F1 button on the Remote Commander.
The Video Input > Far menu appears.

Video Input > Far

o[@=)o &= OIOJO;
G [Ofs vioeo ] [Olree. | [Ol¥eber |

|O|Sub Camera| |O|Document Camera | |O|Sub Document Camera |

| Save || Cancel |

Use the 4, ¥, « or # button on the Remote Commander to select the picture
output from the equipment connected to the remote system, then press the
ENTER button. The selected picture is input to the local system and is
displayed on the monitor screen.

You can only select the picture that can be output from the remote system.
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Switching the Picture Displayed on the
Monitor Screen

You can display the pictures on the local and remote sites on the monitor
screen at the same time. This enables you to check how your own party is
monitored on the remote site.

1 Press the LAYOUT button on the Remote Commander.
The Layout menu appears.

Layout
Screen Display Patterns

|

- =

[O]PandP | [Olside by side] [O]PinP |
|O] PinP | |O]pinP | [O]PinP | |O]PinP |
Monitor Select Mode
= ==
[©/HDmMI | [O]RGB | |[O|HDMI+RGB|
| Save || Cancel |

2 Usethe 4, ¥, « or ® button on the Remote Commander to select one of the

screen display patterns, then press the ENTER button.

You can select from among the following eight patterns:

Full: Displays the remote picture in full screen.

PandP: Displays the remote picture on the left of the screen in large size
and the local picture on the right in small size.

Side by Side: Displays the remote and local pictures side by side.

PinP: Displays the local window picture in the remote full picture.
You can select the location of the window picture from among five
patterns.

The “Monitor Select Mode” cannot be changed.

3 To store the selected screen display pattern in the memory of the system,
use the 4, ¥, @« or # button on the Remote Commander to select “Save”,
then press the ENTER button.

The Layout menu disappears.
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To swap the location of the remote and local pictures

When the displayed picture can be switched during communication, pressing
the LAYOUT button on the Remote Commander displays the indication “F1:
Switches the monitored picture between the remote and local sites.” at the
bottom of the monitor.

Each press of the F1 button on the Remote Commander swaps the location of
both pictures.

To switch the display to the remote picture while receiving RGB pictures

148

When receiving an RGB computer picture from a remote party, pressing the
LAYOUT button on the Remote Commander displays the indication “F2:
Restores the previous monitor screen.” at the bottom of the monitor. Press the
F2 button on the Remote Commander to switch to the remote picture. To return
to the RGB picture, press the F2 button again.

When you connect two monitors and set “Monitor Select Mode” to “HDMI+RGB”, you
cannot switch to RGB picture by pressing the F2 button.
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Capturing the Screen

You can capture the image displayed on the screen by using “Screen Capture”
in the Tools menu and display the captured image on the Phone Book. The
captured image is stored in the “Memory Stick”.

To capture the local image

1 Inserta “Memory Stick” in which you want to save the capturing image
into the Memory Stick slot on the Communication System.

2 Display the image you want to capture on the monitor screen.

For details on adjusting the camera, see “Adjusting the Camera” on page
136.

3 Press the TOOLS button on the Remote Commander, or press the 4, ¥, @«
or # button to select “Tools” in the Home menu and press the ENTER
button.

The Tools menu appears.

4 Ppress the » button on the Remote Commander, and select “Execute” for
“Screen Capture” with the 4, ¥, « or » button then press the ENTER

button.
1IPELA
B Tools
it Streaming [Suspended]
&% Recording [Suspended]
=1 i [Execute |
|0| Icon display
T Reject Answer
&) Screen Capture

The image displayed on the monitor is captured and stored in the “Memory
Stick”.

For the procedure how to display the captured image on the Phone Book,
see “Registering a New Remote Party” on page 122.

To capture the remote image

1 Display the image of the remote site you want to capture on the monitor
screen during communication.

For details on adjusting the remote camera, see “Adjusting the Camera”
on page 136.

Capturing the Screen 149

uonosuuo) odiseq g Jeideyn



2 Press the TOOLS button on the Remote Commander to display the Tools
menu.

3 Use the 4, ¥, <« or ® button on the Remote Commander to select “Execute”
for “Screen Capture”, then press the ENTER button.

The remote picture is captured and is stored in the “Memory Stick”.
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Chapter 4:
Connection with
Optional
Equipment

This chapter describes the various connections using the optional equipment in
addition to the components contained in the PCS-XG80/XG80S/XGS55/
XG55S HD Visual Communication System.

To make a multipoint connection, see chapter 6.

Using a Tools Menu

Pressing the TOOLS button on the Remote Commander opens the Tools menu
on the monitor screen.

The Tools menu allows you to perform operations often used simply by
selecting the item in the menu.

IPELA

8 Tools
it Streaming [Suspended]
% Recording [Suspended]
|0l Icon display
2T Reject Answer
&3 Screen Capture

Pressing the # button on the Remote Commander, selecting each item with the
4, ¥, « or # button and pressing the ENTER button enable the following
operations:

» “Presentation” is displayed only when the PCSA-DSG80 HD Data Solution software
(not supplied) is installed in the Communication System.

* “Reject Answer” is available only when the PCSA-MCG80 HD MCU software (not
supplied) is installed in the Communication System.
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Presentation

Pressing the ENTER button on the Remote Commander allows you to transmit
an RGB picture input from a connected computer to a remote party. During
transmission, the message “Executing” appears and the selectable item
changes to “Stop”. To stop transmitting the RGB picture, select “Stop” and
press the ENTER button.

For details on presentation, see “Using the Computer Picture for
Presentation” on page 154.

Streaming

Pressing the ENTER button on the Remote Commander allows you to
broadcast live stream of the visual communication, and people who do not
participate in the communication can watch it over the Web. During
broadcasting, the message “Executing” appears and the selectable menu item
changes “Stop”. To stop broadcasting a live stream, select “Stop” and press the
ENTER button.

For details, see “Streaming a Communication” on page 157.

Recording

Pressing the ENTER button on the Remote Commander allows you to save the
video and audio of the visual communication in progress in a “Memory Stick”.
While the recording is being saved, the message “Executing” appears and the
selectable menu item changes to “Stop”. Selecting “Stop” and pressing the
ENTER button stops recording.

For details on recording, see “Recording a Visual Communication” on page
159.

Annotation

Pressing the ENTER button displays the Annotation Start menu. You can
transmit the picture with letters and graphics overwritten with a commercially
available pen tablet or display a pointer on the screen (Annotation function).
While the annotation function is being executed, the message “Executing”
appears and the selectable menu item changes to “Stop”. Selecting “Stop” and
pressing the ENTER button ends annotation.

For details on annotation, see “Using the Annotation Function” on page 161.

Icon Display

Pressing the ENTER button on the Remote Commander and selecting “On”
with the 4, ¥, « or # button display the indicators on the screen. Selecting
“Off” hides the indicators.

Reject Answer (PCS-XG80/XG80S only)

Pressing the ENTER button and selecting “On” with the 4, ¥, < or # button
enables you to reject incoming calls from other terminals during
communication. Selecting “Off” results in accepting the incoming calls.
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The “Reject Answer” function is only available when the PCSA-MCG80 HD MCU
Software (not supplied) is installed.

Screen Capture
Pressing the ENTER button on the Remote Commander allows you to save the
picture displayed on the screen in a “Memory Stick” as a still image.

For details on screen capture, see “Capturing the Screen” on page 149.
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Using the Computer Picture for
Presentation

If you install the optional PCSA-DSG80 HD Data Solution software in your
system, you can transmit an RGB picture input from a computer, etc. with the
local picture simultaneously to a remote party.

You can receive a computer picture transmitted from the remote party even if the PCSA-
DSG80 HD Data Solution software is not installed.

Installing the HD Data Solution Software
1 Ensure that the Communication System is turned off.

2 Insertthe Key Module of the HD Data Solution software into the TABLET
connector (OPTION connector on the PCS-XG55/XG55S).

to TABLET (OP” =

>
on the PCS-XG55/ %
XG55S) PCSA-DSG80 HD Data Solution software

3 Press the /) (power) switch on the System to turn it on.
The PCSA-DSG80 HD Data Solution software is installed in the System.
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Connecting a Computer

to RGB IN

Connecting cable with the
D-sub 15-pin connectors
(not supplied)

to RGB OUT

Computer

Making a Presentation

To configure the presentation mode

When you transmit an RGB picture from a computer, etc. and a camera picture
simultaneously to a remote party, the remote party can view both pictures
simultaneously. This function is called “to make a presentation using the
presentation mode complying with H.239”. Using this function allows smooth
reproduction of both camera and computer pictures. To make a presentation
using the presentation mode complying with H.239, it is necessary to turn on
the presentation mode on both the local and remote systems. If the presentation
mode on either of the systems is turned off, a presentation complying with
H.239 cannot be made.

To configure the presentation mode, set “H.239” to “On” on the IP: Mode page
(page 67) or on the ISDN: Mode page (page 69) of the Communication setup
menu.

To start a presentation

1 Press the TOOLS button on the Remote Commander to open the Tools
menu.

2 Press the » button on the Remote Commander and press the 4, ¥, « or »
button to select “Execute” for “Presentation”.
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The RGB picture from the computer is transmitted to the remote party.
While presentation is being executed, the message “Executing” appears on

the screen.
1mELA
8 Tools
El 9 Presentation [Executing]
gt Streaming [Suspended]
8 Recordi [Ereoe |
7ﬁ Annotation [Suspended]
|0l Icon display
32 Reject Answer
A7 Screen Capture

You can also transmit the computer picture to the remote party by pressing the
PRESENTATION button on the Remote Commander instead of performing steps
1 and 2 above.

To change the display pattern of the presentation when the H.239 function
is disabled

Select the display pattern for the presentation with “Presentation Screen” on
the Basic Setup page of the Video setup menu (page 73) before starting a
presentation.

Full Screen: The computer picture to be transmitted from the local system is
displayed in full screen.

PandP: The computer picture to be transmitted from the local system and the
selected input picture (local camera picture, etc.) are displayed in PandP
mode.

Side by Side: The computer picture to be transmitted from the local system
and the selected input picture (local camera picture, etc.) are displayed in
Side by Side mode.

If the remote system does not support H.239, you cannot transmit the input picture
(camera picture, etc.) and the computer picture as two streams, even if “H.239” is set
to “On” on your system.

To stop the presentation

Select “Stop” for “Presentation” in the Tools menu and press the ENTER
button on the Remote Commander. Transmission of the computer picture
stops.

You can also stop the presentation by pressing the PRESENTATION button
on the Remote Commander.
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Streaming a Communication

By broadcasting a stream of a visual communication, people who cannot
attend the communication can watch the proceedings over the Web using a
computer.

Before broadcasting a live stream, be sure to configure the live stream
permission setting.

For details on viewing a streamed communication, see Chapter 7.

For details on the streaming settings, see “Streaming” on the Streaming/
Recording page of the Administrator setup menu on page 89.

Starting a streaming broadcast

1 Press the TOOLS button on the Remote Commander to open the Tools
menu.

2 Press the » button on the Remote Commander and press the 4, ¥, « or »
button to select “Execute” for “Streaming”, then press the ENTER button.
The streaming broadcast starts, and the communication in progress can be
watched from a computer over the Web.

While the streaming broadcast is running, the message “Streaming
[Executing]” is displayed in the Tools menu and the menu item changes to

« 5
Stop”.
1I2ELA
B Tools
£ Home Q i Execute
gt Streaming [Executing]
[=1 i Execute
& Annotation [Suspended]
O teon iy
2 Reject Answer
&7 Screen Capture

* If you start streaming before a communication begins, the broadcast will continue
streaming after the communication begins.

* Depending on Web access limitations, about 10 terminals can view a streaming
broadcast simultaneously. The actual number of terminals that can view the broadcast
simultaneously depends on your system’s operating environment.
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To stop a streaming broadcast

Selecting “Stop” for “Streaming” in the Tools menu and pressing the ENTER
button stop the streaming broadcast.

* Even if the Communication System is turned off while the streaming broadcast is
being executed, the streaming broadcast continues.
* The streaming broardcast cannot be executed during encrypted connection.
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Recording a Visual Communication

The video and audio of a visual communication can be saved in a “Memory
Stick” in MPEG4 format. The saved data can then be viewed on a computer.

For details on the recording settings, see “Recording” on the “Streaming/
Recording” page of the Administrator setup menu on page 89.

To start recording

1 Inserta “Memory Stick” into the Memory Stick slot.

2 Press the TOOLS button on the Remote Commander to open the Tools

3

menu.

Press the # button on the Remote Commander and press the 4, ¥, 4 or #
button to select “Execute” for “Recording”, then press the ENTER button.

The message “Start recording?” appears.

Use the 4, ¥, « or # button on the Remote Commander to select “OK?”,
then press the ENTER button.
Recording in the “Memory Stick” starts.
During recording, the message “Recording [Executing]” is displayed in the
Tools menu and the menu item changes to “Stop”.

1IPELA
B Tools

£ Home

F3 Machine Status

2 [Erecis |
= [Bxecue |
&% Recording [Executing]
o E|
|0l Icon display m
< Reject Answer
& Screen Capture

Recording a Visual Communication
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To stop recording

1 Select “Stop” for “Recording” in the Tools menu, then press the ENTER
button on the Remote Commander.
The message “Stop recording?” appears.

2 Use the 4, ¥, « or # button on the Remote Commander to select “OK”,
then press the ENTER button.

Recording in the “Memory Stick” stops.

If the remaining capacity of the “Memory Stick” is no longer enough for storage
during recording, the recording stops automatically and a notification message
appears.

Although the recorded MPEG4 files have the same file type name as the MPEG4
files that can be played on the PSP or other devices that support the “Memory
Stick” video format, you cannot play the files on these devices even after the files
are recognized and moved to the file directories of these devices.

Recording cannot be executed during encrypted connection.
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Using the Annotation Function

During communication you can transmit or receive letters and graphics written
on the screen with a pen tablet as they are written. You can also point the
camera picture or computer picture with a pointer. This function is called
“Annotation”.

The pen tablet that can be used for the annotation function is
BambooMTE450" manufactured only by Wacom Co., Ltd.

* Wacom and the Wacom logo are registered trademarks of Wacom Co., Ltd.
Bamboo is a trademark.

For details on the BambooMTE450, consult with a Sony dealer.

The communication using a pen tablet is only available for communication between the
PCS-XG80/XG80S/XG55/XGS55S Communication Systems. A pen tablet cannot be
used for communication with other Sony communication systems.

Connecting a Pen Tablet
1 Turn off the Communication System.

2 Connect the pen tablet to the TABLET connector (OPTION connector on

the PCS-XG55/XG55S) on the front panel of the Communication System.

to TABLET 2
(OPTION on the Pcs-xess/xessi)ég

Pen tablet

3 Press the /) (power) switch on the System to turn it on.

Using the Annotation Function while in Communication

To start annotation

1 Start communication.
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2

3

Press the TOOLS button on the Remote Commander to open the Tools
menu.

Press the # button on the Remote Commander and press the 4, ¥, « or &
button to select “Execute” for “Annotation”, then press the ENTER button.

IPELA

8 Tools

£ Home 2 i Execute
st Streaming [Suspended]
i Recording [Suspended]

Annotation [Executing] top
S

|0l Icon display
& Reject Answer
&9 Sereen Capture

3 Machine Status

The Annotation Start menu appears.

Use the 4, ¥, « or # button on the Remote Commander to select
“Background Screen” for executing the annotation function and press the
ENTER button.

Background Screen
[P @ Local Picture ©*[O] Remote Picture
(=0H Received Computer ot Transmitting

O Picture - Computer Picture
Annotation Mode

# [@[Dawing | & (O[Fointing ]

l Start ‘ l Cancel ‘

Remote Picture: Selects the picture on the remote site as the background

Local Picture: Selects the picture on the local site as the background

Received Computer Picture: Selects the computer picture received from
the remote site as the background

Transmitting Computer Picture: Selects the computer picture on the
local site as the background

“Received Computer Picture” can be selected only when the computer picture is
being received from the remote site.

“Transmitting Computer Picture” can be selected only when the computer picture
is being transmitted from the local site.

Use the 4, ¥, <« or » button on the Remote Commander to select
“Annotation Mode” and press the ENTER button.

Drawing: Allows you to write letters or graphics on the screen.
Pointing: Allows display of a pointer on the screen.
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6 Use the 4, ¥, « or #» button on the Remote Commander to select “Start”
and press the ENTER button.
The indicator indicating that the local party uses annotation
appears.
When the Drawing mode is selected, % (pen) indicator appears on the
monitor screen and {b (pointer) appears when the Pointing mode is
selected.

7 Write letters or graphics on the screen with a pen supplied with the pen
tablet, or move the pointer on the screen.

The written data is displayed on the screen in live.

Monitor screen

(70

For details on how to use the pen tablet, refer to the instruction manual
supplied with the pen tablet.

Operations during pointing

You can point to any desired portion on the monitor screen with a pointer. You
cannot write letters and graphics in pointing mode.

Operations during drawing

Operate using the function keys on the tablet and the buttons on the pen.
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Start Stop
«——— Eraser

./— Select Line Density
‘ ‘ o2—— Select Color

Drawing Rights Erase All

To start drawing
Press the < key on the tablet.

To stop drawing
Press the > key on the tablet.

To change the color
Press the lower pen button. Each press changes the color. You can select from
among black, red, blue, green, yellow, orange, purple and white.

To change the line density
Press the upper pen button. Each press changes the line density. You can select
from three different line densities.

To erase with the eraser
Touch the tail switch (eraser) of the pen onto the tablet and move it on the
letters or graphics you want to erase.

To erase all written letters and graphics
Press the FN2 key on the tablet.

To obtain the drawing rights

Normally, the drawing rights belong to the party who starts annotation. In the
case that the remote party starts annotation, the Obtain Drawing Rights button
appears and the indicator (Drawing executed by the remote party) on
the monitor screen on the local site.

If you want to obtain the drawing rights, press the FN1 key on the tablet. The
indicator (Drawing executed by the local party) appears on the monitor
screen, and you are allowed to write letters and graphics on the screen.

To save the drawings written using annotation

1 Inserta “Memory Stick” in which you want to save the drawings using
annotation into the Communication System.
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Press the TOOLS button on the Remote Commander to open the Tools
menu.

Select “Execute” for “Screen Capture” in the Tools menu.
The drawing using annotation on the screen is saved in the “Memory
Stick” as a still image.

To end the annotation mode

1

2

Press the TOOLS button on the Remote Commander to open the Tools
menu.

Use the 4, ¥, « or # button on the Remote Commander to select “Stop”
for “Annotation”, then press the ENTER button.

The annotation mode ends.

The letters and graphics written using the annotation function are deleted
when the communication ends.
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Using Multiple Microphones

You can input the stereo sound from two PCS-A1 (two are supplied with the
PCS-XG80 and one is supplied with the PCS-XG55) or PCSA-A3 (not
supplied) microphones to the system.

If you are using an echo canceling microphone, see “Using the PCSA-A7
Microphones (PCS-XG80/XG80S only)” on page 169.

To connect the microphones
Connect the optional microphones to the MIC (A1/A3) 1 (R) and 2 (L) jacks
on the Communication System. Power is supplied to the microphones from the
System.

3

to MIC (A1/A3) to MIC (A1/A3)
1(R) 2(L)
% Microphone (Left)

PCS-A1 (supplied with the PCS-XG80/XG55) or @

PCSA-A3 microphone (not supplied) Microphone (Right)

To use the connected microphones

Set “Audio Input” to “MIC” on the Basic Setupl page of the Audio setup
menu, and set “Input Select (MIC)” to “MIC (A1/A3)” (page 71).

To input the stereo sound from two microphones, set “Input Mode” to “Stereo”
(page 72). Set it to “Monaural” to input monaural sound from two
microphones.

Notes on installation of the microphones
* Install microphone about 50 cm (1.6 ft) away from the participants.
* Place the microphone in a quiet, echo-free location.
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* Install the speakers so that the participants do not come between it and the
microphones.

* Install microphones away from equipment that may cause noise.

* Avoid covering the microphones, with paper for example, or carrying the
microphones and moving them. If you do either, extreme noise and echo may
be heard temporarily by the remote party. In this case, wait until the echo
disappears.

* When stereo sound is input, locate the microphone connected to the MIC
(A1/A3) 1 (R) jack on the right of the camera and the microphone connected
to the MIC (A1/A3) 2 (L) jack on the left.
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Microphone layout examples

PCS-A1 microphones
PCS-A1

AD &P EP|AD

g
et

a»

o

a

PCS-XG80/XG80S/
XG55/XG558

PCSA-A3 microphones

PCSA-A3

CODCDD[@CCD

PCS-XG80/XG80S/
XG55/XG55S
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Using the PCSA-A7 Microphones
(PCS-XG80/XG80S only)

Connection of multiple PCSA-A7 microphones (not supplied) allows

communication among a large number of participants.

The PCSA-A7 microphones have the following characteristics:

* Built-in echo canceller

* Noise reduction

* High quality sound

* Several PCSA-A7 microphones can be connected in cascade without losing
sound quality.

The PCSA-A7 is a monaural microphone and cannot pick up sound in stereo.

To connect the PCSA-A7 microphones

Connect the PCSA-A7 microphones to the EC-MIC (A7) 1 and EC-MIC (A7)
2 connectors of the Communication System. Power to the microphones is
supplied by the Communication System.

to EC-MIC (A7) 1

PCSA-A7 microphones (PCSA-A7P4: 4-piece set, not supplied)
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To use the microphones

Set “Audio Input” to “MIC”, and “Input Select (MIC)” to “EC-MIC (A7)” on
the Basic Setupl page of the Audio setup menu. (page 71)

Notes on placing the PCSA-A7 microphones

* Position the microphones about 50 cm (1.6 ft) away from the participants.

* When using speakers, do not place them in front of the microphones. In
addition, avoid placing the speakers where participants may come between
it and the microphones.

Configuration using the PCSA-A7 microphones

Power is supplied to up to eight microphones connected to the Visual
Communication System or the AC adaptor, including cascade connections.
However, using the 8-meter microphone cable counts as 4 microphones.
Power is not supplied to any connected microphones that exceed this limit.
You can add more microphones, by connecting the AC adaptor to the first non-
powered microphone.

* Up to 40 PCSA-A7 microphones can be connected to one port, using a cascade
connection.
e The POWER LED turns off on a microphone with no power supply.

Setup example 1:

The 8-meter microphone cable counts as four microphones, and power is
supplied to only the first four microphones. The same is true if the 8-meter
microphone cable is used in the middle of the connections.
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Setup example 2:

Up to eight microphones are powered by the AC adaptor, counting from the
microphone connected to the AC adaptor.

Setup example 3:

_k
N
~
®
©

10

The 8-meter microphone cable is used in the middle of the connections, and
counts as four microphones. Up to four microphones are powered by the AC
adaptor, counting from the microphone connected to the AC adaptor.

Microphones layout example

A P E» v

@ PCS-XG80/XG80S
@ PCSA-A7

DO AP
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Using a Second Camera

You can connect the second camera through the PCSA-CXGS80 Camera Unit.

Connection example for a second camera

First camera (PCSA-CXG80) Second camera

© VISCA cable
/ (not supplied) -
© |\ g—— —) H [T =4
to VISCA OUT to VISCA IN

to Video
output
(YPbPr)

to VIDEO IN
YPbPr

Video cable (not supplied)
)=

Connect the video output connector on the second camera to the VIDEO IN
YPbPr jacks on the front of the Communication System or the S VIDEO IN or
RGB IN connector at the rear.

The S VIDEO IN connector is not available on the PCS-XG55/XG55S.

Select “YPbPr”, “S-VIDEO” or “RGB” in “Second Camera Input” of the
Camera setup menu depending on the connector to which the camera is
connected.

The “S-VIDEO?” setting is not available on the PCS-XG55/XG55S.

To switch the picture shot by two cameras

172

When you open the Camera menu, the instruction “F2: Switches to the first
camera.” or “F2: Switches to the second camera.” is displayed at the bottom of
the monitor screen. Each press of the F2 button on the Remote Commander
changes the picture shot by each camera.

For the procedure how to open the Camera menu, see “Adjusting the Camera”
on page 136.
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Recording during a Communication

You can record the voices of participants on both the remote and local sites
during a communication if you connect an audio recorder to the REC OUT
jack on the Communication System.

This is convenient for taking minutes of the communication.

To connect an audio recorder

Audio recording device

=55
=15

to audio
inputs

Audio cable (not supplied)

When recording with an audio recorder

When an audio recorder is connected to both the AUDIO IN and REC OUT
jacks, set “Recording Mute” to “On” on the Basic Setupl page of the Audio

setup menu, since the echo may cause and is transmitted to a remote party

(page 71).

To record the sound output from the REC OUT L/R jacks in 2-channel
monaural, set “REC OUT Mode” to “Monaural 2ch” on the Basic Setup2 page
of the Audio setup menu.

Recording during a Communication
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Sending Audio/Video from the External
Equipment to a Remote Party

The Communication System allows you to send the picture and sound output
from the connected equipment such as a VCR to a remote party.

To connect the video equipment for input
The Communication System is equipped with two video inputs.

S-video cable (not supplied) to S-video output

HH T
VCR, etc. l

\\\\y/ to S

VIDEO IN*

o E I . (sl
y Audio cable (not .
to AUDIO 1 supplied) to audio

IN* output

HD player, etc.

_% 38 %} Audio cable (not
l o supplied) -

B Video cable (not supplied)
to VIDEO IN
YPbPr (YPbPr)

* The S VIDEO IN connector and AUDIO 1 IN jack are not available on the PCS-XG55/XG55S,
and the AUDIO 2 IN jack is labeled AUDIO IN.

To input audio/video from external equipment
To input video

Press the VIDEO INPUT button on the Remote Commander to open the Video
Input >Near menu, then select the video you want to input.
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Video Input > Near

o[ @=)o o(@o @O
NG [Ofsvioeo | [Olree__]  [Olvpoer ]
| Save || Cancel |

Use the 4, ¥, <« or # button on the Remote Commander to select the external

equipment connected to each video input on the Communication System, then

press the ENTER buttton.

The picture from the selected equipment is displayed.

CAMERA: Video shot by the camera unit connected to the CAMERA
connector.

S VIDEO: Video of the camera or video equipment connected to the S VIDEO
IN connector.

RGB: Video of a computer, etc. connected to the RGB IN connector.

YPbPr: Video of the camera or video equipment connected to the VIDEO IN
YPbPr jacks.

The “S-VIDEO” setting is not available on the PCS-XG55/XG55S.

To save the selected input, press the 4, ¥, « or ® button on the Remote
Commander to select “Save”, then press the ENTER button.

To input audio

Set “Audio Input” to “AUX” or “MIC+AUX” on the Basic Setup1 page of the
Audio setup menu (page 71).

When set to “AUX?”, the sound from the external equipment is input and the
sound from a microphone is deactivated. When set to “MIC+AUX?”, both
sounds are input.

To switch to the sound from the external equipment connected to the AUDIO
1 IN or AUDIO 2 IN jacks, set “Input Select (AUX)” to “AUDIO1” or
“AUDIO2” on the Basic Setupl page of the Audio setup menu (page 71).

The AUDIO 1 IN jack is not available on the PCS-XG55/XG55S, and the AUDIO 2 IN
jack is labeled AUDIO IN.

To switch the input video and audio at the same time

Set “Link to Audio Input” to “On” on the Link to Mic page of the Video setup
menu (page 75) so as to link the audio you want to switch at the same time with
the video input.

When the video input is switched, the audio input is simultaneously switched
to the one linked to the video input.
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Viewing the Picture from the System on
a Monitor or Projector

When the monitor or projector is connected to the Communication System,
you can view the picture from the system.

To connect a monitor or projector

Monitor
7Y
)
N © f = >
to HDMI IN

to HDMI OUT
am

HDMI cable )
(supplied) Monitor,
projector, etc.

to RGB
ouT

to RGB IN
Connecting cable with D-sub 15-pin
connectors

hq:h -*@]

To use the connected display equipment

When outputting the picture both to the monitor connected to the HDMI OUT
connector and the display equipment connected to the RGB OUT connector,
set “Monitor Output” to “HDMI+RGB” on the Basic Setup page of the Video
setup menu (page 74).

For RGB output, you can select the video format of the signal output from the
RGB OUT connector with “RGB Monitor Output Format”. You can select
“SXGA”, “XGA” or “WXGA” (page 74).

* The HDMI output is available only when the output signal is of 1080i video format.

* If “Monitor Output” is set to “HDMI+RGB” when no HDMI monitor is connected to
the Communication System, you cannot view the menus. Before making this setting,
be sure to connect an HDMI monitor.
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Pictures displayed on the two monitors

During communication, the following images are displayed on the two
monitors.

Picture displayed on the first monitor

The local or remote picture shot by the camera (moving picture) is monitored
on the first monitor connected to the HDMI OUT connector.

To switch between the local and remote pictures, press the LAYOUT button,
then F1 button on the Remote Commander.

Remote camera picture

o—— Local camera picture

) I

t F1 button

I Local camera picture

—— Remote camera picture

Picture displayed on the second monitor

The picture shot by the local camera or the RGB picture transmitted from the
remote party can be displayed on the second monitor connected to the RGB
OUT connector.
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Communicating without the Picture —
Voice Meeting

The Visual Communication System enables a voice only communication using
telephones via an ISDN line. (Voice Meeting)

Basic connecting procedures are the same as those for normal communication
with audio/video.

Conducting a voice meeting with a remote party not registered in the phone
book

Set “Line I/F” to “TEL” in the Detailed Dial menu.
During the Voice Meeting, the “Voice Only” indicator is displayed.

For “Line I/F” setting, see “Calling a Remote Party Not Registered in the
Phone Book” on page 116.

To register a remote party for a Voice Meeting
Set “Line I/F” to “TEL” in the List Edit menu displayed from the Phone Book.

For registration, see “Registering a Remote Party — Phone Book” on page
122.

To set the audio compression format

Select the audio compression format by setting “Telephone Mode” of the Dial
setup menu.

When you initiate the voice meeting, set “Telephone Mode” to “Auto” (page
65). When set to “Auto”, the G.711 p-law format is automatically selected.
You need not set the audio compression format when receiving a call for a
Voice Meeting from the remote party.
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Controlling the Remote System with the
Tone Signal — DTMF Transmission

The Visual Communication System enables you to control the remote system
connected by transmitting the tone signal (DTMF: Dual Tone Multi
Frequency) assigned to the numbers for dialing (0-9, #, % ).

1 Press the TONE ( %) button on the Remote Commander during
communication.
The DTMF menu appears on the monitor screen.

2 Press one of the number buttons (0-9, #, %) on the Remote Commander
corresponding to the tone signal you want to transmit to the remote party.

The tone signal will be transmitted when the button is pressed.

3 To stop transmitting the tone signal, press the ENTER button on the
Remote Commander.
The DTMF menu disappears.

The microphone is automatically turned off while the DTMF menu is displayed.
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Accessing the Communication System

The following controls are available to access the Communication System. For
details on each control, consult your Sony dealer.

Using a Web Browser

You can control or set up the Communication System by accessing it from a
Web browser.

To access the Communication System from a Web browser, set “Web
Monitor” to “On” and “Web Access” to “Enabled” on the Access Permit page
of the Administrator setup menu (page §9).

For details on Web operation, see Chapter 7, “Web Control Function”.

Using Telnet

You can control or set up the Communication System by accessing it with
Telnet.

To access the Communication System from Telnet, set “Telnet Access” to
“Enabled” on the Access Permit page of the Administrator setup menu (page
90).
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Chapter 5:
Encrypted
Connection

When a strictly confidential communication is required, the communication
system enables a connection with encrypted video and audio. A connection
conducted using this feature is known as an encrypted connection.

This chapter describes how to conduct an encrypted connection.

The Communication System is equipped with standard encryption, which
complies with the H.233, H.234 and H.235 standerdized by the ITU-T.

 Streaming and recording are not available during an encrypted connection.
¢ The maximum bandwidth for encrypted connections is 6 Mbps.
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Preparing for an Encrypted Connection
via LAN

To start an encrypted connection, “Encryption Mode” must be set in the
Encryption setup menu.

Set “Encryption Mode” to “Connect Priority” or “Encrypt Priority” in the
Encryption setup menu.

1IPELA
& Setup Encryption

[(NSCOTICIM  Encryption Mode [ Connect Priority [ v|

Save Cancel

Connect Priority

Connects with encryption to a remote party with standard encrypted connection
enabled. Connects without encryption to parties unable to connect with
standard encryption or parties with encryption set to off.

Connect with encryption

1

Local system: Remote system:
Standard encrypted connection available Standard encrypted connection available

Connect without encryption

Local system: ) Remote system: e
Standard encrypted connection available Standard encrypted connection unavailable
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Encrypt Priority

Connects only to remote parties with standard encrypted connection enabled.

Connect with encryption

— —

an an

Local system: Remote system:
Standard encrypted connection available Standard encrypted connection available

Do not connect
Local system: Remote system:
Standard encrypted connection available Standard encrypted connection unavailable
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Starting an Encrypted Connection

You can start an encrypted connection by calling a remote party in the same

manner as a daily connection.

During an encrypted connection, the encryption icon, [£1, is displayed.

If there is no icon displayed, transmitted and received data are not encrypted. Confirm
if an icon is displayed before starting a connection.

When the encrypted connection is disabled
If the following message appears when you call a remote party, an encrypted

connection is not available.

Error Messages

Causes

The far-end system is not
compatible with the encryption
feature.

The remote system is not equipped with an
encryption feature.

The encryption feature on a far-
end system is disabled.

The encryption feature on a remote system is
turned off or the signal encryption method setting
on the remote system is different from that on the
local system.

The encryption feature on a far-
end system is enabled.

The encryption feature on a remote system is
turned on.

The conference could not start
because the encryption feature at
the near-end side was disabled.

“Encryption Mode” is set to “Off” on the local
system.

The conference could not start
because the encryption feature at
the far-end side was disabled.

The encryption feature on the remote system is
disabled.

The conference could not start
because the signal encryption
method at the near-end side
differed from that of the far-end
side.

The encryption method setting on the remote
system is not the same as that on the local
system.
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Error Messages Causes

The standard encryption You are connected to the remote system via SIP
videoconference with SIP connection.
connection is not available.
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Chapter 6:
Multipoint
Connection

186

This chapter describes how to connect your system to multiple points.

For multipoint connection, installation of the optional PCSA-MCGS80 HD
MCU software is required.

When connecting via a LAN, multipoint connection among up to 10 points
including your site is available. When connecting via an ISDN, multipoint
connection among up to six points including your site is available, and a phone
can be used at up to five points among six.

A multipoint connection using LAN and ISDN mixed is also available.

Restrictions on the use of the MCU software

* When a multipoint connection is made via LAN, you can set up the total
communication bit rate for all the connecting points with “Total Bandwidth”
in the Communication setup menu. As the communication bit rate for each
point is automatically adjusted so as not to exceed the value selected in
“Total Bandwidth”, actual bit rate per point may differ from that selected for
that point.

* When a multipoint connection is made via an ISDN, the same number of

channels should be used on all the points and the total channels must not

exceed 12B.

The H.264, H.263+ and H.261 video modes are supported.

The G.711, G.722, G.728 and MPEG4 AAC audio modes are supported.

* A multipoint connection including a SIP connection is not available.

Only the PCS-XG80/XG80S is enabled for use as a main terminal for the

cascade connection.

When the local system is used as the main terminal and connected with

remote terminals other than the PCS-XG80/XG80S/XG55/XGS55S, the

maximum bandwidth to be used is restricted to 4 Mbps.

» The HD MCU software cannot be installed on the PCS-XG55/XG55S.



Connection Examples of a Multipoint
Connection

Using the LAN Connection (Up to Six Points)

Installing the optional PCSA-MCG80 HD MCU software in an HD Visual
Communication System allows you to connect multiple points up to six.

If you have already made a point-to-point connection when a third point calls,

the system automatically starts multipoint connection.

PCSA-MCG80 HD
MCU software

to =1 or =2

(100BASE-TX/

10BASE-T)

to LAN
-7 )
UTP cable (category 5, straight) T
(not supplied)
LAN

For a multipoint connection only the Communication System with the PCSA-MCG80
HD MCU software installed can be used as main terminal. If you want to use multiple
Communication Systems as main terminals depending on the type of connection, the

same number of HD MCU software as that of main terminals is required to install.

Connection Examples of a Multipoint Connection
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Using the Cascade Connection via LAN (Up to 10 Points)

Installing the optional PCSA-MCG80 HD MCU software in two HD Visual
Communication Systems enables cascade connection with two main terminals,
allowing you to make a multipoint connection among up to ten points by
connecting four to each main terminal.

LAN

————= e
PCSA-MCG80 HD PCSA-MCG80 HD %
MCU software MCU software

LAN LAN

* Even if the PCSA-MCG80 HD MCU software is installed in three or more
Communication Systems, cascade connection is not available.

* For cascade connection, “Broadcast Mode” can be set to “Voice Activate” mode only
during communication. The “Split” and “Split (fixed)” modes are not available.

* Only the PCS-XG80/XG80S is enabled for use as a main terminal on the remote site.
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Using the ISDN Connection

Installing the optional PCSA-MCG80 HD MCU software in an HD Visual
Communication System allows you to connect to multiple systems up to six by
using the optional PCSA-B768S, or up to four by using the optional PCSA-
B384S ISDN Unit.

The illustration shows an example using the
PCSA-B768S ISDN Unit.

PCSA-B384 or PCSA-
w B768S ISDN Unit

==

PGSA-MCGE0 HD
MCU software I'.;fl I‘.;I ? ? If;:l L;fl

i to ISDN1 to 6
G

to ISDN lines ISDN modular cables
(not supplied)

B 1 ] B i i |
T T T T T

Notes on the number of ISDN lines used and number of remote
parties for a multipoint connection

You can select the number of ISDN channels to be used for the remote point
connected first using “ISDN Bandwidth” on the ISDN: Mode page of the
Communication setup menu (page 69).

However, if the number of remote points connected increases as a result of
dialing from the main terminal, some of the channels used for the first point
will be cut off and used for newly connected points instead. For example,

if you use six ISDN lines (up to 12B channels available), 12B channels will be
used for the first remote point only when no other points are connected. When
the system connects to a second point, the number of channels for the first
point decreases, and 6B channels will be used for both the first and second
points.

Even if one of the remote points in a multipoint connection is disconnected, the
number of channels used for the remaining points will not increase.
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When you are called from a remote party and the remote party has set up alower number
of ISDN channels than that in your terminal, the setting on the remote party’s terminal
has priority.

To connect with a normal phone

When you are using an ISDN connection, a normal phone can be connected at
up to five points.

Only the 1B (64K) connection is available for a normal phone.

* When using the ISDN connection, installing the PCSA-MCG80 HD MCU software
in two or more Communication Systems does not allow cascade connection.

» For multipoint connection, only the Communication System with the PCSA-MCG80
HD MCU software installed can be used as main terminal. If you want to use two or
more Communication Systems as main terminals depending on the type of
connection, the same number of HD MCU software installations as that of main
terminals is required.

Using Both LAN and ISDN

Installing the PCSA-MCG80 HD MCU software in one HD Visual
Communication System enables a multipoint connection with the terminals
connected via a LAN and ISDN.

The illustration shows an example
using the PCSA-B768S ISDN Unit.

PCSA-B384S or PCSA-
B768S ISDN Unit

(100BASE-TX/
10BASE-T)

o [ ] (S [

to a1 or &5 2 1
fl t
to ISDN1 to 6

UTP cable (category 5, ISDN modular cables
straight) (not supplied) (not supplied)

to ISDN lines +
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The connection example described above includes four terminals via a LAN connection
and one terminal via an ISDN connection. The number of the systems for LAN and
those for ISDN connections is not fixed.

Using the LAN Cascade and ISDN Connection

Installing the PCSA-MCGS80 HD MCU software in two HD Visual
Communication System enables cascade connection including two main
terminals. Connecting four terminals to one main terminal allows you to make
a multipoint connection via a LAN and ISDN with up to ten points.

LAN

= ==
PCSA-MCG80 %
HD MCU software

* Be sure to use LAN connection between two Communication Systems connected with
cascade. Cascade connection via an ISDN is not available.

* For cascade connection, “Broadcast Mode” can be set to “Voice Activate” mode only
during communication. The “Split” and “Split (fixed)” modes are not available.

* Only the PCS-XG80/XG80S is enabled for use as a main terminal on the remote site.
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Installing the MCU Software

1 Turn off the power of the Communication System.

2 Insert the Key Module of the PCSA-MCG80 HD MCU software into the
TABLET connector.

PCSA-MCG80 HD MCU software

3 Press the /) (power) switch on the System to turn it on.
The PCSA-MCGS80 HD MCU software is installed in the System.

Confirming that the Installation of the Software is Complete

The installed software is indicated in “Software Option” under the Machine
Information page of the Machine Status menu.

1ITELA
[@ Machine Status > Machine Information

Machine Inforr Host Version 2.00
Software Option Multipoint
Option I/F None
Host Name peshost
IP Address 0:0:0: 0:0:0
IP Address(LAN2) 0:0:0: 0:0:0
MAC Address 00-1A-80-78-6F-C8
MAC Address(LAN2)  00-1A-80-78-6F-C9
Serial Number 4294967295

Previous Cancel

For details, see “Machine Information” on page 95.
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Configuring Multipoint

Setting Up Multipoint

1 Open the Multipoint setup menu, set “Multipoint Mode” to “AUTO”, and
make the necessarysettings.

1ImELA
& Setup Multipoint

IELITTE0  Multipoint Mode AUTO [~]

Mode Spiit ~

split

Gance

For details on “Broadcast Mode” and “Split”, see “Using the Display
Control” on page 202.

2 Open the Communication setup menu and make the necessary settings.

I=ELA
= Setup Communication 1P
LT o] IndividulStings orTansissionecepion (T
i il [ OFF <

For details, see “Communication Setup Menu” on page 67.

Registering the Remote Parties in the Multipoint Connection List

You can register a multipoint connection list that includes all remote parties for
a multipoint connection in the Phone Book. It allows you to dial all the parties
simultaneously.

You can enter new remote parties to register in the multipoint connection list
or add the parties registered in the Phone Book to the multipoint connection
list.
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To register a multipoint connection list in the Phone Book

The basic procedure for registration is the same as when registering a remote
party for a point-to-point connection. For details on the procedure, see
“Registering a New Remote Party” on page 122.

1 Select “New Entry” in the Phone Book to display the List Edit menu, then
enter the name of the multipoint connection list in the Index text box.

IPELA
2 Phone Book

Group Select None Specified |+

Dialto: [P [v] ]  OneTouch Dial Specified
Number of Connected Stes [T [+]
Line UF
Communication Bit Rate

Number of Lines ~ 28(128K)

2 Select “Number of Connected Sites” and select the number of sites to
which you want to connect.
The “Dial to:” text boxes that correspond to the selected numbers of sites
are displayed.

1IPELA
2 Phone Book

Group Select None Specified |+

Dialto: [P_[v] |  OneTouchDial Specified [None Specified [ v
T L e L
Dialto: [P [v] ] newr

Communication Bit Rate [ 1024Kbps ~

Number of Lines ~ 28(128K)

Gancel

3 Select the line interface icon or a still image to be displayed in the Phone
Book.

You can select “2%” as an icon for a multipoint connection list.

4 set up the line interface of the remote parties you want to register in a

multipoint connection list in the “Dial to:” text boxes.

Select the line interface from the drop-down list on the left, and enter the

number of a remote party in the text box.

For LAN connection: Select “IP” from the drop-down list (when using the
@& 1 connector), and enter the IP address.

For ISDN connection: Select “ISDN” from the drop-down list, and enter
the line number.

For ISDN (Telephone) connection: Select “TEL” from the drop-down
list, and enter the telephone number. (ex. : 0390123456).
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Enter all the parties to which you want to make a multipoint connection.

IPELA

B Phone Book
st . R
Group Select [ None Spocified [~ |
Dialto: [IP_[v[ 123.123.123.1 ]  One-Touch Dia Secifed [None Specified | v
Dialto: [IP_[v] 1231231232 |  Number w3 [
Dialto: [IP_[v[ 1231231233 |  LineUF

Communication Bit Rate [ 1024Kbps ]

Number of Lines ~ 28(128K)

5 set up other items.

For details on the setup, see step 3 in “Registering a New Remote Party”
on page 123.

6 Select “Save”, then press the ENTER button on the Remote Commander.
Registration of the multipoint connection list is completed.

To specify a remote party registered in the Phone Book to the multipoint
connection list

1 Usethe 4, ¥, « or » button on the Remote Commander to select the name
you want to register in the multipoint connection list.

2 Press the % button on the Remote Commander. Or press the ENTER
button on the Remote Commander to display the submenu, press the 4, ¥,
« or % button to select “& On”, then press the ENTER button.

IPELA
2 Phone Book

Default Group
L&

Room 101
1SDN 0123456789

Cancel
0
Connect
Edit
Copy
Delete

The 2 (multipoint) mark is added to the lower right of the selected list,
and the remote party is registered in the multipoint connection list.
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You can add the = marks to up to five parties using the same procedure as
above. The & marks that correspond to the number of the parties you have
registered appear as dark marks on the upper right of the Phone Book.
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Number of specified points

IPELA
B Phone Book Ex=] =
Default Group Py ® . o o
2 || Ras

Room 101 Room 102 Office A
ISDN 0123456789 | | 1P255.256.255.255 | | ISDN 98-7654
* * | 3 I

Multipoint mark

To delete the 2 mark from the name list, press the % button on the Remote
Commander again, or press the ENTER button on the Remote Commander to
display the submenu, press the 4, ¥, 4 or # button to select “=& Off”, then press
the ENTER button.

3 Select one of the remote parties with the %& mark, then press the ENTER
button.

4 pressthe 4, ¥, «or» button to select “ Edit” from the submenu, then press
the ENTER button.
The List Edit menu appears. All the IP addresses or telephone numbers of
the parties marked with %& are entered in the number text boxes.

1IPELA
¥ Phone Book

Group Select None Specified |+

Dial to: 01-2345-6789 One-Touch Dial Specified | None Specified [ v

Dialto: [P |v| 255.255.255.255 |  Number 3 =
Dial to: Line VF

Communication Bit Rate [ 1024Kbps -
Number of Lines [ 28(128K) -

5 Enter the name of the multipoint connection list in the Index text box.

6 Select “Save”, then press the ENTER button.
The registration of the multipoint connection list is completed.
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Starting a Multipoint Connection

Calling Remote Parties

To call remote parties registered in the multipoint connection lists
1 Select the multipoint connection list registered in the Phone Book.
2 Press the CONNECT (%) button on the Remote Commander, or press the

ENTER button on the Remote Commander to display the submenu, press
the 4, ¥, « or # button to select “Connect”, then press the ENTER button.

1IPELA
#F Phone Book

Default Group
& Mulipoint

Room 101
1SDN 0123456789

Cancel
#on

Edit
Copy
Delete

The system begins dialing the remote parties registered in the multipoint
connection list. “Dialing” appears on the monitor screen. When the system
connects to all the remote points, the message “Session Connected.”
appears on the screen, and the pictures of the remote parties are displayed
on the screen.

To call remote parties by selecting from the Phone Book

1 Select aremote party to which you want to connect for a multipoint
connection from the Phone Book.

2 Pressthe % button on the Remote Commander, or press the ENTER button

on the Remote Commander to display the submenu, press the 4, ¥, «or #
button to select “=& On”, then press the ENTER button.
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IPELA
# Phone Book

Default Group
| & ]

Room 101
ISDN 01-2345:6789

Cancel
0
Connect
Edit
Copy
Delete

The %i (multipoint) mark is added to the lower right of the selected name
in the Phone Book list and the remote party is specified to the party for the
multipoint connection.

You can add the 2& marks for up to five parties using the same procedure
as above. The =i marks that correspond to the number of the parties you
have selected appear as dark marks on the upper right of the Phone Book.

Number of specified points

1IPELA
R Phone Book |* x & |=.' *
e o
_-_ﬂ
—
fiice A
DN 08-765¢

Default Group
Room 101 Room 102 o
ISDN 0128456789 | | 1P 265255255255 | | ISt
* * | I

Multipoint mark

To delete the =& mark from the name list, press the % button on the Remote
Commander again, or press the ENTER button to display the submenu, press the 4,
¥, «or # button to select “ 2 Off”, then press the ENTER button.

Select one of the remote parties with the i mark.

Press the CONNECT ( 4@ ) button on the Remote Commander, or press the
ENTER button on the Remote Commander to display the submenu, press
the 4, ¥, « or # button to select “Connect”, then press the ENTER button.
The system begins dialing the remote parties with the %& marks. “Dialing”
appears on the monitor screen.

When the system connects to all the remote points, the message “Session

Connected.” appears on the screen, and the pictures of the remote parties

are displayed on the screen.
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To call remote parties not registered in the Phone Book

Basic operations are the same as those for a point-to-point connection.

For details, see “Calling a Remote Party Not Registered in the Phone Book”
on page 116.

1 Select “Detailed Dial” in the Home menu or press the CONNECT (&)
button on the Remote Commander to open the Detailed Dial menu.

2 Select “Number of Connected Sites” and select the number of the points to
which you want to connect.

The “Dial to:” text boxes that correspond to the selected number of points

appear.
1IPELA
G+ Detailed Dial
ﬁ Home Dialto: [IP_ [+] ] E
piaito: [P [~] ] Linewr P
Dial to: [P [v [avbps ||
Number of Lines| 1B(64K) | v|

3 Sset up the line interface of the remote parties in the “Dial to:” text boxes.
Select the line interface from the drop-down list on the left, and enter the
number of a remote party in the text box.

For LAN connection: Select “IP” from the drop-down list (when using the
@31 connector), and enter the IP address.

For ISDN connection: Select “ISDN” from the drop-down list, and enter
the line number.

For ISDN (Telephone) connection: Select “TEL” from the drop-down
list, and enter the telephone number (ex. : 0390123456).

Enter all the parties with which you want to make a multipoint connection.

IPELA
&+ Detailed Dial
£ Home ‘ Dialto: [P [v][123.123.1231 | NumberoiComecedSies[3 | v |
Dialto: [IP__[+][123.123.123.2 Line UF P
Dialto: [IP_[+][123.123.1233 ] ingi e 2Wops ]
Number of Lines[ 1B(64K) | v|

For details on the setup, see “Calling a Remote Party Not Registered in the
Phone Book” on page 116.
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4 select “Connect”, and press the ENTER button on the Remote
Commander, or press the CONNECT ( 4 ) button on the Remote
Commander.

The system begins dialing the remote parties selected in step 3. “Dialing”
appears on the monitor screen.

When the system connects to all the remote points, the message “Session
Connected.” appears on the screen, and the pictures of the remote parties
are displayed on the screen.

To call additional remote parties

After starting communication with the first party, press the CONNECT ( &)
button on the Remote Commander to display the menu.

| Enter Number/Address |

| Select from Phone Book |

| Select from History |

Call the second remote party by using one of the procedures described in
“Starting a Connection by Calling a Remote Party” on page 108 depending on
the registration status of the party. When you press the CONNECT (&)
button on the Remote Commander after the communication starts with the
second remote party, the above menu opens again and you can call the next

party.

* When “Direct Dial” or “One-Touch Dial” is set to “On” in the Home Menu setup
menu, selecting “Previous” from the above menu displays the necessary items for
direct dialing or the one-touch dial buttons on the monitor screen.

* The Phone Book opens when you press the # button during communication. It is
convenient for calling a remote party registered in the Phone Book.

If some points are not connected

200

The following dialog appears. Only the connected points are shown as dark
circles. Select the desired item.
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Some positions were not connected.

@ @ O O ©O

l Disconnect All l l Redial l

Start Meeting: Starts communication with remote parties connected.
Disconnect All: Cancels all the connections and restores the Home menu.
Redial: Redials the numbers of the points that you failed to connect.

Note on multipoint videoconferences using ISDN

If the number of remote points connected increases as a result of dialing from
the main terminal while making a multipoint connection using ISDN, some of
the channels that have been used for connection will be cut off and used for the
newly connected points instead. For example, if you use six ISDN lines (up to
12B channels available), 12B channels will be used for the first remote point
only when no other points are connected. When the system connects to a
second point, the number of channels for the first point decreases, and 6B
channels will be used for both the first and second points.

Even if one of the remote points in a multipoint connection is disconnected, the
number of channels used for the remaining points will not increase.

Receiving a Call from a Remote Party

Operations are the same as those for a point-to-point connection.

For details, see “Receiving a Call from a Remote Party” on page 119.
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Using the Display Control

During a multipoint connection you can control the following operations.

Broadcast Mode

There are four broadcast modes, “Split” and “Voice Activate”, and “Split
(fixed)” and the broadcast select mode.

You can set up “Split” and “Voice Activate” modes in “Broadcast Mode” of
the Multipoint setup menu.

You can select “Split (fixed)” and broadcast select modes in the Layout menu
during communication.

Split mode

This mode allows display of the pictures of the connected remote terminals and
the picture of the local terminal by splitting the monitor screen.

You can select “Six-screen Mosaic” or “Automatic” in “Split” of the
Multipoint setup menu. When “Six-screen Mosaic” is selected, the display is
split into six regardless of the number of terminals. When “Automatic” is
selected, the display is automatically split into four if two or three terminals are
connected or into six when four or five terminals are connected.

The split windows A to C or A to E display the pictures of the remote terminals
in the connected sequence.

Four-split window Six-split window

Picture A Picture B Picture A Picture B Picture C

| | |

l l

ﬁ
Picture D —— '@

Picture E —— \ﬁ;

1

Picture C Picture on the Picture on the
local terminal local terminal

* When the six-split window is displayed, the system detects the terminal including the
loudest voice among all the terminals and displays the picture of that terminal in the
lower right window. The picture on the local terminal is then displayed in the window
where the picture of the detected terminal was displayed.
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If you switch the broadcast mode from “Split” to “Voice Activate” in which the
picture of a specified terminal is displayed in full screen during communication, the
location of Pictures A to E will be changed when “Split” mode is restored.

When there is one terminal, the picture is displayed in full screen regardless of the
setting.

When the six-split window with a terminal specified is displayed, the picture from the
specified terminal is always displayed in the lower-right window.

When “Split” mode is selected, you cannot control the camera on any connected
remote terminals.

Voice Activate mode

This mode allows you to detect the terminal with the loudest voice among the
connected terminals and to display the picture of that terminal in full screen on
all other terminals. The “[%A_]” indicator appears when “Voice Activate”
mode is activated. The indicator with an alphabetic letter (ex. : f&1) indicating
the terminal of the displayed picture also appears. The & indicator is
displayed on the monitor screen while the local picture is broadcast.

To transmit pictures with resolution of 720p (1280 x 720 pixels) in H.264 Video Mode
when “Voice Activate” is activated, select “Voice Activate (720P)” in “Broadcast
Mode” of the Multipoint setup menu. However, the “Voice Activate (720P)” mode
cannot be selected when the communication is made via an ISDN or SIP connection.
Even for an IP connection, this mode is not available if the remote party does not
support H.264 Video Mode.

Fixed split mode

The pictures from the connected remote terminals and the picture of the local
terminal are displayed in split windows on the monitor screen as the same
manner as those in “Split” mode.

You can specify a picture among the split windows to fix it in the lower right
window for the six-split mode. Pictures other than the specified one are
displayed in the split windows in the connected sequence.

Six-split window
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The picture of the specified terminal is
always displayed in this window.

Broadcast select mode
You can specify a terminal to display the picture of that terminal in full screen
on all other terminals. The indicator with an alphabetic letter (ex. [&l)
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indicating the terminal of the displayed picture also appears. The & indicator
is displayed on the monitor screen while the local picture is broadcast.

Broadcast Modes and Displayed Windows

The chart described below shows the window displayed on the monitor screen
when you select one of the broadcast modes. According to the connection
status of your system, some modes cannot be selected. You cannot select the
broadcast mode if your connection status corresponds to that with no display
window in the chart below.

Connection status Non-cascade connection Cascade connection
LAN connection LAN cascade connection
(page 187) (page 188)
ISDN connection LAN cascade & ISDN
(page 189) connection
LAN & ISDN connection | (page 191)
(page 191)

Connecting points (max.) 6 10

Automatic |2 or 3 Four-split window -
terminals

a
connected \ ﬁ%L
Bl 4
(]

I

4or5 Six-split window -
terminals

connected ngM

|

Ldb | 1V

<D

Broadcast mode

Six-screen Mosaic Six-screen mosaic -

| % |
A
L ath

Before communication
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Connection status

Non-cascade connection

Cascade connection

Split
(fixed)

20r3
terminals
connected

dorb
terminals
connected

Six-split window

o |

7

o
(

| % |
A
Lah

/

Broadcast mode
During communication

Voice Activate

Full screen

Full screen

Broadcast Select

Full screen

5

ol

Only the “Voice Activate” mode is supported during cascade connections.

Using the Display Control
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Switching the Broadcast Mode

206

At the beginning of the connection, the broadcast mode set in “Broadcast
Mode” and “Split” of the Multipoint setup menu is applied. You can change
the mode during communication using the Layout menu.

If “Broadcast Mode” of the Multipoint setup menu is set to “Voice Activate (720P)”,
you cannot switch “Broadcast Mode” during communication as the “Broadcast Mode”
does not appear in the Layout menu. Set “Broadcast Mode” before starting
communication.

1 Press the LAYOUT button on the Remote Commander.
The Layout menu appears.

2 Use the 4, ¥, « or #» button on the Remote Commander to select the mode
to which you want to switch from “Broadcast Mode”, then press the
ENTER button.

Layout

Screen Display Patterns

|

.

[O]PandP | [Oside by Side| [O[PinP |
|O] PinP | [O]PinP | [O]PinP | [O]PinP |
Monitor Select Mode
=] = fi=-
[©[HDMI | [O]|RGB | |O]HDMI+RGB]|
Broadcast Mode
| Save | | Cancel |

Split: Selects the Split mode.

Split (A fixed): Fixes the picture of the terminal connected first in the
specified window of the fixed split mode.

Split (B fixed): Fixes the picture of the terminal connected second in the
specified window of the fixed split mode.

Split (C fixed): Fixes the picture of the terminal connected third in the
specified window of the fixed split mode.

Split (D fixed): Fixes the picture of the terminal connected fourth in the
specified window of the fixed split mode.
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Split (E fixed): Fixes the picture of the terminal connected fifth in the
specified window of the fixed split mode.

Split (Near End Fixed): Fixes the local picture in the specified window of the
fixed split mode.

Voice Activate: Selects “Voice Activate” mode.

Self Broadcast: Broadcasts the local picture in broadcast select mode.

A Broadcast: Broadcasts the picture of the terminal connected first in
broadcast select mode.

B Broadcast: Broadcasts the picture of the terminal connected second in
broadcast select mode.

C Broadcast: Broadcasts the picture of the terminal connected third in
broadcast select mode.

D Broadcast: Broadcasts the picture of the terminal connected fourth in
broadcast select mode.

E Broadcast: Broadcasts the picture of the terminal connected fifth in
broadcast select mode

To display the local picture in “Voice Activate” mode
You can display the local picture only on your monitor screen even if “Voice
Activate” mode is activated. All other terminals remain in “Voice Activate”
mode.

1 Press the LAYOUT button on the Remote Commander to display the
Layout menu.
The instruction “F1: Switches the monitored picture between the remote
and local sites.” appears in the lower part of the screen.

2 Press the F1 button on the Remote Commander.
The local picture appears on your monitor screen.

To restore “Voice Activate” mode on the local site
Press the F1 button on the Remote Commander again.

Receiving the Broadcast Requested From Another Terminal

When you receive the “Self Broadcast” command from one of the terminals
connected, the picture of that terminal is broadcast in full screen.

When you receive the “Stop Broadcast” command from one of the terminals
connected, the system returns to the previous mode.

If you have received the “Self Broadcast” command from another terminal, the
operation above will not be carried out.
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Ending the Multipoint Connection

208

1 Press the CONNECT (<) button on the Remote Commander.

The following menu appears:

l Disconnect A ] l Disconnect B ] l Disconnect C

Disconnect All

The alphabetic letters A to E (or A to C) indicate the connected sequence
of terminals.

The terminal names are displayed in the menu if you set “Display Terminal
Name” to “Show temporarily” or “Always show” on the Menu Screens
page in the General setup menu.

Use the 4, ¥, « or # button on the Remote Commander to select the
terminal to be disconnected, then press the ENTER button.
Disconnect A: Disconnects the terminal connected first.
Disconnect B: Disconnects the terminal connected second.
Disconnect C: Disconnects the terminal connected third.
Disconnect D: Disconnects the terminal connected fourth.
Disconnect E: Disconnects the terminal connected fifth.
Disconnect All: Disconnects all the terminals.

The selected terminal is disconnected.
You can also disconnect all the terminals by pressing the DISCONNECT
('@ ) button on the Remote Commander.

To cancel the disconnection

Select “Cancel” in step 2, then press the ENTER button on the Remote
Commander.

Ending the Multipoint Connection



Notes on Secondary
Terminals

If there is a terminal that is not adequate for

the settings set by this system, that terminal

is called a secondary terminal.

Communication capabilities between

secondary terminal and this system are

shown below.

* Transmitting/receiving audio

¢ Receiving video from a secondary
terminal

* Disables transmission of video to a
secondary terminal

For details on secondary terminals, see
“Glossary” on page 252.

When a normal phone is connected
The audio mode of the Visual
Communication Systems is not affected if a
normal phone is connected or disconnected
at any time.

When a 56K network is mixed among
the terminals if the connection is
made via a 64K network

The connection automatically changes to
that via the 56 K network. Terminals that
cannot change to that network are regarded
as secondary terminals, and the transmission
of video is not available, although
transmission/reception of audio and
reception of video are available.

When a terminal with different audio
mode is connected and its video bit
rate is different

The connection is made in the audio mode of
the terminal with the lowest video bit rate.
Any terminal that cannot conform to the
audio mode is regarded as a secondary
terminal, and the transmission of video is not
available, although transmission/reception
of audio and reception of video are
available.

Notes on Secondary Terminals
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Multipoint Attributes

Number | Attribute Value (H.320 MCU) Value (H.323 MCU)
1 Maximum number of terminals |5 (6 when including the |5 (6 when including the
that can be connected to a single | local terminal) local terminal)
MCU
2 Maximum number of 1 1
concurrent (independent)
connections that can be
supported in a single MCU
3 Maximum number of ports that |0 1
can be connected to other
MCUs
4.1 Network interfaces at each port | BRI LAN
42 Restricted network capability Restrict_Required -
5 Transmission rates available at | 1B, 2B, 4B, 6B (BRI) Restricted on maximum
each port value of total bit rate of
all points
6 Audio Processor Equipped Equipped
6.1 Mixed/switched Mixed Mixed
Noise/echo suppression on No No
“silent” ports
6.2 Audio algorithm at each port G.711, G.728, G.722, G.711, G.728, G.722,
MPEG4 AAC (monaural | MPEG4 AAC (monaural
only) only)
7 Video Processor (motion Equipped Equipped
pictures)
7.1 Switched/mixed Voice activated/four- Voice activated/four-
split/six-split/user control | split/six-split/user control
7.2 Video algorithm at each port H.261, H.263, H.264 H.261, H.263, H.264
8 Data Processor Equipped Equipped
8.1 Data broadcast facility, LSD Equipped -
Data broadcast facility, HSD No -
8.2 MLP Processor Equipped -
9 Encryption Support Support
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Number | Attribute Value (H.320 MCU) Value (H.323 MCU)
10 Method of choosing Selected Custom: Custom:
Communication Mode - SCM Number of lines (1B/ | LAN bandwidth
2B/4B/6B) (Restricted on maximum
Audio algorithm value of total bit rate of
(G711, G.728, G.722, | all points)
MPEG4 AAC) Audio algorithm
Auto: (G.711, G.728, G.722,
Video frame rate (7.5/ MPEG4 AAC)
10/15/30fps) Auto:
Video encoding mode Video frame rate (7.5/
(CIF/QCIF) 10/15/30fps)
Fixed or switched Video encoding mode
automatically: (CIF/QCIF)
Video algorithm Fixed or switched
(H.261 fixed, H.261, |automatically:
H.263 or H.264 Video algorithm
switched (H.261 fixed, H.261,
automatically) H.263 or H.264
Restrict (56K fixed/ switched
Auto) automatically)
11 Capability of secondary Capable of audio Capable of audio
terminals transmitting/receiving transmitting/receiving
and video receiving only. |and video receiving only.
Capable of audio Capable of audio
transmitting/receiving transmitting/receiving
only via a normal phone. |only via a normal phone.
12 Call setup provision(s) No call/receive No call/receive
reservation reservation
13 Control capabilities - -
13.1 Numbering of terminals No Equipped e
Simple chair control using BAS | No No —_—
13.2 MLP facilities (T.120) No No
(@]
13.3 H.224 (simplex data) Equipped Equipped 3
°
14 Cascading No Equipped @
14.1 Fixed rates (“simple”) No No ;
14.2 Master/Slave No Equipped s
°
15 Terminal identification No Equipped %.
16 MBE capability No - 5
S
=}
®
Q
=
=}

Multipoint Attributes
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Chapter 7:
Web Control
Function

212

This chapter describes the Web Control Functions used when operating the
PCS-XG80/XG80S/XG55/XG55S. The Web Control Function helps you
control the PCS-XG80/XG80S/XG55/XG55S, or change its setup
configuration, using a Web browser installed on your PC, such as Internet
Explorer.

Internet Explorer is a product of the Microsoft Corporation. Please use Version
5.0, or above (Version 6.0 recommended).



Opening the Web Page

Enter the IP address assigned to the PCS-XG80/XG80S/XG55/XG55S in the
address line of your browser.

The format of an address is:

http:// XXX XXX XXX XXX/

For instance, if the IP address is “192.47.100.117”, enter “http://
192.47.100.117/” in the address line.

When a proxy server in an external network segment has been set, the Gateway address
in the PCS-XG80/XG80S/XG55/XGS55S LAN setup must also be set. Or set your Web
browser proxy setting to “No Proxy” for the PCS-XG80/XG80S/XG55/XG55S.

Opening the Web Page 213
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Identifying a User

214

Once you reach the Web page, the following window will be displayed asking
you to identify yourself as the user.

Connect 1o 000 XXK. XXX

=

W,

Pleaze Enter Your Password

User Name |ﬂ | v|

Password: | |

[CTRemember my password

[ 0K ] [ Cancel ]

Enter one of the following user names (see below) into the “User Name” box
and the corresponding password into the “Password” box, then click the [OK]
button.

Each character of a password is shown as “x” on the screen.

When the user name and password are correct, the “Home” menu will come
up.

If an incorrect user name or password is entered, you are asked to enter it again.
When the incorrect entries are made three times, an error message appears on
the screen.

You can select a user name from the following and enter the password for the
selected user name.

[remote]

Enter the Remote Access Password set in the Administrator setup menu. You
can access and check the “Phonebook™ and “Setup” pages.

[address]

Enter the Phone Book Modification Password set in the Administrator setup
menu. You can access the “Phonebook” page, change the setting of the page,
and register a new entry onto the page. And you can check the “Setup” pages.

[sonypcs]

Enter the Administrator Password set in the Administrator setup menu. You
can access the “Phonebook™ page, change the setting of the page, and register
a new entry onto the page. And you can check and modify the “Setup” pages.

Identifying a User



[streaming]

Enter the Streaming Broadcast Password of the terminal transmitting via
streaming broadcast. You can receive and view the contents of the transmitted
communication.

[setting]

Enter the Save Settings Password set in the Administrator setup menu. You can
access the “Phonebook” page, change the setting of the page, and register a
new entry onto the page. And you can check and modify the “Setup” pages
other than the Administrator setup menu.

* If the corresponding password is not assigned, leave the “Password” box blank and
click the [OK] button.

* Administrator Password, Phone Book Modification Password, Save Settings
Password, Remote Access Password and Streaming Broadcast Password settings are
set in the Administrator setup menu.
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Selecting a Menu

216

By clicking a menu name on the left part of the page, you can display the
corresponding menu page.

Menu items

PCS-XG80  vIDEC COMMUNICATION TERMINAL

W rowerqfi
. e ] Shared 2 - s,
comunbanon A Home 4B pronebosk  gRIsred | Ewistory  @asep | @ momstion @ monitor gl streaming

PCS-XG80
Home
— I O <
Gontrol Pad

Remote
GCommander

& Connect

@ Connect

G connect

@ Connect

[Home]

Displays the “Home” menu to select the line I/F to connect to a remote party,
enter the address of the remote party and dial. The information icons for this
system are also displayed.

[Download]
Displays the “Download” menu to download logs.

[Control Pad]
Displays the control panel to control the system.

[Remote Controller]

Displays the image of the Remote Commander (PCS-RF1) supplied with the
system. It allows you to perform the same operations as those on the Remote
Commander.

Selecting a Menu



How to Use [Home] Menu

When you click [Home] on the left part of the page, the Home menu appears.
You can also display the Home menu by entering the correct password on the
name entry screen.

PCS-XG80  wvieoc: UNICATICN TERMINAL

A Home @ B rroncvoor gEITred | Etistory  gRasetop | @ information M gt Streaming
PC8-XG80

& Conne
Dovelod I Y <

Control Pad

Remote
Commander

@ Connect

To dial by entering a number

@ Select the line interface (IP, ISDN or SIP).
@ Enter the telephone number or address of a remote party into the text box.
® Click the [Connect] button.
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How to Use [Download] Menu

218

When you click [Download] on the left part of the page, the Download menu
appears.

Various log files can be shown.

PCS-XGBO  woeo communicaTion TeRMAL
§ PowER ON A ;
comuncanon T Home | @ Wrrcnesooe gD Enistory  Eysewp @ iormation @ Monitor | fsueaning
Download PCS-XG80

Home

Dovmload Save System Log B3 pownioad

Control Pad

Remote Save Operation Log Download
Commander

Save Phone Book: ¥ oownloa

Save Setup Download

Save Call Log: Download

Select the log file you want to display, and click the [Download] button. You
can check the log files in a separate window.

How to Use [Download] Menu



How to Use [Remote Commander] Menu

When you click [Remote Commander] on the left part of the screen, the
Remote Commander image appears.

PCS-XG80 u 10N TERMINAL

¥ PoweR on
" Ao "
comumcanon A Home ook 3 Al - v Esewp @ tomation or g streaming
Remote Commander PCS-XG80

Home

Download

Control Pad

Remote
Commander

LAYOUT  VIDEQ INPUT  CAMERA

VOLUME 200M

RETURN T00LS

BAGK
CONNECT  SPACE  DISCONNECT

§ Presentation
1 Streaming

1 Recording @

By clicking the various buttons on the Remote Commander image, you can
control the system in the same way you can when using a real Remote
Commander (PCS-RF1), operating the camera, and dialing phone numbers.
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Selecting a Tool

By clicking the tools button on the top part of the page, you can jump to the
corresponding tools page.

PCS-XG80 VIDEO COMMUNICATION TERMINAL
!::;:::mo“ A Home g omeet!  Fpcnboo I Chistory  gRySetup @ lormation @ Monitor gl Streaming
[Connect/Disconnect]
Calls a remote party using direct dialing and ends a communication.
[Phonebook]

Displays the dial list of the Phonebook.
Connects from the Phonebook.
Registers, confirms, or edits the dial list.

For a private phone book, the “Phonebook” button changes to the “Private
Phonebook™ button.

[Shared Phonebook]
You can use the Shared Phone Book.

[History]

Displays the Dial, Answer and Missed Call history lists.
Dials from the history.

Deletes an unnecessary history record.

[Setup]

Confirms or modifies the setup.

[Information]

Confirms the machine information, peripheral status and communication
mode.

You can also check the network routing, and can display the recorded files in
a “Memory Stick”.

[Monitor]
You can monitor the picture on the Communication System.

When “Web Monitor” is set to “Off”” on the Access Permit page of the Administrator
setup menu, you cannot use the [Monitor] page.

[Streaming]
You can watch the live stream of a communication.

¢ QuickTime version 6.0 or above is needed to view a communication.

* When “Streaming” is “Disabled” on the Streaming/Recording page of the
Administrator setup menu, the communication cannot be watched. If “Video” is set
to “Off” on the Streaming/Recording page, only the audio stream of the
communication is broadcast, and video cannot be watched.
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How to Use [Version Up] Page

When you click [Setup] on the top part of the page, [Version Up] appears on
the lower left of the page.
Clicking [Version Up] displays the [Version Up] page.

PCS-XG80 VIDEQ COMMUNICATION TERMINAL

T rronvool IS | Etistory g Setup ) information or it streaning

PCS-XG80
e e e 1 R e Sl P

Line Interface: EIP EISDN HSIP
Multipoint Primary Line Interface: ©IP ®ISDN @ SIP

P Use LAN2

Gommunication

P
Communication
Mode

ISDN

Communication

o save

ISDN
Gommunication
Mode

8IP
Communication
Mode

Version Up

Click [Reference] and select the software you want to upgrade, then click the
[Upload] button.

When upload is complete, a message appears and the version upgrade begins.
After the upgrade is complete, the system reboots. Do not turn off the power
until rebooting is complete.

You can also upload Phone Books and configuration files by selecting them

with [Reference].

How to Use [Version Up] Page 221
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How to Use [Streaming] Page

@ On the user name entry screen, enter “streaming” in the [User Name] box
and the Streaming Password of the terminal transmitting via streaming
broadcast in the [Password] box.

® Click the [Streaming] button to start QuickTime and start watching a
communication.

¢ QuickTime version 6.0 or above is required to view a communication. If QuickTime

is not installed on your computer, download it for free from the following Web site:

http://www.apple.com/quicktime/download/

When “Streaming” is “Disabled” on the Streaming/Recording page of the

Administrator setup menu, the communication cannot be watched. If “Video” is set

to “Off” on the Streaming/Recording page, only the audio stream of the

communication is broadcast, and video cannot be watched.

» Depending on Web access limitations, about 10 terminals can view a streaming
broadcast simultaneously. The actual number of terminals that can view the broadcast
simultaneously depends on your system’s operating environment.
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How to Use [Monitor] Page

3 http:// XXX XXXXX — PCS—XGBO Web Monitor — Microsoft Internet Expl... (2 ][5

§ POWER ON

[2] Far

Display Control  Mic Volume Camera Control

| Layout
O On/Off
Pin P

FariNear Preset White Balance
Load Auto
Far
Indoor
Qutdoor
® Near
One Push
Presentation Video
Input
Start

Input

off S10p

Preset

Load

Save

When you click [Monitor] of the tools buttons, the [Monitor] page opens. You
can monitor the picture on the Communication System.

When “Web Monitor” is set to “Off”” on the Access Permit page of the Administrator
setup menu, or while the encrypted connection is made, you cannot use the [Monitor]

page.
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Appendix

Location and
Function of Parts
and Controls

PCS-XG80S/XG55S HD Visual
Communication System

Front

[ ——

‘606 0

© 1/ (power) switch
Turns on/off the system.

@ 1/ (power) indicator
Starts blinking in green when the power
switch is pressed to on, then lights in
green. Lights in orange when the system
is set to standby mode.

©® LAN 1 ALERT indicator

When the system is connected to LAN
via the == 1 connector on the rear, this
indicator lights in yellow when packet
error (loss) or link error occurs during
communication.

This indicator is labeled LAN ALERT on
the PCS-XG55S.
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O LAN 2 ALERT indicator
(PCS-XG80S only)

When the system is connected to LAN
via the #%2 connector on the rear, this
indicator lights in yellow when packet
error (loss) or link error occurs during
communication.

ON LINE indicator (PCS-XG55S
only)

Blinks in blue while dialing or receiving
a call, and stays lit in blue during
communication.

© Communication status indicator
(PCS-XG80S only)

Lights in white for several seconds then
goes out when the system starts.

Blinks while dialing or receiving a call,
and the indicator stays lit during
communication.

O TABLET connector
Connect to a pen tablet (not supplied) for
annotation, or the Key Module (not
supplied) for software installation.

This connector is labeled OPTION on the
PCS-XG55S.

@ Memory Stick slot
Insert a “Memory Stick” (not supplied)
into this slot.
A “Memory Stick Duo” can also be
inserted.

© VIDEO IN YPbPr (component
input) jacks (phono jack)
Connect to the component (YPbPr)
signal outputs of the optional camera or
external video equipment.

© AUDIO 2 IN L/R jacks (phono jack)

Connect to the audio outputs of the
optional camera or audio equipment.

This connector is labeled AUDIO IN on
the PCS-XG55S.



@ MAINTENANCE connector (D-sub
9-pin)

Used for maintenance service.

Rear

© CAMERA connector
Connect to the TERMINAL connector

on the PCSA-CXG80 HD Camera Unit.

©® S VIDEO IN connector (mini DIN
7-pin) (PCS-XG80S only)
Connect to the S-video output on the
optional second camera or video
equipment.

© RGB IN connector (D-sub 15-pin)
Connect to the RGB output of the
optional computer or video equipment.

O RGB OUT connector (D-sub
15-pin)
Connect to the RGB input of the
optional projector or display unit.

© HDMI OUT connector
Connect to the HDMI input of the
optional TV monitor.

© ISDN UNIT connector

Connect to the TERMINAL connector
on the optional PCSA-B384S or
PCSA-B768S ISDN Unit.

© AUX CONTROL connector (D-sub
9-pin)

Used for maintenance service.

Location and Function of Parts and Controls

O < (ground) terminal
Connect a ground wire.

© EC-MIC (A7) 1/2 (Echo canceling
microphone) jacks (PCS-XG80S
only)
Connect to optional PCSA-A7 echo
canceling microphones.

@ MIC (A1/A3) 1 (R)/2 (L) jacks
(minijack)
Connect to the PCS-A1 microphones
(supplied with PCS-XG80/XG55) or
PCSA-A3 microphones (optional).
Power is supplied to the microphones
from the System.

@ AUDIO 1IN L/R jacks (phono jack)
(PCS-XG80S only)
Connect to the audio outputs of the
optional VCR or audio equipment.

@ AUDIO OUT L/R jacks (phono
jack)
Connect to the audio inputs of the TV
monitor.

@® REC OUT L/R connectors (phono
jack)
Used when recording the audio signals
to minute a communication. The mixed
sounds of the local and remote parties
are output from these connectors.

@ EXT (external equipment) 1/2
connectors (PCS-XG80S only)

Not used with the system of this version.

@ ==1 (LAN1) connector
(100BASE-TX/10BASE-T, 8-pin
modular)

Used to connect via a LAN or a SIP.
Connect to a hub or a SIP server using
the category 5 cable.

This connector is labeled === (LAN) on the
PCS-XG55S.
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@ =:2 (LAN2) connector
(100BASE-TX/10BASE-T, 8-pin PCSA-CXG80 HD Camera

modular) (PCS-XG80S only) Unit (Supplied with
Used to connect via a LAN. Connect to PCS-XG80/ XG55)

a hub, etc. using the category 5 cable.

[ Note |
® DC 195V Jjack This Camera Unit is not supplied with
Connect the supplied VGP-AC19V15 PCS-XG80S/XG55S.
AC Power Adaptor.
Front

.,
9 O Or
T (o
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© Lens

This is a 10-magnification optical zoom
lens.

© POWER/STANDBY indicator

Lights in green when the System is
turned on. When the System is set to
standby mode or is turned off, it lights in
orange.

©® TERMINAL connector

Connect to the CAMERA connector on
the System.

O Receiver of the RF Remote
Commander

Point the supplied RF Remote
Commander at this receiver when
pairing with the Camera Unit.

© VISCA OUT connector

Used for VISCA communications.
When a second camera is connected to
the System, connect to the VISCA IN
connector on the second camera.

@ Tripod attachment screw hole
Use to attach the camera to a tripod.

For details on the tripod screw, see
“Attaching the PCSA-CXG80 HD
Camera Unit to a Tripod” on page 36.

© Fixing screw holes
Use to fix the camera to a fitting.

© Attachment locations for
hook-and-loop pads
When you use the supplied
hook-and-loop pads, stick them to these
locations.

PCS-RF1 RF Remote
Commander (Supplied)

PRESENTATION

oo 4bb b

o TU MTT ®
; Ua@ _‘ O

|
I

Location and Function of Parts and Controls

You can set the volume of beep that sounds
by pressing a button on the Remote
Commander using the menu. You can also
set for the beep not to sound.

For the setting, see “Beep Sound” in the
Audio setup menu on page 73.

© PRESENTATION button
Starts or stops transmission of
presentation data.

@ F1 to F4 (function) buttons

The function buttons are used for
various operations according to the
situation.

The current function of the buttons is

guided at the bottom of the menu screen.

© LAYOUT button
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Displays the Layout menu to select the
screen display pattern or monitor select
mode.

O VOLUME +/- buttons

Adjust the volume of the sound received
from a remote party.

+: to increase the volume

—: to decrease the volume

© Arrow buttons (#/%/«/%)

Used to select the menu or make various
settings in the menu.

O ENTER button

Executes the selection or setting in the
menu and goes to the next step.

@ RETURN button

Used to return to the previous step.

© CONNECT ( <) button

Used to connect a remote party for
communication.

© Number (0-9, #, %) buttons
Used to enter the letters or numbers of a
telephone number, etc.

@ Battery compartment (rear)
Insert two size AA (R6) batteries.

® /O (power on/off) button

Sets the System to standby mode when it
is turned on. Turns on the System when
it is in standby.

@ VIDEO INPUT button

Displays the Video Input menu to switch
the video input signal to be displayed on
the monitor TV.

® CAMERA button

Displays the Camera menu to adjust the
camera angle, brightness, etc.

@ ZOOM (T/W) buttons
Zooms in or out.
T: to enlarge the picture
W: to reduce the picture

228 | Location and Function of Parts and Controls

@ TOOLS button

Displays the Tools menu.

@ DISCONNECT ( = ) button

Used to disconnect a remote party in
communication.

@ BACK SPACE button

Deletes the letter entered last.

@ MIC ON/OFF button
Turns off the local sound to be sent to a
remote party. To restore the sound, press
the button again.



PCSA-B384S ISDN Unit
(Optional)

PCSA-B768S ISDN Unit
(Optional)

Front/Upper panel

[ ]
(3]
Rear

S

Front/Upper panel

(3]
Rear
I |
C ]
(4]

© POWER indicator
Lights in orange when power is supplied
to the ISDN Unit. When initializing is
complete, blinks in green.

© STATUS 1-3 indicators
Lights in orange when link
synchronization of each ISDN connector
is established. Lights in yellow when
each ISDN line is connected.

© ISDN 1-3 terminals (8-pin modular
jack)
Connect to the ISDN lines using the
ISDN modular cable.

O TERMINAL connector

Connect to the ISDN UNIT connector
on the System with the interface cable
supplied with the ISDN Unit.

Location and Function of Parts and Controls

© POWER indicator

Lights in orange when power is supplied
to the ISDN Unit. When initializing is
complete, blinks in green.

@ STATUS 1-6 indicators
Lights in orange when link
synchronization of each ISDN connector
is established. Lights in yellow when
each ISDN line is connected.

© ISDN 1-6 terminals (8-pin modular
jack)
Connect to the ISDN lines using the
ISDN modular cable.

O TERMINAL connector

Connect to the ISDN UNIT connector
on the System with the interface cable
supplied with the ISDN Unit
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Indicators

230

The following icons appear on the monitor depending on the functions being used.
Indicators marked with an asterisk (*) do not appear on the PCS-XG55/XG55S.

Indicator Name Description
Near camera | Local camera being controlled
Far camera | Remote camera being controlled
Y Mic off Local microphone is turned off in
v NEAR (Near) communication or not in
= communication.
S Mic off (Far) | Remote microphone is turned
> | FAR off in commynication or not in
communication.
Volume Volume of remote party’s voice

being adjusted

-

b

R

Audio level
(stereo)

Audio input level of stereo sound

Audio level

Audio input level of monaural

—@ (monaural) sound
Character Character input available
ALPHA input mode
LAN status | LAN connected via the =1
[ ] (LAN1) connector (@ connector on the
Fr® PCS-XG55/XG55S) using
Internet Protocol version 4 (IPv4).
* LAN status | LAN connected via the =2
,!, 2 (LAN2) connector using IPv4.
LAN status | LAN connected via the &1
i!; 1 (LANI, connector (& connector on the
v6 1Pv6) PCS-XG55/XG55S) using

Internet Protocol version 6 (IPv6).

PORT
Y Y

ISDN status

Used ISDN ports

Indicators




Indicator

Name

Description

b

Y MICCAUAD)

Audio input

Selected audio input (example of
the input from the MIC(A1/A3)
connector)

Video input | Selected video input (example of
the video from the RGB IN
connector)
* 1080i 1080i video mode in use

1080i

ISDN Audio only communication in

! Voice On|y (telephone) | progress

mode

“Memory “Memory Stick” is inserted into
E Stick” the System.

|
S
o)
v

Preset load

Recalling the preset camera
settings (1-6)

Presentation | Presentation Executing
(transmitting) | (transmitting the presentation data
to a remote party)
Presentation | Receiving the presentation data
- (receiving) from a remote party
4
Streaming Stream broadcast in progress
Recording Recording in progress
Tablet Pen tablet connected
Drawing Drawing rights belong to the local
| | NEAR (near) party.
= Drawing (far) | Drawing rights belong to the

>
o

remote party.

b

Pointer (near)

Local party’s pointer
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Indicator

Name

Description

Pointer (far)

Remote party’s pointer

L]
a

Encryption

Connected with encryption

| Packet Loss |

Packet loss

Packet loss occurring

A

N /
22

Voice “Voice Activate” is selected in

V A Activate “Broadcast Mode” in a multipoint

el mode connection.

Broadcast Local picture is broadcast in a

(Near) multipoint connection.

a
Broadcast Terminal A (-E) connected first
4 (A-E) (-fifth) is broadcast in a multipoint

connection.

Indicators




On-Screen Messages

Check the following if a message appears on the TV monitor when operating

the Communication System.

Message

Cannot complete connection. (The following code and message appear.)

0 Unknown network error: Try again later.
1 Number does not exist: Check the number and try again.
2 Network congestion: Try again later.
3 Try again later.
16 Normal disconnection: (The line has been disconnected normally.)
17 Line is busy: Try again later.
18,19 System not responding: Check if the remote system is connected.
20 No such subscriber: Confirm the site number.
21 Call rejected: Check if the remote system is connected.
22 Called party number changed: Check the number and try again.
26 Connection restoration request: Try again later.
27 Remote system out of order: Check if the remote system is operational.
28 Invalid number entered: Check the number and try again.
31,41 -43,47
Network not available: Try again later.
33,34
Line is busy. Try to dial again later.
44 Network not available: Line is busy. Try again later.
50 Not a Subscriber: Check the remote party’s facility contract.
57,58 Bearer capability not authorized: Check if “Restrict” is set correctly.
70 Restricted capability: Set “Restrict” to “56K” and try again.
88 Terminal attribute error: Check the connection of the remote system.

91,95 -102, 111

Protocol error: Turn off and restart the system and try again.

128  H.221 negotiation timeout: Restart the system and connect again.
131  Board mismatch: Check the optional line interface boards.
132 Invalid SPID: Reregister the SPID.
134 Physical link synchronization error: Check the connection of the ISDN cable.
144, 145

The remote terminal may not be compatible with the BONDING function.
177  LAN connection timeout: Try again later.

On-Screen Messages
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Message

178  LAN connection rejected: Try again later.

179  DNS error.

180  Dialing your own number is invalid.

181  GateKeeper error.

192  PPPoE server admission has failed. Check the PPPoE User Name and Password are
entered correctly.

195  Now obtaining an IP address via DHCP.

196  Configure the DNS address or use the IP address to dial.

205  Check the user name or user number for dialing is correct.

207  The remote terminal may not be registered in gatekeeper. Contact the gatekeeper

administrator.

209 -212
Gatekeeper does not respond. Contact the gatekeeper administrator, or use the IP address
to dial.

201, 217

Call not responded.

218  Local number is not set correctly in the ISDN Setup menu. Set it correctly. Line
connected with 1B (64K).

219  Local number setting for ISDN configuration may not be correct in the remote party.
Line connected with 1B (64K).

230, 231
PPPoE server admission fails. Dial again after confirmation of the PPPoE settings.

232 Access to the DNS server has failed. Check the PPPoE DNS settings.

233 Connection to the remote party via DNS disabled. Dial using IP address.

234 Dialing the same address is invalid.

235 Regarded as a secondary terminal as the number of lines for ISDN configuration is
different.

236  Regarded as a secondary terminal as Far End Camera Control is set to Off.

237  Check the line interface or the IP address is set correctly.

238  The conference could not start because the encryption feature at the near-end side was
disabled.

239  The conference could not start because the encryption feature at the far-end side was
disabled.

240  The conference could not start because the signal encryption method at the near-end side
differed from that of the far-end side.

241  The standard encryption videoconference with SIP connection is not available.

242 The Proprietary encryption videoconference with ISDN connection is not available.

243  Connection with the current communication mode is not available via the specified line
interface.

244  Disconnected due to failure to receive packet from remote site.
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Troubleshooting

If the Communication System does not function correctly, check the following.

Symptom

Cause

Solution

The power is not

The power switch is not set to on.

Press the power switch to turn on the

Commander does
not operate.

communication system.

turned on. power of the system (page 41).
The batteries in the Remote Replace the batteries with new ones
Commander are low or dead. (page 37).

The Remote It is isolated from the Perform pairing of the Remote

Commander with the Camera (page
38).

Pairing with the Remote
Commander fails.

Perform pairing of the Remote
Commander with the System or
Camera Unit (page 38).

No sound or the

volume is very low.

The volume of the system is too
low.

Adjust the sound volume by pressing
the VOLUME +/- buttons on the
Remote Commander (page 44).

The volume of the TV monitor is
too low.

Adjust the volume of the TV monitor.

The microphone on the remote
party is turned off.

Ask the remote party to turn on the
microphone.

Audio input is not selected
properly.

* Set up “Input Select (MIC)” on the
Basic Setupl page of the Audio
setup menu properly (page 71).

* Set up “Audio Input” properly on
the Basic Setupl page of the Audio
setup menu (page 71).

The microphone or external
equipment is not connected
correctly.

Check the connection (pages 166, 169
and 174).

Picture is blurred.

Manual focus is selected but picture
remains blurred.

Adjust the focus (page 142).

When auto focus is selected, the
background is too bright, contrast is
too high, or the background or the
participants’ clothes contain fine
line patterns.

Select manual focus and adjust
manually (page 142).

Troubleshooting
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Symptom

Cause

Solution

No picture.

The selected picture source is not
tuned on.

Turn on the selected video equipment.

Video input is not selected properly.

Select the video input properly (page
144).

The selected picture source is not
correctly connected to the system.

Check the connections (page 174).

A voice meeting is held.

This is not a malfunction.

Movement of the camera is
prevented.

Turn off the system, then turn it on
again.

No connection.

Wrong number was dialed.

Check the entered number.

The setting of “Line I/F” is not
correct (when using direct dialing).

Set “Line I/F” to correct interface
referring to “Calling a Remote Party”
(page 110).

The registered items in the Phone
Book are not correct.

Register the party correctly referring
to “Registering a Remote Party —
Phone Book™ (page 122).

Some of the system settings are not
correct.

Set the system settings correctly
referring to “Registering Local
Information” (page 61).

The IP address and network mask
are not set correctly (when using
LAN).

Ask the system administrator to set
them correctly (page 76).

The LAN cable is connected to the
@52 connector.

Set “Use LAN2” to “On” in the Line
I/F setup menu (page 65).

Some of the functions are restricted
when connecting the LAN cable to
the == 2 connector. SIP connection,
use of gatekeeper and SNMP, and
Web and Telnet accesses are not
available.

The LAN or ISDN cable is Connect correctly (pages 33, 34).
disconnected.

The LAN or ISDN cable is Connect correctly (pages 33, 34).
connected to the incorrect

connector.

The LAN or ISDN cable is down.

Replace the cable with a new one.

The cable exclusively designed for
the ISDN connection is used for
LAN connection (when using
LAN).

Use the cable for LAN connection.

Incorrect type of cable (cross or
straight cable) is used for the LAN
or ISDN connection.

Use the correct type of cable.

The DSU is turned off (when using
ISDN).

Turn on the DSU.
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Symptom

Cause

Solution

No connection.

If you disconnect the
communication with an abnormal
procedure, e.g., unplugging an
ISDN cable or turning off the
system during communication, you
may not connect to the ISDN line
for a while (when using ISDN).

Turn off the power of the system and
wait for a few minutes before turning
it on again.

If you repeat plugging/unplugging
or turning on/off, you may not
connect to the network for a while
(when using LAN).

Turn off the power of the system and
wait for a few minutes before turning
it on again.

LAN connection timeout (when
using LAN).

Try again later.

Packet for communication is not
acceptable under the current LAN
environment (when using LAN).

Consult with the system administrator
so that the packet for Communication
becomes acceptable under your LAN
environment.

The remote terminal is not turned
on.

Ask the remote party to turn on the
terminal.

It takes a long time for the remote
party to be able to answer from the
standby mode.

Ask the remote party to cancel the
standby mode.

The remote party is in
communication with another party.

Call the remote party after they end
the communication with another

party.

Answering the call is not permitted
by the remote terminal as it is
operating for setups, etc.

Ask the remote party to permit
answering a call.

The remote terminal is not set to
auto answer mode.

Ask the remote party to set the
terminal to auto answer mode, or to
answer a call manually.

The ISDN telephone numbers are
not set up in the remote terminal
(when using bonding).

Ask the remote party to set up “Area
Code” and “Local Number” in the
ISDN Setup menu correctly (page
81).

The eighth digit and up of the ISDN
telephone numbers are not the same
when connecting using bonding
(when the remote party uses the
communication system of an older
model such as the PCS-1600).

Connect without using bonding, or
use the ISDN telephone numbers that
are the same in the eighth digit and

up.

There is some problem with the
remote terminal.

Try to dial the number of another
terminal.

A message appears on the screen.

See “On-Screen Messages” (page
233).

Troubleshooting

237

xipuaddy



Symptom

Cause

Solution

Still pictures or the
Phone Book cannot
be saved to the
“Memory Stick.”

The write-protect tab on the
“Memory Stick” is set to LOCK.

Release the lock (page 250).

The “Memory Stick” has already
been recorded to full capacity.

Use another “Memory Stick.”
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Specifications

PCS-XG80/XG80S/XG55/
XG55S HD Visual
Communication System

This unit is compliant with ITU-T
Recommendations H.320 and H.323.

Motion picture

Operating bandwidth

64 Kbps to 10 Mbps (standard,
LAN connection) (up to4 Mbps
on the PCS-XG55/XG55S)

56 Kbps to 768 Kbps (when
installing the PCSA-B768S,
ISDN connection)

56 Kbps to 384 Kbps (when
installing the PCSA-B384S,
ISDN connection)

H.261/H.263/H.263+/H.263++/
H.264

MPEG4 Simple Profile (when
using SIP)

Picture elements

CIF: 352 pixels x 288 lines
QCIF: 176 pixels x 144 lines
4CIF: 704 pixels x 576 lines
WCIF (W288p): 512 pixels x 288
lines
‘W432p: 768 pixels x 432 lines
WA4CIF: 1024 pixels x 576 lines
720p: 1280 pixels x 720 lines
1080i: 1920 pixels x 1080 lines
(PCS-XG80/XG80S only)

Coding

16 Kbps (G.728 compliant with
ITU-T Recommendation)

8 Kbps

5.3 Kbps, 6.3 Kbps

48 Kbps (MPEG4 AAC) (when
using ISDN)

Sound

Bandwidth 22 kHz (MPEG4 AAC)

14 kHz (MPEG4 AAC)

7 kHz (G.722 compliant with
ITU-T Recommendation)

3.4 kHz (G.711/G.728 compliant
with ITU-T Recommendation)

Transmission rate

56 Kbps, 64 Kbps (G.711
compliant with ITU-T
Recommendation)

48 Kbps, 56 Kbps, 64 Kbps (G.722
compliant with ITU-T
Recommendation)

64 Kbps, 96 Kbps (MPEG4 AAC)
(when using LAN)

24 Kbps, 32 Kbps

Network

Multiplexing
Video, audio, data
Frame format
H.221 (compliant with ITU-T
Recommendation)
LAN (standard), 64 Kbps to
10 Mbps
ISDN (BRI), up to 3 lines (when
installing the PCSA-B384S)
up to 6 lines (when installing the
PCSA-B768S)
Data transmission rate
LSD 1.2 Kbps, 4.8 Kbps, 6.4 Kbps
MLP 6.4 Kbps, 24 Kbps, 32 Kbps
HMLP 62.4 Kbps, 64 Kbps,
128 Kbps
LAN protocol supported
HTTP
Telnet
RTP/RTCP
TCP/UDP
SNMP

Interface

Remote control

Far end camera control
H.281 (compliant with ITU-T
Recommendation)

General

Power requirements
DC 195V
Current consumption
SA
Operating temperature
5°C to 35°C (41°F to 95°F)
Operating humidity
20% to 80%
Storage temperature
—20°C to +60°C (—4°F to +140°F)
Storage humidity
20% to 80% (no condensation)
282 x 56 x 244 mm (W x H x D)
(11 /8 x 2 /4 x 9 5/8 inches)
(not including projections
except for the feet)

Dimensions

Specifications
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Mass Approx. 2.2 kg (4 1b 14 oz)
(PCS-XG80/XG80S)

Approx. 2 kg (41b 7 oz)

(PCS-XG55/XG55S)
Supplied accessories

PCS-RF1 RF Remote Commander
M

Size AA (R6) batteries for RF
Remote Commander (2)

HDMI cable (3 m) (9.8 feet) (1)

VGP-AC19V15 AC adaptor (1)

Power cord (1)

CD-ROM (1)

Before Using this Unit (1)

Installation Guide (1)

Quick Connection Guide/Remote
Commander Guide (1)
(PCS-XG80/XG80S only)

Important Notice Regarding
Software (1)

Warranty booklet (1)

User registration form (1)
(Japan only)

240 Specifications

PCS-RF1 Remote
Commander (Supplied with
PCS-XG80/XG80S/XG55/
XG55S)

Signal format

Compliant with IEEE802.15.4

DC 3V using two size AA (R6)
batteries

Control

VGP-AC19V15 AC Adaptor
(Supplied with PCS-XG80/
XG80S/XG55/XG55S)

Power requirements

100 to 240 V AC, 50/60 Hz,

1.6 Ato 0.7 A

Output DC195V,62A
Operating temperature

5°C to 35°C (41°F to 95°F)
Operating humidity

20% to 80%
Storage temperature

—20°C to +60°C (—4°F to +140°F)
Storage humidity

20% to 80% (no condensation)

Dimensions 155 x 67 x 36.5 mm (W x H x D)
(6 /3 x 2 3/ x 1 7/16 inches)
(not including projections)
Mass Approx. 550 g (20.5 oz)



PCSA-CXG80 HD Camera
Unit (Supplied with
PCS-XG80/XG55)

Video signal 1080i/59.94, 1080i/50
Synchronization
Internal synchronization
Image device 1/3 type (6 mm), CMOS
Effective picture elements:
Approx. 2,000,000 pixels
Lens 10x (optical) (40x (digital))
f=3.4-33.9mm, F1.8 - F2.1
Horizontal angle: 8 (TELE end) to
70 degrees (WIDE end)
Minimum object distance
100 mm (4 inches) (WIDE end)
Minimum illumination
15 lux (F1.8) with 50 IRE
Pan/tilt action Horizontal: 100 degrees
Maximum panning speed:
300 degrees/sec.
Vertical: 25 degrees
Maximum tilting speed:
125 degrees/sec.
Input voltage 19.5 V DC
Current consumption
1 A max.
Operating temperature
5°C to 35°C (41°F to 95°F)
Storage temperature
—20°C to +60°C (—4°F to +140°F)
240 x 152 x 173 mm
(10 4 x 6 x 6 */4 inches)
(w/h/d) (including the feet)
Mass Approx. 2 kg (41b 7 oz)
Installation angle
Less than 15 degrees to the
horizontal surface
Supplied accessories
Camera cable (3 m) (9.8 ft) (1)
Hook-and-loop pads (2 sets)
Operating Instructions (1)
Warranty booklet (1)

Dimensions

PCS-A1 Microphone (Two
supplied with PCS-XG80/one
supplied with PCS-XG55)

Bandwidth 13 kHz

Directional characteristic

Omnidirectional

74 x 16 x 93 mm (W x H x D)
(3 x 2/32 x 3 */4 inches)

Mass Approx. 170 g (6 0z)

Power Plug in power

Cable length 8 m (26.2 ft)

Dimensions

PCSA-A3 Microphone
(Optional)

Bandwidth 13 kHz

Directional characteristic

Unidirectional

68 x 16 x 96 mm (W x H x D)
(2 3/4 x /32 x 3 7/s inches)

Mass Approx. 200 g (7 oz)

Power Plug in power

Cable length 8 m (26.2 ft)

Dimensions

PCSA-A7P4 Microphone
(Optional)

64 x 26 x 102 mm (W x H x D)
(2 5/8 x 1'/16 X 4/s inches)
(including the feet)

Mass Approx. 130 g (4.6 0z)

Power requirements

DC 12 V, powered by the System
or AC adaptor

Power consumption

less than 2.5 W (per microphone)
Operating temperature

5°C to 35°C (41°F to 95°F)
Operating humidity

20% to 80%
Storage temperature

—20°C to +60°C (—4°F to +140°F)
Storage humidity

20% to 80% (no condensation)

Supplied accessories

PCSA-A7 Microphone (4)

Microphone cable (8 m, 26.3 ft)
&)

Microphone cable (1.5 m, 4.9 ft)
4

MPA-ACI1 AC adaptor (1)

Power cord (one for each region:
North America, Europe, Japan)

Cord adaptor (1)

DC cord (1)

Operating Instructions (1)

Warranty card (1)

Dimensions
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PCSA-B384S ISDN Unit
(Optional)

Power requirements
DC 195V
Current consumption
03A
Operating temperature
5°C to 35°C (41°F to 95°F)
Operating humidity
20% to 80%
Storage temperature
—20°C to +60°C (—4°F to +140°F)
Storage humidity
20% to 80% (no condensation)
166 x 34 x 128 mm (W x H x D)
(6 °/16 x 13/3 x 5 '/16 inches)
(not including projections
except for the feet)
Mass Approx. 400 g (14 oz)
Supplied accessories
Interface cable (5 m) (16.4 ft) (1)
Operating Instructions (1)
Warranty booklet (1)

Dimensions

PCSA-B768S ISDN Unit
(Optional)

Power requirements
DC 195V
Current consumption
05A
Operating temperature
5°C to 35°C (41°F to 95°F)
Operating humidity
20% to 80%
Storage temperature
—20°C to +60°C (—4°F to +140°F)
Storage humidity
20% to 80% (no condensation)
166 x 34 x 128 mm (W x H x D)
(6 °/16 x 13/3 x 5 '/16 inches)
(not including projections
except for the feet)
Mass Approx. 400 g (14 oz)
Supplied accessories
Interface cable (5 m) (16.4 ft) (1)
Operating Instructions (1)
Warranty booklet (1)

Dimensions

242 Specifications

PCSA-DSG80 HD Data
Solution Software (Optional)

Dimensions  72.5 x 11 x 20 mm (W x H x D)
(278 x 116 x 13/16 inches)
Mass Approx. 10 g (0.02 oz)
Supplied accessories
Serial number seal (1)
Operating Instructions (1)

PCSA-MCG80 HD MCU
Software (Optional)

Dimensions  72.5 x 11 x 20 mm (W x H x D)
(2718 x 7116 x 13/16 inches)
Mass Approx. 10 g (0.02 oz)
Supplied accessories
Serial number seal (1)
Operating Instructions (1)

Design and specifications are subject to change
without notice.

Always verify that the unit is operating properly
before use. SONY WILL NOT BE LIABLE
FOR DAMAGES OF ANY KIND
INCLUDING, BUT NOT LIMITED TO,
COMPENSATION OR REIMBURSEMENT
ON ACCOUNT OF THE LOSS OF PRESENT
OR PROSPECTIVE PROFITS DUE TO
FAILURE OF THIS UNIT, EITHER DURING
THE WARRANTY PERIOD OR AFTER
EXPIRATION OF THE WARRANTY, OR
FOR ANY OTHER REASON
WHATSOEVER.




Sales and distribution of MPEG-4
Visual encoders/decoders

THIS PRODUCT IS LICENSED UNDER
THE MPEG-4 VISUAL PATENT
PORTFOLIO LICENSE FOR THE
PERSONAL AND NON-COMMERCIAL
USE OF A CONSUMER FOR

(i) ENCODING VIDEO IN COMPLIANCE
WITH THE MPEG-4 VISUAL
STANDARD (“MPEG-4 VIDEO”)

AND/OR

(ii) DECODING MPEG-4 VIDEO THAT
WAS ENCODED BY A CONSUMER
ENGAGED IN A PERSONAL AND
NON-COMMERCIAL ACTIVITY AND/
OR WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED BY MPEG LA
TO PROVIDE MPEG-4 VIDEO.

NO LICENSE IS GRANTED OR SHALL BE
IMPLIED FOR ANY OTHER USE.
ADDITIONAL INFORMATION
INCLUDING THAT RELATING TO
PROMOTIONAL, INTERNAL AND
COMMERCIAL USES AND LICENSING
MAY BE OBTAINED FROM MPEG LA,
LLC. SEE HTTP://WWW.MPEGLA.COM

MPEG LA is offering licenses for
(i) manufacturing/sales of any storage media
storing MPEG-4 Visual video information
(ii) distribution/broadcasting of MPEG-4
Visual video information in any manner
(such as online video distribution service,
internet broadcasting, TV broadcasting).
Other usage of this product may be required to
obtain license from MPEG LA.
Please contact MPEG LA for any further
information. MPEG LA, L.L.C., 250 STEELE
STREET, SUITE 300, DENVER,
COLORADO 80206,
http://www.mpegla.com

Sales and distribution of MPEG-4
AVC (3-1) encoders/decoders

THIS PRODUCT IS LICENSED UNDER
THE AVC PATENT PORTFOLIO LICENSE
FOR THE PERSONAL AND
NON-COMMERCIAL USE OF A
CONSUMER TO

(i) ENCODE VIDEO IN COMPLIANCE
WITH THE AVC STANDARD (“AVC
VIDEO”)

AND/OR

(ii) DECODE AVC VIDEO THAT WAS
ENCODED BY A CONSUMER
ENGAGED IN A PERSONAL AND

NON-COMMERCIAL ACTIVITY AND/OR
WAS OBTAINED FROM A VIDEO
PROVIDER LICENSED TO PROVIDE AVC
VIDEO. NO LICENSE IS GRANTED OR
SHALL BE IMPLIED FOR ANY OTHER
USE. ADDITIONAL INFORMATION MAY
BE OBTAINED FROM MPEG LA, L.L.C.
SEE HTTP://MPEGLA.COM
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Acceptable RGB Input/Output Signals

PCS-XG80S/XG55S HD Visual Communication System (RGB OUT)

Picture element | Signal format fH (kHz) fV (Hz) Sync
1024 x 768 XGA VESA 60 Hz 48.363 60.004 | H-neg V-neg
1280 x 1024 SXGA VESA 60 Hz 63.981 60.02 | H-pos V-neg
1280 x 768 WXGA VESA 60 47.776 59.870 | H-neg V-pos
Hz
PCS-XG80S/XG55S HD Visual Communication System (RGB IN)
Picture Signal format fH (kHz) fV (Hz) Sync
element
640 x 480 VGA mode 3 31.469 59.94 | H-neg V-neg
VGA VESA 72 Hz 37.861 72.809 | H-neg V-neg
VGA VESA 75 Hz 37.5 75 | H-neg V-neg
VGA VESA 85 Hz 43.269 85.008 | H-neg V-neg
800 x 600 SVGA VESA 56 Hz 35.156 56.25 | H-pos V-pos
SVGA VESA 60 Hz 37.879 60.317 | H-pos V-pos
SVGA VESA 72 Hz 48.077 72.188 | H-pos V-pos
SVGA VESA 75 Hz 46.875 75 | H-pos V-pos
SVGA VESA 85 Hz 53.674 85.061 | H-pos V-pos
1024 x 768 XGA VESA 60 Hz 48.363 60.004 | H-neg V-neg
XGA VESA 70 Hz 56.476 70.069 | H-neg V-neg
XGA VESA 75 Hz 60.023 75.029 | H-pos V-pos
XGA VESA 85 Hz 68.667 84.997 | H-pos V-pos
1280 x 1024 SXGA VESA 60 Hz 63.981 60.02 | H-pos V-pos
Acceptable VIDEO IN (YPbPr) Signals
Picture element Remarks (SMPTE-274M) fH (kHz) fV (Hz)
1920 x 1080 1920 x 1080/59.94/1:1 67.43 59.94
1920 x 1080 1920 x 1080/50/1:1 56.25 50
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Pin Assignments Pin | Signal Description
14 |GND Ground

100BASE-TX/10BASE-T jack

S VIDEO IN connector (PCS-XG80S

only)
7
4 ARUS
(ooo
Modular jack 2 Q241
6 5
Pin | Signal Description
1 TPOPTX+ | Transmit+ Mini-DIN 7-pin connector
2 TPONTX- | Transmit— Pin |Signal Description
3 TPIPRX+ | Receive+ 1 Y.GND Brightness signal ground
4 NC — 2 C.GND Chrominance signal
5 NC ] ground
6 TPINRX— | Receive— 3 Y Brightness signal
7 NC - 4 C Chrominance signal
3 NC - 5 EOMP.GN Composite signal ground
6 COMP.GN | Composite signal ground
ISDN UNIT connector D
5 1a 7 COMP Composite signal
The S-Video input is only available for the

Visual Communication System.

USB connector

CAMERA connector
Pin | Signal Description 6 ;
1 GND Ground
2 195V 19.5V 15 o
3 |DCLK+ Clock+ D-sub 15-pin connector (female)
4 |DCLK- Clock~ Pin |Signal Description
5 |DR+ Receive data+ 1 Y Brightness signal
6 DR- Receive data— 2 Y.GND Brightness signal ground
7 |FS+ Frame sync+ 3 |Pb Color difference signal
8 FS- Frame sync— B-Y)
9 DX+ Transmit data+ 4 Pb.GND Color difference signal
(B-Y) ground
10 |DX- Transmit data—
5 Pr Color difference signal
11 |RX Serial receive data (R-Y)
12 1TX Serial transmit data 6 |Pr.GND | Color difference signal
13 |19.5v 19.5V (R -Y) ground
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Pin | Signal Description Pin | Signal Description
7 TXD No connection 15 NC -
8 RXD No connection
9 [195v 195V EC-MIC (A7) 1 and 2 connectors
(PCS-XG80S only)
10 |LVDS-RX |Multiplexed receive
D+ signal (+) 9 3
11 |LVDS-RX |Multiplexed receive 10 !
D- signal (=) &8 2
12 | SIRCS No connection Pin | Signal Description
13 |LVDS-TX | Multiplexed transmit 1 GND Ground
D+ signal (+) 2 TXD+ Transmit data+
14 |LVDS-TX Multlplexed transmit 3 TXD— Transmit data
D- signal (-)
15 |GND Ground 4 |NC -
] B - 5 NC -
The pin assignment above is used to connect -
the PCSA-CXG80 Camera Unit. 6 | MICDET Microphone detect
7 GND Ground
RGB OUT/IN connector 3 RXD+ Receive datat
9 RXD- Receive data—
10 |+12V Power supply+12 V

Mini D-sub 15-pin (female)

Pin | Signal Description

1 RED R (red)

2 GREEN G (green)

3 BLUE B (blue)

4 NC -

5 GND Ground

6 RED.GND R (red) signal ground

7 GREEN.GND | G (green) signal
ground

8 BLUE.GND | B (blue) signal
ground

9 NC -

10 |SYNC.GND | Sync signal ground

11 |NC -

12 |NC -

13 |HSYNC Horizontal sync

14 | VSYNC Vertical sync
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Pin Assignments on Optional
Board Connectors

TERMINAL connector
(PCSA-CXG80)

8

1

ISDN 1-3 jacks (PCSA-B384S)
ISDN 1-6 jacks (PCSA-B768S)

1 8

]

Modular jack

0000000 N N N N
15 9 Pin | Signal Description
. 1 NC -
D-sub 15-pin connector (female)
- . ] . 2 NC ~
Pin | Signal Description 3 TA Transmits
1 |Y-OUT Brigh ignal
0]8) rightness signa 1 RA Receives
2 |Y.GND Bright ignal
Brigftness signa 5 [ve Receive-
3 |Pb-OUT Color difference signal 6 B Transmit-
B-Y) 7 |NC -
4 Pb-GND Color difference signal 8 NC -
(B -Y) ground
5 |Pr-CAM Color difference signal TERMINAL connector
(R-Y) (PCSA-B384S/PCSA-B768S)
6 | Pr-GND Color difference signal
(R -Y) ground 2_14
7 | No connection | —
8 |No -
Connection USB connector
9 [+195V +195V Pin | Signal Description
10 |LVDS-TXD+ |Multiplexed transmit 1 GND Chassis ground
signal (+) 2 [19.5v 19.5V
11 |LVDS-TXD- Multlplexed transmit 3 DCLK+ Clock+
signal (-)
12 | No connection |— 4 |DCLK- Clock-
13 | LVDX-RXD+ | Multiplexed receive > |DPR+ Transmit data+
signal (+) 6 DR- Transmit data—
14 |LVDS-RXD- | Multiplexed receive 7 |FS+ Frame sync+
ional (-
signal (- 8 |FS- Frame sync—
15 |GND Ground 9 |DX+ Receive data+
10 |DX- Receive data—
11 |TX Serial transmit data
12 |RX Serial receive data
13 [19.5V 19.5V
14 |GND Ground

Specifications

247

xipuaddy



List of Port Numbers Used on the PCS-XG80/XG80S/XG55/XG55S

For point-to-point connection

Signal Port number Type
RAS 1719 UDP
Gatekeeper Discovery 224.0.1.41:1718 UDP Multicast
Q.931 (dial) 2253-2263 TCP
Q.931 (answer) 1720 TCP
H.245 2253-2263 TCP
Audio RTP 49152-49159 UDP
Audio RTCP 49152-49159 UDP
Video RTP 49152-49159 UDP
Video RTCP 49152-49159 UDP
FECC RTP 49152-49159 UDP
FECC RTCP 49152-49159 UDP

2nd Video RTP 49152-49159 UDP

2nd Video RTCP 49152-49159 UDP

SIP 5060 UDP/TCP
Auto bandwidth detection 51234-51235 UDP/TCP

For multipoint connection

Signal Port number of the | Port numbers of the second to | Type
first point fifth points

RAS 1719 UDP
Gatekeeper Discovery |224.0.1.41:1718 UDP Multicast
Q.931 (dial) 2253-2263 TCP
Q.931 (answer) 1720 TCP
H.245 2253-2263 TCP
Audio RTP
Audio RTCP
z%jeo E?ZP second point: 49172-49179

1deo third point: 49192-49199
FECC RTP 4915249159 forth I1;oint: 49212-49219 ubp
FECC RTCP fifth point: 49232-49239
2nd Video RTP
2nd Video RTCP
SIP 5060 UDP/TCP
Auto bandwidth 51234-51235 UDP/TCP
detection
[ Note

The port numbers for RTCP that can be set are 49152 to 65535.
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Meeting Room
Layout

Be sure to position camera and microphone
appropriately in your meeting room.

Camera Range

represents the shooting area of the
camera when the zoom has been extended
fully. [ indicates the shooting area of
the camera when the angling function is
fully utilized. Use the measurements below
as a guide for the layout of your meeting
room.

Top view (horizontal range at
maximum zoom-out)

—

R
A NN\N
) \y s

2
=
ESy
w0 92
X

-

1 00“\ 100°

4m =
(13.12 ft) 70

/5.6 m (18.37 ft)\

Lighting Considerations

Do not point the camera toward a window
where sunlight comes in as back lighting
may decrease the contrast. If it is necessary,
cover the window with a thick curtain.

Adjust room lighting so that it falls on the
participants. Avoid direct light on the TV
monitor. Light intensity on faces should be
about 300 lux or more.
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“Memory Stick”
Media

Use a “Memory Stick PRO” or “Memory
Stick PRO Duo” for the Visual
Communication System.

Notes on using “Memory Stick”
media

* When you set the “Memory Stick” erasure
prevention switch to “LOCK?”, data cannot
be recorded, edited, or deleted.

Terminal __HHHHHHHHHU
[ )

LOCK =
Il
I

Erasure
Label area

)

prevention
switch

The position and shape of the write-protect
switch may differ between the various
types of “Memory Stick”.

Do not remove the “Memory Stick” while
it is reading or writing data.

Data may be damaged if:

—The “Memory Stick™ is removed or the
unit is turned off while reading or
writing.

—You use the “Memory Stick” in a
location subject to the effects of static
electricity or electric noise.

We recommend that you back up
important data recorded on the “Memory
Stick”.

Do not affix anything other than the
supplied label to the “Memory Stick” label
area.

Affix the label so that it does not stick out
beyond the label area.

When storing or carrying a “Memory
Stick”, keep it in its original case.

Do not touch the terminal of the “Memory
Stick” with anything, including your
fingers or metallic objects.

Do not strike, bend, or drop the “Memory
Stick”.

Do not disassemble or modify the
“Memory Stick”.

250 “Memory Stick” Media

* Do not allow the “Memory Stick” to get
wet.
* Do not use or store the “Memory Stick” in
locations subject to:
—Extreme heat, such as in a closed car
parked in the sun.
—Direct sunlight.
—Humidity or corrosive substances.

About data

* When you set the “Memory Stick” erasure
prevention switch to “LOCK”, data such
as images and mails cannot be recorded,
edited, or deleted. Be sure to unlock the
switch before transferring or copying data
on the unit to the “Memory Stick™, or
erasing data on the “Memory Stick”.

We recommend that you make a backup
copy of important data on another
“Memory Stick” or on a hard disk using a
computer.

Notes on using “Memory Stick
Duo”

» Use a pointed object, such as a ballpoint
pen, to move the “Memory Stick Duo”
write-protect switch.

* Do not write forcefully on the “Memory
Stick Duo” memo area.

Terminal — N ”la*%

(84—

Write-protect |5 )
switch

Memo area

Format that can be used with this

unit

The unit can use the picture files recorded on

a “Memory Stick” in the following format:

* Image files (DCF-compatible)
compressed in the JPEG (Joint
Photographic Experts Group) format
(extension: .jpg)



Memory Stick™, Memory Stick Duo™,
Memory Stick PRO™, Memory Stick
PRO Duo™ and .2, are trademarks of
Sony Corporation.

Phenomena Specific
to CMOS Image
Sensors

The following phenomena that may appear
in images are specific to CMOS
(Complementary Metal Oxide
Semiconductor) image sensors. They do not
indicate malfunctions.

White flecks

Although the CMOS image sensors are
produced with high-precision technologies,
fine white flecks may be generated on the
screen in rare cases, caused by cosmic rays,
etc.

This is related to the principle of CMOS
image sensors and is not a malfunction.

The white flecks especially tend to be seen

in the following cases:

* when operating at a high environmental
temperature

¢ when you have raised the gain (sensitivity)

This phenomenon may be improved when
you turn the power of the System off and on.

Aliasing
When fine patterns, stripes, or lines are shot,
they may appear jagged or flicker.
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Glossary

ARC

An abbreviation for Adaptive Rate Control.
Technology which automatically lowers a
video streaming bitrate against network
congestion.

ARQ

An abbreviation for Automatic Repeat
reQuest. Error control method in which the
receiver requests a retransmission from the
transmitter when a packet loss occurs.

Auto Bandwidth Detection

Detects the network bandwidth and others
before communication. By using this value
for the QoS function, optimum QoS control
is available from the beginning of the
communication.

Bonding*

Bonding is one of the Inverse Multiplexing
methods allowing the connection of the
communication system with multiple ISDN
lines. Dialing the first ISDN line enables you
to connect all other lines. Dialing the second
and later lines is done automatically by the
communication between the communication
systems on both sites. To use bonding, it is
required that both communication systems
be equipped with the bonding function and
that “Area Code” and “Local Number” in the
ISDN Setup menu of the answering site be
set correctly. As the communication
between the systems when using the
bonding function is made via the ISDN
numbers of the answering site, the “Area
Code” and “Local Number” settings in the
ISDN Setup menu are not essential at the
dialing site.

* Bonding (Bandwidth on Demand
Interoperability Group) is a registered
trademark of THE BONDING
CONSORTIUM.

BRI

An abbreviation for Basic Rate Interface.
Basic interface standardized by the ITU-T.
Single ISDN has two B channels and one D
channel.
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Codec

An abbreviation for Coder-Decoder. An
integrated device of a coder that converts an
analog audio/video signal to a digital data
stream and compresses it, and a decoder for
expanding to restore the original analog
signal.

DHCP

An abbreviation for Dynamic Host
Configuration Protocol. Manages IP
addresses in the network.

DNS

An abbreviation for Domain Name System.
Defines the domain name system.

Echo Canceller
Device to eliminate echo that occurs when
transmitting audio.

FEC

An abbreviation for Forward Error
Correction. Error control method in which
the receiver can correct errors without
requesting a retransmission from the
transmitter.

Frame rate

The number of frames which can be
encoded/decoded in one second.

G.711

Audio encoding/decoding format
recommended by the ITU-T. A phone
bandwidth audio signal is converted to a
digital signal with a data rate of 64 Kbps. It
can be transmitted with a data rate of 56
Kbps.

G.722

Audio encoding/decoding format
recommended by the ITU-T. A 7-kHz
bandwidth audio signal is converted to a
digital signal with a data rate of 48 Kbps, 56
Kbps or 64 Kbps.

G.728

Audio encoding/decoding format
recommended by the ITU-T. A phone
bandwidth audio signal is converted to a
digital signal with a data rate of 16 Kbps.



Gatekeeper

Controls the access of H.323
communication devices on a network.
Administers the zone, access limitation,
audio/video bandwidth, and alias etc.

H.221

Frame structure for a digital channel in
audiovisual teleservices.

H.239

ITU-T standard for sharing data and
presentations with video. This supports the
dual video presentation mode, enabling
endpoints to receive and transmit video and
presentation data simultaneously.

H.261

Video codec for audio/visual services as p x
64 Kbps. A standard that defines a video
coding algorithm, picture format and error
correcting technology for communication
between different manufacturers’ video
codecs.

H.263

A video coding algorithm based on the
H.261 standard. This format enables
communication via a lower bit rate.

H.263+

Video encoding/decoding format based on
the H.263 standard, added by the Annex I to
TOLIJLK...... T), that allows enhanced
picture quality and error resistance.
Normally, this format is a profile used with
a combination of some of the Annex for
H.263/H.263+.

H.264

A video coding algorithm standardized by
the ITU-T in May 2003. This format realizes
high-quality picture via a lower bit rate. It
provides an equal picture quality via half as
low bit rate as the H.263 format. The H.264
format is also called as MPEG4 Advanced
Video Coding (AVC).

H.320

A standard for communication between
different communication systems.

H.323

This enables communications on the
non-Qos (Quality of Service) LAN.

HD

An abbreviation for High Definition. High
Definition television provides a
high-resolution and high-quality picture.
There are 1080i and 720P HD formats.

HMLP
See “MLP”.

HOP

Number of routers that have passed through
to reach the remote party.

I-MUX

An abbreviation for Inverse Multiplexer.
This protocol allows you to transmit the data
at 384 Kbps via 6B-channel.

ISDN

An abbreviation for Integrated Services
Digital Network. This is a communication
protocol by CCITT on transmission of
integrated voice, video, and data.
Bandwidths include basic (64 Kbps) and
primary rate (1.544 and 2.048 Mbps).

ITU-T

An abbreviation for International
Telecommunication Union,
Telecommunications.

Lip synchronization

A function that synchronizes sound with
motion. Sound processing is much faster
than motion processing, thus sound and
motion sometimes get out of step with each
other.

MLP

Data communication is also available during
communication of video/audio signals
between the communication systems. The
MLP or HMLP is a protocol for data
communication such as NetMeeting. Using
the HMLP protocol allows faster data
transmission.

Glossary
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NTSC

An abbreviation for National TV Standards
Committee. NTSC is the television system
in use in Japan, the United States, etc.

It is not compatible with the PAL system.

PAL

An abbreviation for Phase Alternation Line.
PAL is the television system in use in
Europe, China, etc.

It is not compatible with the NTSC system.

PinP

An abbreviation for “Picture in Picture.”
This is a function which allows you to
monitor your own party on a small window
on your TV monitor.

QoS

An abbreviation for Quality of Service. QoS

reserves a bandwidth for specific
communication in the network and
guarantees a given communication speed.

SIP

An acronym for Session Initiation Protocol.
SIP is a communication control protocol
used for Internet telephony, instant
messaging, etc.

SNMP

An abbreviation for Simple Network
Management Protocol. This protocol is for
management information between the
management station and the managed
terminals. This enables the monitoring of
Sony Communication Systems.

SPID

An abbreviation for Service Profile ID.

Streaming
A technology that allows audio and video
data to be played back as it is downloaded

for real time viewing over a network, such as

the Internet.

Sub-address

An identification number given to devices
sharing a common ISDN line.

254 Glossary

TOS

Inputting the information data in the TOS
field of the IP address allows the
communication system to judge the packet
transmission priority, etc. It also enables
change of path according to the types of
service (Delay or Size).

YPbPr

Component video that is transmitted with
three signal cables Y, Pb and Pr.



Menu Configuration

The menus of the HD Visual Communication System are configured as

described below.

For detailed information, see pages in parentheses. The initial settings of each

item are bolded.

Settings and options marked with an asterisk (*) do not appear on the

PCS-XG55/XG55S.

Adjustments
Brightness

Home —— Camera

(page 48)| (page 136)

Preset
|: New Entry

Camera Angle

Auto Adjustment, Manual Adjustment
Preset Setting List

Preset Number, Camera
Angle, Thumbnails

Details Digital Zoom Off, On
Backlight ————— On, Off
White Balance Auto, Indoor, Outdoor,
ONE PUSH
Focus Auto, Manual
Focus Adjustment
BrightFace Off, High, Medium, Low
Noise Reduction — Off, High, Medium, Low
Filter
I Tools — Presentation Execute, Stop
(page 151) (page 154)
— Streaming Execute, Stop
(page 157)
— Recording Execute, Stop
(page 159)
— Annotation Execute Background Screen,
(page 161) L Stop Annotation Mode, Start
— Icon Display On, Off
— Reject Answer™ On, Off
— Screen Caj ture Execute
(page 149
— Machine Status —— Machine Information
(page 93) — Peripheral Status
—— Communication Mode Status
— LAN Line Status
— Network Routing Check
— Setup Line I/F
(page 61) —— Dial B}
—— Answer
—— Multipoint™ D]
—— Communication —— [
—— Audio
—— Video
L LAN [H|
—— QoS 1]
— TOS
I L SIP K|

Continued on next page

Continued on next page
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—— ISDN
—— Annotation [M]
—— Camera IN]
—— General 0]
—— Home Menu E
—— Administrator @
—— Encryption R|
—— Shared Phone Book—
— History — Dial, Answer, Missed Call
(page 113)  — Phone Book ———— “Phone Book”
— Detailed Dial ———— “Detailed Dial”
— Phone Book/—— Phone Book List
Private Phone ~ — New Entry ——— Index, Group Select, Dial to:, Auto Dial, Image,
Book One-Touch Dial Specified, Line I/F, Communication
(page 122) Bit Rate, Number of Lines, More Options —»“More
Options”
— Group Edit
— History ——————— > “History”
'— Detailed Dial —————— “Detailed Dial”
— One-Touch Dial— F1, F2, F3, F4
(page 112)
— Direct Dial — Line interface — IP, IP(2), ISDN, TEL, SIP
(page 110) — IP address, Telephone number
— Dial
— Connect — Enter Number/Address —— “Detailed Dial”
(page 109) | — Select from Phone Book — “Phone Book”
— Select from History —— “History”
— Detailed Dial —1— Detailed Dial ———— Dial to:, Line I/F, Communication Bit Rate,
(page 116) Number of Lines
— Phone Book ———— “Phone Book”
— History ————— > “History”

— More Options Enable — “List Edit”

Line I/F Line Interface — IP, ISDN, SIP
(page 65)
Primary Line Interface IP, ISDN, SIP
Use LAN2* ————  Off, On
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[E] Dial —— Telephone Mode

Auto, G.711u-law, G711A-law

(page 65) — More Options Enable — Off, On

— User Name Input
— Prefix

— Prefix-A

— Prefix-B

— Prefix-C

— Select LAN Prefix
— LAN Prefix

Answer Auto Answer

(page 66) ISDN MSN
Mic on Answer
Reject Answer”

Off, On
Prefix-None, Prefix-A, Prefix-B, Prefix-C

Disable, Enable

On, Off
Off, On
On, Off
On, Off

3] Multipoint™ Milutipoint Mode — AUTO, On

(page 66)

Broadcast Mode — Split, Voice Activate, Voice Activate (720P)

Split

Automatic, Six-screen Mosaic

Menu Configuration
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@ Communication—IP
(page 67) (Communication)

—IP:Mode
(Communication)4>

—ISDN

—ISDN:Mode
(Communication)4)

Continued on next page
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— Individual Settings for Off, On
Transmission/Reception

—Individual Settings for Off, On
Point-to-Point/Multipoint™

—Total Bandwidth*——— 128Kbps, 384Kbps,

512Kbps, 768Kbps,
1Mbps, 2Mbps, 3Mbps,
4Mbps, SMbps, 6Mbps,
7Mbps, 8Mbps, 9Mbps,
10Mbps, Other
—Communication Bit Ratel)— 128Kbps, 384Kbps,
512Kbps, 768Kbps,
1Mbps, 2Mbps, 3Mbps,
4Mbps, SMbps™, 6Mbps*,
7Mbps*, 8Mbps*,
9Mbps™, 10Mbps”, Other

— Audio Mode? ——— G711, G.722, G.728,
MPEG4

| Far End Camera Control”) — On, Off

-H239— On,Off

—H.239 Ratio ——2/3, 1/2, 1/3

—Screen Size!) ———————— 720, WACIF, W432P,
WCIF, 4CIF, CIF, QCIF,
AUTO

L Video Mode!) ————— H.261, H.263+, H.264

L Video Frame" —— 15ps, 30fps, 60fps, AUTO

Individual Settings for Off, On

Point-to-Point/Multipoint™

—ISDN Bandwidth (Dial)>— 1B(64K), 2B(128K),
3B(192K), 4B(256K),
5B(320K), 6B(384K),
8B(512K), 12B(768K)

- ISDN Bandwidth ——— 1B(64K), 2B(128K),

(Answer)® 3B(192K), 4B(256K),
5B(320K), 6B(384K),
8B(512K), 12B(768K)

— Audio Mode® ——— G.711, G.722, G.728,
MPEG4

—Far End Camera Control3)— On, Off

- H239—— On, Off

-H.239 Ratio ——2/3, 1/2, 1/3

—Restrict ———— — Auto, 56K

| Screen Size® —— WA4CIF, W432P, WCIF,
4CIF, CIF, AUTO

L Video Mode? ————— H.261, H.263+, H.264

L Video Frame® ———————— 15fps, 30fps, AUTO



\\ SIP:Mode ————— Communication Bit Rate — 128Kbps, 384Kbps,
(Communication)‘” 512Kbps, 768Kbps,
1Mbps, 2Mbps, 3Mbps,
4Mbps, 5Mbps™, 6Mbps”,
7Mbps*, 8Mbps™,
9Mbps*, 10Mbps”*, Other

— Audio Mode — G.728, G.722, G.711

— Far End Camera Control — On, Off

— Screen Size — 720, W4CIF, W432P,
WCIF, 4CIF, CIF, QCIF,
AUTO

— Video Mode — H.261, H.263+, H.264,
MPEG4

— Video Frame ———— 15fps, 30fps, 60fps, AUTO

1) When “Individual Settings for Transmission/Reception” or “Individual Settings for Point-to-Point/
Multipoint” is set to “On” on the IP page, the item is set up for transmission, reception, point-to-point
and multipoint individually.

2) When “Individual Settings for Point-to-Point/Multipoint” is set to “On” on the IP page, the item is
set up for point-to-point and multipoint individually.

3) When “Individual Settings for Point-to-Point/Multipoint™ is set to “On” on the ISDN page, the item
is set up for point-to-point and multipoint individually.

4) The page number after “Communication2” varies with the on/off setting in “Individual Settings for
Transmission/Reception” or “Individual Settings for Point-to-Point/Multipoint”.
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Audio —— Basic Setupl——Audio Input ————— MIC, AUX, MIC+AUX

(page 71) (Audiol) — Input Select (MIC)/———— MIC(A1/A3), EC-MIC(A7)*,
Input Select (AUX) AUDIO 1, AUDIO 2*

— Echo Canceller—— On, Off
—Lip Sync ———— Auto, Off
— Recording Mute ——— Off, On
— Input Mode ——————————— Stereo, Monaural"
L— Output Mode ——— Stereo, Monaural

— Basic Setup2 —— AUX Local Monitor Out On, Off

(Audio2) — Reversed MIC Inputs Off, On

— Audio Input Delay Setting — Default—100ms, Default—50ms,
Default, Default+50ms,
Default+100ms, Custom

— Audio Input Delay

— Audio Output Delay Setting— Default—100ms, Default—50ms,
Default, Default+50ms,
Default+100ms, Custom

— Audio Output Delay
—REC OUT Mode ——— Stereo, Monaural 2ch
'— Sound Effect —— Beep Sound ———— Loud, Medium, Quiet, Off
(Audio3) — Sound Effect ————— Loud, Medium, Quiet, Off
— Dial Tone ———— — Loud, Medium, Quiet, Off
'—Ringer Tone ———— Loud, Medium, Quiet, Off

1) The initial setting on the PCS-XG55/XG55S is “Monaural”.

Video —— Basic Setup — Video Input —————— Camera, RGB, YPbPr, S VIDEO™
(page 73) | (Videol) — Presentation Screen — Full Screen, PandP, Side by Side
— Monitor Output —— HDMI, RGB, HDMI+RGB
— RGB Monitor Output Format — SXGA, XGA, WXGA
— Blanking Period —— Long, Medium, Short
— Frequency ————  60Hz, 50Hz
— Custom Input—7— Custom Input Label (Camera)
Label — Custom Input Label (RGB)
(Video2) — Custom Input Label (YPbPr)
L Custom Input Label (S VIDEO)*
— Link to Mic —7— Link to Audio Input ——  Off, On
(Video3) — Video Input ———————————— Camera, S-VIDEO*, RGB, YPbPr
— Audio Input —— MIC, AUX, MIC+AUX
— Input Select (MIC)/ ———— MIC(A1/A3), EC-MIC(A7)*,
Input Select (AUX) AUDIO 1, AUDIO 2*
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[E LAN—
(page 76)

— Basic Setup])—
(LAN)

— Host Name

— DHCP Mode

— Prefix Length

— IP Address

— Network Mask
— Gateway Address
— Primary DNS

— Secondary DNS

— LAN Mode

L PPPOE
(LAN)

(LAN)

— Gatekeeper —
(LAN)

— Used Port
Number,
RTP/RTCP Setup
(LAN)

— SNMP
(LAN)

PPPoE
User Alias
Password

Auto, Off

Auto, 100Mbps Full Duplex, 100Mbps
Half Duplex, 10Mbps Full Duplex,
10Mbps Half Duplex

Off, LAN1, LAN2*

Fixed IP for PPPOE —— Off, On
Fixed IP Address for PPPoE

DNS
Primary DNS
Secondary DNS

— NAT Setup —I:NAT Mode

WAN IP Address

— User Alias
— User Number

—Q.931
—H.245
— RTP/RTCP
— MTU Size

— SNMP Mode

— Trap Destination
— Community

— Description

— Location

1) When “Use LAN2” is set to “On” in the Line I/F setup menu, the Basic Setup pages for
LANI and LAN?2 are displayed, and you can set up the items on those pages.

— Contact

— Gatekeeper Mode
— Gatekeeper Address

Obtain automatically, Specify

Auto, On, Off

Auto, On, Off

On, Off

xipuaddy
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M QoS—— Basic Setup

— Adaptive Rate Control (ARC) —— On, Off

(page 78)|  (QoS1) — Auto Bandwidth Detection On, Off
—TCP Port Number
—UDP Port Number
—Packet Resend Request(ARQ) —— On, Off
—ARQ Buffering Time —————— 300ms, 150ms, 80ms, Auto, Custom
—ARQ Buffering Time
—Forward Error Correction(FEC) — On, Off
—FEC Redundancy ——— 8, 4, 2, Auto
— Audio Duplex Transmission On, Off
— Re-Order/Shaping — Re-Order On, Off
(Qo0S2) - Re-Order Buffer ————  Auto, 1, 2, Custom
— Re-Order Buffer Rate
— Shaping On, Off
TOS TOS Data Type Video, Audio, Data, Presentation
(page 80) TOS —————— Off, IP Precedence, DSCP
Precedence
Low Delay —————— On, Off
High Throughput On, Off
High Reliability On, Off
Minimum Cost ——— On, Off
DSCP
SIP Basic Setup SIP Server Mode — On, Off
(page 80)  (SIP) Transport Protocol ————— TCP, UDP
Port Number
SIP Domain
Registered User Name
Password
SIP Server Address
SIP Server Port
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ISDN—— Basic Setup Country/Region —— Country/region selectable
(page 81)| (ISDN1)

Protocol —————— Japan(NTT), National ISDN, Euro ISDN,
Euro ISDN(France), SESS(P-MP),
5ESS(P-P), DMS-100

— Telephone Number —|: Area Code (A1, A2, B1,B2,C1,C2)
(ISDN2) Local Number (A1, A2, BI, B2, C1, C2)

— Telephone Number —|: Area Code (D1, D2, El, E2, F1, F2)

(ISDN3) Local Number (D1, D2, El, E2, F1, F2)
— Sub Address ——— Sub Address (A1, A2, B1, B2, C1, C2, D1, D2, El, E2, F1, F2)
(ISDN4)
— SPID —— SPID (A1, A2, B1, B2, C1, C2, D1, D2, El, E2, F1, F2, Auto SPID)
(ISDN5)
M Annotation Enable On, Off
(page 82) Color ————— Black, Red, Blue, Green, Yellow, Orange,
Purple, White
Line Density —— Thick, Medium, Thin
M Camera |_ Fade In On, Off
(page 83) Second Camera Input ——— RGB, YPbPr, S-VIDEO*

Menu Configuration

263

xipuaddy



[®] General—— Device Setup—
(page 83) (Generall)

— Terminal Name

—Standby Mode ——— On, Off

—Standby Time ———————— 1-99 minutes

—Last Number Registration Off, On

—Control by Far End ———— On, Off

—Language ——— Japanese, English, French, German,

Spanish, Italian, Simplified Chinese,
Portuguese, Traditional Chinese, Korean,
Dutch, Danish, Swedish, Finnish, Polish,
Russian, Arabic, Thai, Norwegian, Turkish,
Welsh, Czech, Hungarian

—Menu Screens
(General3)

—System LED Brightness™ Bright, Off, Dark
—Camera LED Brightness Bright, Off, Dark
RF Remote Control ———— System, Camera
Reception
— Clock Set NTP On, Off
(General2) —Primary NTP Server
—Secondary NTP Server
—Time Zone

—Clock Display Pattern Year/Month/Day, Month/Day/Year,

Day/Month/Year, Year-Month-Day,

Day.Month. Year
—Date
—Time
L_Time Update ————— Execute

—Display Time in —————Off, Time Display, Current Time
Communication

—Display Terminal Name Off, Always Show, Show Temporarily

!

Continued on next page
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—Guide On, Off
—Display Indicator ————— On, Off
—Communication Mode On, Off
Display
—Display On-Screen ————— On, Off
Keyboard
—Menu Transparency ————— High, Medium, Low



L Function Keys Fl ——— Far/Near, Camera, S-VIDEO®, RGB, YPbPr,

in Communication No Operation
(General4) F2 ——— Camera, S-VIDEO™, RGB, YPbPr, No Operation
F3——— Camera, S-VIDEO*, RGB, YPbPr, Zoom (RGB),
No Operation
F4—————————— Camera, S-VIDEO", RGB, YPbPr, No Operation
&l Home Menu—— Home Menul —~ Clock Display————— On, Off
(page 85) (Home Menul) |- Local Terminal Name — On, Off
— Number Display IP:Address, SIP:User Name, SIP:Address,

GK:User Alias, GK:User Number,
NAT:Address, No Display

— Terminal Status——— On, Off

— Warning Messages On, Off

—Home Menu2 —— Connect Button Display - Simple, Individual, Off

(Home Menu2) [~ Phone Book Button On, Off
— History Button————— On, Off
— Detailed Dial Button — On, Off
- Camera Button —— On, Off
— Tools Button— Off, On
— One-Touch Dial On, Off
- Direct Dial ——  Off, On

L—Home Menu3 —1~ Video Input Display —— On, Off
(Home Menu3) [~ Audio Input Display —— On, Off

— Audio Level Meter On, Off
— Volume ———  On, Off
— LAN Status —— On, Off
— ISDN Status — On, Off

xipuaddy

Menu Configuration 265



[®] Administrator —— Password ————— Administrator Password

(page 87) (Administrator1) — Phone Book Modification Password
— Save Settings Password

— Remote Access Password

— Streaming Broadcast Password

— Setup Password1 — Line /F —————— Enabled, Disabled
(Administrator2) — Dial ———— Enabled, Disabled
— Answer —— Enabled, Disabled
— Multipoint* ———Enabled, Disabled
—IP Mode ——————— Enabled, Disabled
— SIP Mode —  — Enabled, Disabled
— ISDN Mode —— Enabled, Disabled
— Setup Password2 Audio Enabled, Disabled
(Administrator3) — Video —————— Enabled, Disabled
—LAN —— Enabled, Disabled
— QoS ———— — Enabled, Disabled
—TOS ——— Enabled, Disabled
— SIP Enabled, Disabled
—ISDN —— Enabled, Disabled
— Setup Password3 — General —————————————— Enabled, Disabled
(Administrator4) — Home Menu — — Enabled, Disabled
— Administrator —— Enabled, Disabled
— Annotation ——— Enabled, Disabled
— Camera ———— Enabled, Disabled
— Encryption ————————— Enabled, Disabled
*— Shared Phone Book Enabled, Disabled
— Streaming/Recording —— Streaming ———————— Enabled, Disabled
(Administrator5) — Recording ————Enabled, Disabled
— Video ——————Off, 64Kbps, 128Kbps,
384Kbps, 512Kbps
— Multicast Address
— Audio Port Number
— Video Port Number
— HOP
— Access Permit" — Web Monitor ————  On, Off
(Administrator6) — Web Access ——— Enabled, Disabled
— Telnet Access — Enabled, Disabled
—SSH Access —— Enabled, Disabled

— Image Flip for First Camera — Flip Vertical, Off
— Image Flip for Second Camera — Flip Vertical, Off

!

Continued on next page

1) The items on the Access Permit page are displayed and can be set only when
“Internet Protocol” is set to “IPv4”.
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— Other————————— Use History ————————— On, Off
(Administrator7)  — Save Setup ————  Execute
— Load Setup ———— Execute
— AMX Device Discovery Off, On
— HOP
— 1080i Mode*———— Off, On
— Auto Restore ———— On, Off
— Internet Protocol —— IPv4, IPv6
— Phone Book — Save Phone Book ————— Execute
(Administrator8)  |— Load Phone Book— Execute
t— Clear Phone Book———— Execute
I Auto Dialing——— On, Off
I Create Private Phone Book — Execute
| Delete Private Phone Book — Execute

— Copy to Private Phone Book — Execute

& Encryption —— Encryption Mode — Off, Connect Priority, Encrypt Priority
(page 91)

Shared Phone Book SPB Mode —— On, Off
(page 92) E SPB Server Address

SPB Server Password

xipuaddy
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